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Chapter 1:  

Let’s Get Started

Chapter Overview
•	 Launching Compass for Simple Western Software

•	 Compass Software Overview

•	 Software Menus

•	 Changing the Compass for Simple Western Main 
Window Layout

•	 Software Help

•	 Viewing Instrument User Guides

•	 Checking for and Installing New Versions of Compass 
for Simple Western

•	 Instrument Software (Embedded) Updates

•	 Keeping Multiple Versions of the Software

•	 Viewing Release Notes

•	 Exporting the Software Log

•	 Sending Run Files to Technical Support

•	 Basic Troubleshooting

•	 Compass for Simple Western Version Information

•	 Directory and File Information
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Chapter 1: Let’s Get Started  //  Launching Compass for Simple Western Software

Compass for Simple Western User Guide

The user guide will provide you with information on using Compass™ for Simple Western Software to perform and monitor 
Simple Western™ assays on Leo™ sytems, Jess™ systems, and Abby™ systems. It will also take you through Compass for 
Simple Western features used to view data from a completed run and analyze your data. 

NOTE: Refer to the Compass for Simple Western User Guide, Rev H for information on using Compass Software to 
operate a Wes system. 

Launching Compass for Simple Western Software

		  To open Compass Software, double-click the icon on the computer desktop. 

NOTE: 
If you are using a Wes system, Peggy Sue™ system, Sally Sue system, or NanoPro™ 1000, Compass for Simple 
Western version 7.0 and higher does not support these instruments. You can still use software versions 5.x and 
lower for Peggy Sue, Sally Sue, or NanoPro 1000 and software versions 6.x and lower for Wes to create, load, 
and run assays on these systems, and to analyze data. Lower versions of Compass can be downloaded at the 
Instrument Software Download Center on the Bio-Techne website.

Compass Software Overview
Compass Software has three main screens:

•	 Assay – You’ll create and review your assay.

•	 Run Summary – Check out the status of your run.

•	 Analysis – Take a look at the data from your experiment.

Changing the Screen View
To move between the Assay, Run Summary, and Analysis screens, just click the button in the screen tab located in the 
upper right corner of the main window. 

https://resources.bio-techne.com/bio-techne-assets/docs/software/Simple%20Western/CompassforSW/User%20Guides/Compass%20SW%20Software%20User%20Guide.pdf
mailto:https://www.bio-techne.com/resources/instrument-software-download-center
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Compass for Simple Western User Guide

Assay Screen
The Assay screen is used to create, view, and edit assays. You can assign well locations for assay plate reagents, modify 
assay protocol steps, enter assay notes, and add annotations for individual wells on the assay plate.
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Compass for Simple Western User Guide

Run Summary Screen
The Run Summary screen is used to monitor the status of a run in progress, watch movies of the separation in the 
capillaries, and view current and voltage plots for each run. A separation movie and a current/voltage plot for each 
cartridge can be viewed separately when running multiple cartridges in an experiment on a Leo instrument. 
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Compass for Simple Western User Guide

Analysis Screen
The Analysis screen is used to view data from your assay, including the graph view (electropherograms), lane view (shown 
below), capillary images, and a table with your results. You can also analyze your data here after the run is finished.

Screen Panes
Assay, Run Summary, and Analysis screens all have multiple screen panes that let you view the individual components of a 
run, assay, or data file. Each pane has a labeled tab and a unique icon. We’ll describe panes specific to each screen later in 
the individual screen sections.

To view a pane, click in the pane or on its tab. The example below shows panes in the Analysis screen, where the 
Experiment pane is active:

Title Bar
In the title bar, you will see the run file name and the icons that allow the main Compass for Simple Western window to be 
minimized, maximized, or closed.
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Compass for Simple Western User Guide

Main Menu
Access to various software, instrument, and screen operations is available through the main menu. More details on menu 
commands can be found in “Software Menus” on page 15.

Instrument Status Bar
The instrument status bar is used to start runs, relay system status and show run progress. More details on instrument 
control and status can be found in Chapter 6: “Controlling Jess, Abby, and Leo”.

NOTE: You will only see the instrument status bar when Compass for Simple Western software is connected to an 
instrument. There is no status bar on computer workstations that you’re only using for data analysis.

Screen Tab
The screen tab lets you move between Assay, Run Summary, or Analysis screens and is in the upper right corner of the 
main window. Just click a button to view a screen. The tab for the screen currently displayed is highlighted in blue.

View Bar
The view bar is only displayed in the Analysis screen as part of the main menu bar and allows you to switch between 
displaying sample chemiluminescent, fluorescent, or protein normalization data, fluorescent standards, data for a single 
capillary or all capillaries in the run, or grouped capillary data. View bar options are detailed in “Switching Between Sample 
and Standards Data Views” on page 169 and “Using Groups” on page 199.
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Compass for Simple Western User Guide

Compass Status Bar
The status bar is located in the lower right corner of the main window. It displays active software processes and their 
progress.

Software Menus
A brief description of the software menus in the main menu are described in this section. Not all menus are available in 
every screen, and menu commands change depending on what screen is active. The menus and commands available for 
each screen will be detailed in the individual screen sections.

File Menu
The File menu contains basic file commands.

Edit Menu
The Edit menu contains basic editing commands, analysis, and preferences options. Specific details on preferences are 
described in Chapter 8: “Setting Your Preferences”. 
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Compass for Simple Western User Guide

View Menu
The View menu can only be seen in the Analysis screen and allows you to change how your data is displayed.

Instrument Menu
When Compass for Simple Western is not connected to an instrument, the only option that appears will be to connect to 
a system. The Instrument menu contains instrument control options when the software is connected to an instrument. 
Instrument control options are explained in Chapter 6, “Controlling Leo, Jess, and Abby“.

Window Menu
The Window menu allows you to switch between Blot, Assay, Run Summary, or Analysis screens, and restore screens to 
the Compass for Simple Western default layout.

•	 Blot – Displays the Blot screen where you can view and enhance blotting membrane images acquired on Jess. 

•	 Assay – Displays the Assay screen where you can create, view, and edit assays.

•	 Run Summary – Displays the Run Summary screen which tells you the status of a run in progress.

•	 Analysis – Displays the Analysis screen which is used to view sample electropherograms, lane data, and results.

•	 Default Layout – Restores the individual panes in the current screen back to their default size and location.
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Compass for Simple Western User Guide

Help Menu
The Help menu provides access to Help, software updates, release notes, and other software information.

•	 Compass for SW Help – Displays the Compass for Simple Western User Guide.

•	 User Guide – Displays the User Guide for the instrument Compass is connected to. Displays a menu of Simple Western 
instrument User Guides if Compass is not connected to an instrument. 

•	 Bio-Techne Academy – Opens the Bio-Techne Academy where users can view online training videos, register for 
online workshops, view previous workshops, and view instrument documents. 

•	 Online Antibody Database – Opens the Simple Western Antibody Database where you can search for antibodies 
validated for use on Simple Western. 

•	 Check for Updates – Opens the software download center to show the last released software.

•	 Release Notes – Displays Compass for Simple Western release notes for the current and prior versions.

•	 Export Logs – In the event a technical support issue arises, the Export Logs option lets you gather instrument-specific 
logs into a .zip file and send it directly to ProteinSimple Technical Support. If you don’t have an internet connection, you 
can also save the .zip file to the desktop and send it to Technical Support at a later time.

•	 Send Run File – Lets you send a run file to ProteinSimple Technical Support directly from Compass for Simple Western.

•	 About Compass for SW – Displays the Compass for Simple Western software version and build information.

Changing the Compass for Simple Western Main Window Layout
You can easily resize the Compass for Simple Western main window and the individual panes in each screen. Screen 
panes can also be moved outside of the main window.

Resizing the Main Compass for Simple Western Window
To resize the main window, roll the mouse over a corner or border until the sizing arrow appears. Then just click and drag 
to resize.



18

Chapter 1: Let’s Get Started  //  Changing the Compass for Simple Western Main Window Layout

Compass for Simple Western User Guide

Resizing Screen Panes
•	 To resize a pane – Roll the mouse over the pane border until the sizing arrow appears. Then just click and drag to 

resize.

•	 To maximize a pane – Click the maximize button in the upper right corner or double-click the tab.

Minimize

Maximize

The other panes in the screen will automatically minimize to pane bars in the task area along the window border. 

•	 To minimize a pane – Click the minimize button in the upper right corner of the tab. The other panes in the screen will 
automatically resize and the minimized pane will display as a pane bar in the task area.

Minimize

Maximize

•	 To restore all minimized panes - Click Restore on the minimized pane bar.
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•	 To restore only one minimized pane - Click the pane icon on the minimized pane bar.

•	 To restore a maximized pane to its original size - Double-click the tab or click Restore in the tab menu bar.

•	 To restore all panes to their original sizes - Select Window in the main menu and click Default Layout.

Changing the Location of Screen Panes
Panes can be moved to different locations within a screen.

•	 To move a pane – Click on its tab and drag it to the new location. As the pane is moved, area guides will display to 
assist you in choosing a drop location.

The following figure shows the Analysis screen after moving the Peaks pane. 
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•	 To detach a pane from the main window – Click on its tab and drag it outside the main Compass for Simple Western 
window or right-click the tab and click Detach. 

•	 To move a detached pane back inside the main window – Select Window in the main menu and click Default Layout.

•	 To restore all panes to their original locations – Select Window in the main menu and click Default Layout.

Restoring the Main Window to the Default Layout
To restore screen pane sizes and locations to the original Compass for Simple Western layout, select Window from the 
main menu and click Default Layout.

Software Help
Select Help and click Compass for SW Help to view the Compass Simple Western User Guide. 

•	 If the computer you’re using has an internet connection, the latest online version of the User Guide PDF will display. 

•	 If the computer you’re using does not have an internet connection, the User Guide PDF will only be available if you had 
previously downloaded the PDF, either through the Compass for SW help menu or from bio-techne.com, and saved it in 
the Program Files > Compass for SW folder on your computer. 

The latest versions of User Guides are also available online at the Bio-Techne Instrument Software Download Center. 

Viewing Instrument User Guides
If Compass is connected to an instrument:  
Select Help and click User Guide to view the guide for the system Compass is connected to. 

If Compass is not connected to an instrument:  
Select Help and click User Guide to display a menu of Simple Western Instrument User Guides. 

http://bio-techne.com
https://www.bio-techne.com/resources/instrument-software-download-center?filters%5Binstrument_category%5D%5B0%5D=372&filters%5Bfile_type%5D%5B0%5D=User%20Guide


21

Chapter 1: Let’s Get Started  //  Checking for and Installing New Versions of Compass for Simple Western

Compass for Simple Western User Guide

•	 If the computer you’re using has an internet connection, the latest online version of the User Guide PDF will display. 

•	 When an internet connection is not available, the User Guide PDF will only be available if you had previously 
downloaded the PDF, either through the Compass for SW help menu or from bio-techne.com, and saved it in the 
Program Files > Compass for SW folder on your computer. 

The latest versions of User Guides are also available online at Bio-Techne Instrument Software Download Center or on the 
specific Bio-Techne website instrument page. 

Checking for and Installing New Versions of Compass for Simple 
Western
Compass for Simple Western can automatically check to see if a newer version of the software is available. To do this:

1.	 Make sure the computer being used has an active internet connection.

2.	 Select Help and click Check for Updates. The following web page will load:

3.	 Under Instrument Category, select Simple Western.

4.	 Under File Type, select Software.

5.	 Download the appropriate version and run the executable file to install.

http://bio-techne.com
https://www.bio-techne.com/resources/instrument-software-download-center?filters%5Binstrument_category%5D%5B0%5D=372&filters%5Bfile_type%5D%5B0%5D=User%20Guide
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Instrument Software (Embedded) Updates
To view the version installed, select Instrument in the main menu, then click Properties. 

To check for embedded updates, select Instrument in the main menu, then click Update and select Network. If the 
computer connected to the instrument does not have an internet connection, contact ProteinSimple Technical Support for 
assistance on how to obtain the latest update.

Keeping Multiple Versions of the Software
1.	 Rename the currently installed Compass for SW folder. For example, rename C:\Program Files\Compass for SW to  

C:\Program Files\Compass for SW_6.3.0.

2.	 Open the renamed folder, right-click on Compass for SW.exe, select Send to, and then Desktop (create shortcut).
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Compass for Simple Western User Guide

3.	 Rename the shortcut per the version number, for example: Compass 6.3.0 for SW.

 

IMPORTANT: Uninstall Compass for SW through the Windows Control Panel.

4.	 Install the latest (or newer) version of Compass for Simple Western.

5.	 The new desktop shortcut will point to the last version of Compass for Simple Western that was installed. Rename it to 
the version that was just installed, for example: Compass 7.0.0. for SW.

Viewing Release Notes
Select Help and click Release Notes to view feature updates and bug fixes for new and past versions of Compass for 
Simple Western. If the computer you’re using has an internet connection, the latest online version of the release notes PDF 
will display. When an internet connection isn’t available, the release notes PDF shipped with the original installer for the 
software will open instead. We recommend you review these notes whenever a software update is installed. 

The latest release notes are also available online at the Bio-Techne Instrument Software Download Center.

1.	 Under Instrument Category, select Simple Western.

2.	 Under File Type, select Release Note.

https://www.bio-techne.com/resources/instrument-software-download-center
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Compass for Simple Western User Guide

3.	 Download the notes for the appropriate software version.

Release Notes – Compass for SW software   

Version 7.0.0 

   
P/N 805-0003, Revision E 

Released March 2025 
 
Recommended PC requirements for Leo/Jess/Abby 
Operating System   Windows 10 or Win 11 Pro/Enterprise 64 bit 
Memory     8 GB   
Free Disk Space    100GB 
Ethernet Ports    2 (1st port for Instrument, 2nd port for network access)   
   

Installation   
Open the installer file to start the installation. 
NOTE: ‘Check for Updates’ feature in Compass software will not update from version 3.x to version 
4.0.0 and higher. User will need to download installer from  Bio-Techne website (https://www.bio-
techne.com/resources/instrument-software-download-center) and perform a full installation. 
NOTE: If you are using Peggy Sue, Sally Sue or NP1000, Compass for Simple Western version 6.0 and 
higher does not support these instruments. You can still use software versions 5.x and lower to create, 
load and run assays on these instruments, and to analyze your data. 

NOTE: If you are using Wes, Compass for Simple Western version 7.0 and higher does not support the 
instruments. You can still use software versions 6.3 and lower to create, load and run assays on these 
instruments, and to analyze your data. 

 

Compatibility with Instrument software and Authorization Server 
 
Following software is tested and released with Compass for SW 7.0.0. 

Instrument Software:  
Leo Instrument software 1.0, Jess 2.1 and Abby 1.3 to support respective instruments. 

Compass Authorization Server for SW: 3.0.0 
Compass for SW 6.2.0 or above users are required to upgrade to Compass Authorization Server for SW 
version 3.0.0 (if not already) to establish secure connection between Compass for SW and 
Authentication server (CAS).  

If Compass for SW tries to connect to older version of CAS (below version 3.0.0), a warning is displayed 
that Compass Authorization Server is out of date and is connecting in insecure manner. 

For more details on Compass Authorization Server, contact Technical Support. 

Exporting the Software Log
Select Help and click Export Logs to view the software log file. This will export a zip file containing both the Compass 
and embedded logs (self test, error, temperature, command logs, etc.) when Compass is connected to an instrument. This 
information is used for troubleshooting purposes.

Sending Run Files to Technical Support
If the computer you are using has an internet connection, Compass for Simple Western can zip and send a run file directly 
to ProteinSimple Technical Support.

1.	 Open the run file you’d like to send in the Analysis screen.

2.	 Select Help and click Send Run File….
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3.	 Enter your Name, Company, and E-mail address, and any details in the Comments section:

4.	 Click Send. The progress window displays:

5.	 When the file upload is complete, the following message displays. Click OK.
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Basic Troubleshooting

Problem Solution

The instrument won’t connect to the 
computer

•	 Confirm the static IP address for the ethernet port is set to 172.30.1.2.

•	 Use a direct ethernet to ethernet connection. USB to ethernet adapters can be 
unreliable.

•	 Refer to the installation guide for more detailed instructions or contact 
Technical Support at support@bio-techne.com or 
Instrument.Support.EMEA@bio-techne.com (European customers). 

I can’t access my data •	 By default, run files save to C:\Users\Username\Documents\Compass for SW\
Runs.

•	 If you don’t see your file in the default folder, connect to the instrument’s 
embedded drive. From the Compass for Simple Western main menu, select 
Instrument > Runs...

NOTE: Run files are organized chronologically

For additional instrument, software, and Simple Western assay troubleshooting support, contact ProteinSimple Technical 
Support by phone at (888) 607-9692 or by email at support@bio-techne.com. For customers in Europe, please 
contact Technical Support at +44 1235 529449, or Instrument.Support.EMEA@bio-techne.com. You can also visit the 
Bio-Techne Academy or visit https://www.bio-techne.com/resources/literature. You can also contact your local Field 
Application Scientist for help.

Compass for Simple Western Version Information
Select Help and click About Compass for SW to view the software version and build number information.

mailto:support%40bio-techne.com?subject=
mailto:Instrument.Support.EMEA%40bio-techne.com?subject=
mailto:support%40bio-techne.com?subject=
mailto:Instrument.Support.EMEA%40bio-techne.com?subject=
https://academy.bio-techne.com/learn
https://www.bio-techne.com/resources/literature
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Directory and File Information
The main Compass for Simple Western directory is located in the Program Files folder.
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Compass for Simple Western assay and run files are located in the Documents/Compass for SW folder on your computer. 

s

•	 Assays Folder – Contains all assay files that you’ve saved.

•	 Blots Folder – Contains all Western blot image files acquired using Jess that you’ve saved.

•	 Instrument_Logs - Contains saved instrument log files. 

•	 Instrument_Reports - Contains saved instrument reports. The folder will only appear after you save your first report.

•	 New Assays Folder – Contains Simple Western default assay template files.

•	 Runs Folder – Contains all run files. Run data is automatically written to this folder.

NOTE: When a Compass for Simple Western software update is performed, the template assays in the New Assays 
folder are overwritten.

File Types
The following file types are used by Compass for Simple Western:

•	 Assay Files – Use an *.assay file extension.

•	 Run Files – Use a *.cbz file extension. The default file format for run files is Date_Time_AssayName. An example run file 
name would be 2012-09-28_18-50-53_Simple Western.cbz.

•	 Blot Files – Use a *.btz file extension (Jess only). 

•	 Protocol Files – Exported protocol files use a *.protocol file extension.

•	 Template Files – Exported template files use a *.csv or *.txt file extension.

•	 Analysis Settings Files – Exported analysis settings files use a *.settings file extension.
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•	 Importing and Exporting Protocols and Templates
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Assay Screen Overview

NOTE: If you are using a Wes, Peggy Sue, Sally Sue, or NanoPro 1000, Compass for Simple Western version 
7.0 and higher does not support these instruments. You can still use software versions 5.x and lower for Peggy 
Sue, Sally Sue, or NanoPro 1000 and software versions 6.x and lower for Wes to create, load, and run assays on 
these systems, and to analyze data. Lower versions of Compass can be downloaded at the Instrument Software 
Download Center on the Bio-Techne website.

The Assay screen is used to create, view, and edit assays. To access this screen, click Assay in the screen tab:

Assay Screen Panes
The Assay screen has multiple panes:

•	 Layout (Jess and Abby) – Displays a map of the assay plate and shows where assay reagents will be located.

•	 Sample Layout (Leo) – Displays a map of the Bio-Techne® Simple Western™ Leo™ Sample Plate where assay reagents 
like the samples and antibodies will be located. 

•	 Reagent (Leo) – Displays the number of Bio-Techne® Simple Western™ Pre-filled Reagent Plates that will be used in the 
assay. The Pre-filled Reagent Plate contains assay reagents like size range-specific matrices and wash buffers. 

•	 Protocol – Lists individual assay protocol steps and parameters that Leo, Jess, or Abby will execute.

•	 History – View changes made to the assay tab.

•	 Notes – Lets you enter specific assay information that is saved with the assay and can be used for future reference.

•	 Template – Enter names and attributes for the individual well and row reagents in the Assay Plate (Jess and Abby) or 
Sample Plate (Leo). 

mailto:https://www.bio-techne.com/resources/instrument-software-download-center
mailto:https://www.bio-techne.com/resources/instrument-software-download-center
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L E O A S S AY S C R E E N PA N E

J E S S A S S AY S C R E E N PA N E
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A B BY A S S AY S C R E E N PA N E

NOTE: Template files (*.csv, *.txt) may be imported, exported, and edited by clicking the tabs on the top right side of 
the Template pane or in the File Menu (see below).

Software Menus in the Assay Screen
You can use the following software menus:

•	 File

•	 Edit

•	 Instrument (when Compass for Simple Western is connected to Leo, Jess, or Abby)

•	 Window

•	 Help

The File and Edit menu options specific to the Assay screen are described next.
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File Menu

The following options can be found in the File menu: 

•	 New Assay – Creates a new assay from a starter template.

•	 Open Assay – Opens an existing assay.

•	 Save – Saves the open assay.

•	 Save As – Saves the open assay under a different file name.

•	 Import Protocol – Imports a saved protocol file into an assay.

•	 Import Template – Imports a saved template file into an assay.

•	 Export Protocol – Exports the current protocol file for future use.

•	 Export Template – Exports the current template file for future use.

•	 Print – Prints the information in the Protocol or Template panes.

•	 Exit – Closes Compass for Simple Western.
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Edit Menu

The following options can be found in the Edit menu:

•	 Copy – Copies the information in the Protocol or Template panes into other documents.

•	 Paste – Pastes information from other documents into the Protocol or Template panes. 

•	 Assay Setup (Only for Leo Assays) – Opens the Assay Setup wizard that is used to specify the number of cartridges 
and reagent rows that will be used in the Leo run, and assign Sample Plate reagent locations. 

•	 Default Analysis – Displays the default settings that will be used to analyze the run data generated with an assay.

•	 Default Analysis View – Displays the default Graph, Lane, and Table view options that will be used to display run data 
generated with an assay.

•	 Undo – Reverses the last action performed when setting up your assay. 

•	 Redo – Reverts previous undo actions. 

•	 Preferences - Set and save your preferences for data export and plot colors in the graph. See Chapter 8: “Setting Your 
Preferences” for more information.
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Reagent Color Coding
Immunoassays
The Assay screen uses color coding to identify various assay reagents in all panes. A few examples are shown below. 

L E O C H E M I L U M I N E S C E N C E 
I M M U N OA S S AY

•	 Orange – Samples and ladder

•	 Light Teal – Primary antibody

•	 Teal – Secondary HRP conjugate

•	 Magenta – Antibody Diluent (2 or 
Milk-Free)

•	 Blue – Wash Buffer

•	 Gold – Luminol/Peroxide mix

J E S S/A B BY C H E M I L U M I N E S C E N C E 
I M M U N OA S S AY

•	 Orange – Samples and ladder

•	 Magenta – Antibody Diluent (2 or 
Milk-Free)

•	 Light Teal – Primary antibody

•	 Teal – Secondary HRP conjugate 

•	 Gold – Luminol/Peroxide mix

J E S S F L U O R E S C E N C E 

I M M U N OA S S AY

•	 Orange – Samples and ladder

•	 Magenta – Antibody Diluent (2 or 
Milk-Free)

•	 Light Teal – Primary antibody

•	 Teal – Secondary fluorescent 
conjugate
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Stellar Assays on Jess
The Assay screen uses color coding to identify various assay reagents in all panes. 

S T E L L A R F L U O R E S C E N C E N I R / I R I M M U N OA S S AY

•	 Orange – Samples and ladder

•	 Magenta – Antibody Diluent (2 or Milk-Free)

•	 Light Teal – Primary antibody

•	 Teal – Stellar secondary antibody

•	 Red – Stellar IR or NIR Anneal

•	 Dark Blue – Stellar IR or NIR Label

S T E L L A R F L U O R E S C E N C E N I R / I R I M M U N OA S S AY 
W I T H C H E M I L U M I N E S C E N C E TOTA L P R OT E I N 
N O R M A L I Z AT I O N

•	 Orange – Samples and ladder

•	 Peach – Total Protein Biotin Labeling Reagent

•	 Light Teal – Primary antibody

•	 Teal – Stellar secondary antibody + Stellar Total Protein 
Streptavidin-HRP

•	 Red – Stellar IR or NIR Anneal

•	 Dark Blue – Stellar IR or NIR Label

•	 Gold – Luminol/Peroxide mix

•	 Magenta – Antibody Diluent (2 or Milk-Free)
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Protein Normalization (Fluorescence) on Jess
The Assay screen uses color coding to identify protein normalization reagent (green), which can be included with every 
size assay plate setup. There’s no need to run protein normalization as a separate assay.

•	 Orange – Samples and ladder

•	 Green – Protein Normalization reagent

•	 Magenta – Antibody Diluent (2 or Milk-Free)

•	 Light Teal – Primary antibody

•	 Teal – Secondary antibody

•	 Gold – Luminol/Peroxide mix (chemiluminescence only)

RePlex™ Assays on Leo, Jess, and Abby
Leo, Jess, and Abby let you run two immunoassays or an immunoassay with Total Protein in a single run. This is done in 
two different probing cycles. These assay combinations are currently validated on Leo, Jess, and Abby:

•	 Chemiluminescence Immunoassay + Chemiluminescence Immunoassay using RePlex: Performs a 
chemiluminescence immunoassay followed by another chemiluminescence immunoassay. 

•	 Chemiluminescence Immunoassay + Total Protein Normalization using RePlex and Chemiluminescence Detection: 
Performs a chemiluminescence immunoassay followed by total protein detection. 

•	 Chemiluminescence Immunoassay/Fluorescence NIR Immunoassay + Total Protein Normalization using RePlex 
and Chemiluminescence Detection (Jess only): Performs a chemiluminescence or fluorescence NIR immunoassay 
followed by total protein detection. 

•	 Fluorescence NIR Immunoassay + Fluorescence NIR Immunoassay using RePlex (Jess only): Performs a 
fluorescence NIR immunoassay followed by another fluorescence NIR immunoassay.

•	 Fluorescence NIR Immunoassay + Chemiluminescence Immunoassay using RePlex (Jess only): Performs a 
fluorescence NIR immunoassay followed by a chemiluminescence immunoassay. 

The Assay screen uses color coding to identify various assay reagents in all panes. The following examples show the 
Layout/Sample Layout pane for a few of the RePlex Assay combinations listed above:

IMPORTANT: The Leo Sample Plate layout is slightly different from Jess and Abby, but the reagent color coding is 
the same for all three systems. 
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Chemiluminescence Immunoassay + Chemiluminescence Immunoassay using RePlex

J E S S/A B BY

•	 Orange – Samples and ladder

•	 Magenta – Antibody Diluent (2 or Milk-Free)

•	 Light Teal – Primary antibody for Probe 1

•	 Teal – Secondary HRP conjugate for Probe 1

•	 Light Teal – Primary antibody for Probe 2

•	 Teal – Secondary HRP conjugate for Probe 2

•	 Gold – Luminol/Peroxide mix

•	 Purple – RePlex reagent mix

L E O

•	 Orange – Samples and ladder

•	 Light Teal – Primary antibody for Probe 1

•	 Teal – Secondary HRP conjugate for Probe 1

•	 Light Teal – Primary antibody for Probe 2

•	 Teal – Secondary HRP conjugate for Probe 2

•	 Magenta – Antibody Diluent (2 or Milk-Free)

•	 Dark Blue – Wash Buffer 

•	 Purple – RePlex reagent mix

•	 Gold – Luminol/Peroxide mix 
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Chemiluminescence Immunoassay + Total Protein Normalization using RePlex and Chemiluminescence Detection

J E S S/A B BY

•	 Orange – Samples and ladder

•	 Peach – Total Protein Biotin Labeling Reagent

•	 Magenta – Antibody Diluent (2 or Milk-Free)

•	 Light Teal – Primary antibody for Probe 1

•	 Teal – Secondary HRP conjugate for Probe 1

•	 Green – Total Protein Streptavidin-HRP for Probe 2

•	 Gold – Luminol/Peroxide mix

•	 Purple – RePlex reagent mix

L E O

•	 Orange – Samples and ladder

•	 Light Teal – Primary antibody for Probe 1

•	 Teal – Secondary HRP conjugate for Probe 1

•	 Peach – Total Protein Biotin Labeling Reagent

•	 Green – Total Protein Streptavidin-HRP for Probe 2

•	 Magenta – Antibody Diluent (2 or Milk-Free)

•	 Dark Blue – Wash Buffer

•	 Purple – RePlex reagent mix

•	 Gold – Luminol/Peroxide mix 
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Chemiluminescence or Fluorescence NIR Immunoassay + Total Protein Normalization using RePlex and 
Chemiluminescence Detection (Jess only)

•	 Orange – Samples and ladder

•	 Peach – Total Protein Biotin Labeling Reagent

•	 Magenta – Antibody Diluent (2 or Milk-Free)

•	 Light Teal – Primary antibody for Probe 1

•	 Teal – Secondary antibody for Probe 1

•	 Green – Total Protein Streptavidin-HRP for Probe 2

•	 Gold – Luminol/Peroxide mix

•	 Purple – RePlex reagent mix

Fluorescence NIR Immunoassay + Fluorescence NIR Immunoassay using RePlex (Jess only)

•	 Orange – Samples and ladder

•	 Magenta – Antibody Diluent (2 or Milk-Free)

•	 Light Teal – Primary antibody for Probe 1

•	 Teal – Secondary antibody for Probe 1

•	 Light Teal – Primary antibody for Probe 2

•	 Teal – Secondary antibody for Probe 2

•	 Purple – RePlex reagent mix

Opening an Assay

NOTE: If you are using a Wes, Peggy Sue, Sally Sue, or NanoPro 1000, Compass for Simple Western version 
7.0 and higher does not support these instruments. You can still use software versions 5.x and lower for Peggy 
Sue, Sally Sue, or NanoPro 1000 and software versions 6.x and lower for Wes to create, load, and run assays on 
these systems, and to analyze data. Lower versions of Compass can be downloaded at the Instrument Software 
Download Center on the Bio-Techne website.

https://www.bio-techne.com/resources/instrument-software-download-center?filters%5Binstrument_category%5D%5B0%5D=372&
https://www.bio-techne.com/resources/instrument-software-download-center?filters%5Binstrument_category%5D%5B0%5D=372&
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To open an existing assay:

1.	 Select the Assay screen.

2.	 Select File in the main menu and click Open Assay.

3.	 A list of the last five assays opened will display. Select one of these assays or click Browse to open the Assay folder 
and select a different assay.

4.	 To make changes to assay parameters, follow the instructions for the assay being performed:

•	 “Immunoassays on Jess and Abby: Creating a New Assay” on page 41. 

•	 “Stellar Assays on Jess: Creating a New Assay” on page 59.

•	 “Protein Normalization on Jess: Creating a New Assay” on page 65.

•	 “RePlex Assays on Jess and Abby: Creating a New Assay” on page 67.

•	 “Immunoassays on Leo: Creating a New Assay” on page 78.

•	 “RePlex Assays on Leo: Creating a New Assay” on page 87.

5.	 Select File from the main menu and click Save.

Immunoassays on Jess and Abby: Creating a New Assay
To create a new assay, we recommend using one of the template assays and making any necessary modifications from 
there.

NOTES: 
This section provides details on how to create an Immunoassay on Jess or Abby. To create an Immunoassay on Leo, 
see “Immunoassays on Leo: Creating a New Assay” on page 78.  
 
To create a RePlex Assay on Jess and Abby that includes an immunoassay, see “RePlex Assays on Jess and Abby: 
Creating a New Assay” on page 67.  
 
To create a Stellar Assay on Jess, see “Stellar Assays on Jess: Creating a New Assay” on page 59.
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Step 1 - Open a Template Assay
1.	 Select the Assay screen.

2.	 If your instrument is not connected to Compass for Simple Western, select File in the main menu, click New Assay, and 
select your instrument:

If your instrument is connected to Compass for Simple Western select File in the main menu and click New Assay.

Alternatively, you can choose Open Assay from the File menu to select from the menu of saved assays.

3.	 Select the template assay for your instrument by selecting the instrument-appropriate Assay Type or Immunoassay, 
Size Range, and Cartridge Type.

4.	 Click OK. 

NOTE: If you make changes to the assay, such as defining the wells in the plate, be sure to select File and Save 
before proceeding.
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Step 2 - Assign Assay Plate Reagents (Optional)
1.	 Click on the Layout tab. Displayed are the default row locations where each reagent should be placed on the assay 

plate.

P L AT E L AYO U T:

•	 Row A – Biotinylated Ladder (A1) and Sample (A2–25)

•	 Row B – Antibody Diluent

•	 Row C – Antibody Diluent (C1) and Primary antibody (C2–C25)

•	 Row D – Streptavidin-HRP or NIR (D1) and Secondary conjugate 
(D2–D25)

•	 Row E – Luminol-S/Peroxide mix (chemiluminescence only)

•	 Row F – Empty

NOTE: For details on sample, reagent, and assay plate preparation, please refer to the product insert provided with 
Abby and Jess Simple Western kits.

2.	 If needed, well assignments can be modified as described below. Any row assignments changed in the Layout pane are 
updated in the Protocol pane automatically. 

•	 To move a reagent row to another location – Select the row in the Layout pane, then drag and drop it on the new 
location. The row from which it was moved will be reassigned as empty.
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•	 To delete a reagent row – Select the row to be deleted, then click the red X icon (Delete a row) in the toolbar. Rows for 
required assay reagents cannot be deleted.

•	 To insert a reagent row – Select an empty row where the new row should be inserted, then click on the icon in the 
Layout pane toolbar for your reagent. A new reagent row will be added in the empty row.

Insert a Sample row

Insert a Protein Normalization Reagent row (Jess only)

Insert a Primary row

Insert a Secondary row

Insert a Tertiary row (optional)

Insert a Detection row

NOTE: Row F is the last row assignment that can be used on the assay plate. New sample, incubation, or detection 
rows cannot be inserted if all rows have an assigned reagent. To insert a row in this case, you must first delete the 
contents of a row.
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Step 3 - Modifying the Assay Protocol (Optional)
1.	 Click on the Protocol tab. This pane shows the individual steps of the assay protocol and allows you to change 

parameters. When creating a new assay, the default protocol automatically assigns all reagent locations for the assay. 
An Abby assay is shown as an example:

Each row contains an assay protocol step. Each step can contain a reagent assay plate row assignment and one or 
more parameter settings. To view the details for a step, click on the gray arrow next to the step name. We recommend 
using the default protocol settings for the assays. An expanded list of the default protocol step parameters for a 
chemiluminescence assay is shown below:

NOTE: To expand all parameters, click the  button at the upper right of the pane. To collapse all parameters, click 
the  button at the upper right of the pane. 
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2.	 You can change the primary or secondary antibody incubation time. Click the cell in the value column next to Primary 
Antibody Time (min) or Secondary Antibody Time (min) and enter a new value in minutes.

3.	 You can change the primary and secondary antibody incubation reagent row location if there is more than one row for 
each reagent type. Click the cell in the value column next to Well Row and select a different row on the assay plate:

NOTE: Only rows you’ve designated as a primary antibody or secondary antibody in the Layout pane can be 
selected in the Well Row drop-down menu for Primary Antibody or Secondary Antibody, respectively.

For chemiluminescence assays, the default detection mode is High Dynamic Range (HDR) for chemiluminescence 
assays (Compass for Simple Western 6.1 and higher). See “High Dynamic Range Detection Profile (Jess and Abby) 
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and Default Detection Profile (Leo)” on page 100 and “RePlex Dynamic Range Detection Profile (Jess and Abby) and 
Default Detection Profile for RePlex assays (Leo)” on page 102 for more information. 

For fluorescence assays, the default modes are 6 exposures for NIR and 4 exposures for IR. If you do not want to run 
a detection channel in your assay, remove all the exposures in the Detection Profile. See “NIR Fluorescent Detection 
(Jess only)” on page 49 for more information. 

C H E M I L U M I N E S C E N C E A S S AYS F L U O R E S C E N C E A S S AYS

The number of exposures collected in the assay can be adjusted if desired. 

Chemiluminescent 

Click the gray arrow next to Detection to expand the row. Click the HDR cell in the column next to Detection Profile (Chemi) 
and click the … button that appears to open the Detection Profile window. 

The examples below are from a chemiluminescence assay on Abby. 
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Deselect the High Dynamic Range checkbox. To remove exposure times, click the Remove button. To add additional 
exposure times to the protocol, click the Add button and enter the values. Select OK when you are done.

For non-RePlex chemiluminescence assays on Jess and Abby, when the High Dynamic Range box is unchecked, you also 
have the option of selecting the RePlex Dynamic Range:

NOTE: A Remove All button will appear in the Detection Profile for Jess chemiluminescence assays. You can only 
use the Remove All button if the ladder was not run in the channel you are modifying. See “Ladder Channel (Jess 
only)” on page 51 for more information.
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NIR Fluorescent Detection (Jess only)

Click the gray arrow next to Detection to expand the row. Click the exposure number cell in the column next to Detection 
Profile (NIR) and click the … button that appears to open the Detection Profile window. 

To remove exposure times, click the Remove or Remove All button. To add additional exposure times to the protocol, click 
the Add button and enter the values. Select OK when you are done. 

NOTE: You can only use the Remove All button to remove exposures if your ladder was not run in the channel you 
are modifying. See “Ladder Channel (Jess only)” on page 51 for more information.
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IR Fluorescent (Jess only)

Click the gray arrow next to Detection to expand the row. Click the exposure number cell in the column next to Detection 
Profile (IR) and click the … button that appears to open the Detection Profile window. 

To remove exposure times, click the Remove or Remove All button. To add additional exposure times to the protocol, click 
the Add button and enter the values. Select OK when you are done.

NOTE: You can only use the Remove All button to remove exposures if your ladder was not run in the channel you 
are modifying. 
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Ladder Channel (Jess only)

The ladder channel defaults to NIR in assays including fluorescence detection. If you’d like to change the channel for the 
ladder, select the cell next to Ladder Channel and select the desired channel in the drop-down menu. 

5.	 You can modify any other protocol parameters as needed.

NOTE: For more information on changing protocol step, contact ProteinSimple Technical Support at 
support@bio-techne.com (US/Canada) or Instrument.Support.EMEA@bio-techne.com (Europe). You can also 
contact your local Field Application Specialist. 

Step 4 - Add Assay Notes (Optional)
1.	 Click on the Notes tab.

2.	 Type any assay or protocol notes in the pane. This information will be stored with the assay and run data.

NOTE: When notes are being edited, an asterisk will appear in the Notes tab to indicate changes have been made 
and should be saved.

mailto:support%40bio-techne.com?subject=
mailto:Instrument.Support.EMEA%40bio-techne.com?subject=
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Step 5 - Add Assay Plate Annotations (Optional)
Custom reagent names, notes and attributes can be entered for individual rows and wells on the assay plate. This 
information will be stored with assay and run data. During post-run analysis, this information will be used to apply custom 
analysis settings to specific sample names, blocking reagent names, primary antibody and secondary antibody names, 
or sample, primary antibody, and secondary antibody attributes. This will be explained in more detail in “Analysis Settings 
Overview” on page 277.

NOTE: Template pane information can also be added or updated after a run is complete.

To enter annotations:

1.	 Click on the Template tab. The default annotations for reagent rows and individual wells on the assay plate will display:

2.	 Change or add rows and well names and attributes as needed. To do this:

•	 To change the reagent name for a specific well – Select the top of the well. You can then either right-click and 
select Edit, click Edit in the upper right corner of the pane, press Ctrl+E, or double-click at the top of the selected 
well. 
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Enter the reagent name in the box that appears and click Enter. 

The new information will display in the selected well:

To undo changes, press Ctrl+Z or select Undo from the Edit menu. 

•	 To add an attribute to a specific well – Select the bottom of the well. You can then either right-click and select Edit, 
click Edit in the upper right corner of the pane, press Ctrl+E, or double-click at the bottom of the selected well. 

Type the attribute (for example, sample concentration or dilution ratio) in the box that appears and click Enter. 
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The new information will display in the selected well. 

To undo changes, press Ctrl+Z or select Undo from the Edit menu. 

•	 To change the reagent name for multiple wells or a row – To select individual wells, click on the top of individual 
wells while holding down the Ctrl key. To select a sequential set of wells or a full row, select the top of the first well 
and the last well while holding down the Shift key. Next, right-click and select Edit, click Edit in the upper right 
corner of the pane, press Ctrl+E, or double-click while continuing to hold down the Ctrl or Shift key. 

Type the new reagent name in the box that appears and click Enter. 
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The new information will be displayed in the selected wells. 

To undo changes, press Ctrl+Z or select Undo from the Edit menu. 

•	 To add an attribute to multiple wells – To select individual wells, click on the bottom of individual wells while 
holding down the Ctrl key. To select a sequential set of wells or a full row, select the bottom of the first well and the 
last well while holding down Shift key. Next, right-click and select Edit, click Edit in the upper right corner of the 
pane, press Ctrl+E, or double-click while continuing to hold down the Ctrl or Shift key. 

 

Type the attribute (for example, sample concentration or dilution ratio) in the box that appears and click Enter. 
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The attribute information will appear in the selected wells. 

To undo changes, press Ctrl+Z or select Undo from the Edit menu. 

Step 6 - Save the Assay
1.	 Select File from the main menu and click Save As. Enter the assay name and click Save.

NOTE: New assays are saved in the Compass Assays directory.

Step 7 - Modify Default Analysis Parameters (Optional)
You can preset the parameters used to analyze run data generated with the assay.

1.	 Select the Assay screen.
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2.	 Select Edit from the main menu and click Default Analysis. The following screen will display:

3.	 We recommend using the default parameters for Simple Western assays. However, you can modify any you want, then 
click OK. For detailed information on analysis parameters, please refer to “Analysis Settings Overview” on page 277.

Step 8 - Modify Default Analysis View (Optional)
You can preset the Graph, Lane, and Table view options used to display run data generated with the assay.

1.	 Select the Assay screen.

2.	 Select Edit from the main menu and click Default Analysis View. The following screen will display:
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3.	 Select the items you want to use as default Graph display options for your run data, then click Apply. When you are 
done selecting items, click OK. For detailed information on these options, please refer to “Graph Options: Customizing 
the Data Display” on page 259.

4.	 Click Lane View Options. Select the items you want to use as default Lane display options for your run data, then click 
Apply. When you are done selecting items, click OK. For detailed information on these options, please refer to “Lane 
Options” on page 224.

5.	 Click Table View Options. Select the items you want to use as default Table display options for your run data, then 
click Apply. When you are done select items, click OK. 

Check one or multiple label boxes, and uncheck those you don’t want to display. You can also adjust the columns that 
display in each table in the Analysis Screen. See “Experiment Pane: Assay and Capillary Information” on page 155, 
“Peaks Pane: Calculated Results” on page 161, and “Viewing the Capillaries Pane” on page 165 for more information. 
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NOTE: If you save the run file after updating Graph, Lane, and Table options in the Analysis screen, those selections 
will override the Default Analysis settings and will automatically display the next time you open the run file. 

Stellar Assays on Jess: Creating a New Assay
To create a new assay, we recommend using one of the template assays and making any necessary modifications from 
there.

Step 1 - Open a Template Assay
1.	 Select the Assay screen.

2.	 If Jess is not connected to Compass for Simple Western, select File in the main menu, click New Assay, and choose 
Jess:

If Jess is connected to Compass for Simple Western select File in the main menu and click New Assay.

Alternatively, you can choose Open Assay from the File menu to select from the menu of saved assays.

NOTE: If you make changes to the assay, such as defining the wells in the plate, be sure to select File and Save 
before proceeding.

3.	 Select Stellar.
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4.	 Select Chemiluminescence or Total Protein if desired.

5.	 Select Size Range and Cartridge Type.

6.	 Click OK. 

Step 2 - Review Assay Plate Reagents (Optional)
1.	 Click on the Layout tab. Displayed are the default row locations where each reagent should be placed on the assay 

plate.

P L AT E L AYO U T:

S T E L L A R F L U O R E S C E N C E N I R / I R I M M U N OA S S AY

•	 Row A – Biotinylated ladder (A1) and sample (A2–25)

•	 Row B – Antibody Diluent

•	 Row C – Antibody Diluent (C1) and Primary antibody (C2–C25)

•	 Row D – Streptavidin-NIR (D1) and Stellar secondary antibody (D2-
D25)

•	 Row E – Stellar IR or NIR Anneal

•	 Row F – Stellar IR or NIR Label

S T E L L A R N I R / I R I M M U N OA S S AY + C H E M I L U M I N E S C E N C E I M M U N OA S S AY

•	 Row A – Biotinylated ladder (A1) and sample (A2–25)

•	 Row B – Antibody Diluent

•	 Row C – Antibody Diluent (C1) and Primary antibody (C2–C25)

•	 Row D – Streptavidin-NIR (D1) and Stellar and HRP-conjugated 
secondary antibody (D2–D25)

•	 Row E – Stellar IR or NIR Anneal

•	 Row F – Stellar IR or NIR Label

•	 Row J – Luminol-S/Peroxide mix
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S T E L L A R N I R / I R I M M U N OA S S AY + TOTA L P R OT E I N N O R M A L I Z AT I O N U S I N G C H E M I L U M I N E S C E N C E D E T E C T I O N

•	 Row A – Biotinylated ladder (A1) and sample (A2–25)

•	 Row B – Total Protein Biotin Labeling Reagent

•	 Row C – Antibody Diluent (C1) and primary antibody (C2–C25)

•	 Row D – Streptavidin-NIR (D1) and Stellar secondary antibody + 
Stellar Total Protein Streptavidin-HRP (D2–D25)

•	 Row E – Stellar IR or NIR Anneal

•	 Row F – Stellar IR or NIR Label

•	 Row J – Luminol-S/Peroxide mix

•	 Row K – Antibody Diluent (2 or Milk-Free)

NOTE: For details on sample, reagent and assay plate preparation, please refer to the product insert provided with 
Jess Simple Western kits.

Step 3 - Modifying the Assay Protocol (Optional)
1.	 Click on the Protocol tab. This pane shows the individual steps of the assay protocol and allows you to change 

parameters. When creating a new assay, the default protocol automatically assigns all reagent locations for the assay. 
Some examples are shown below: 

S T E L L A R F L U O R E S C E N C E I M M U N OA S S AY 
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S T E L L A R N I R / I R F L U O R E S C E N C E I M M U N OA S S AY + C H E M I L U M I N E S C E N C E I M M U N OA S S AY

S T E L L A R F L U O R E S C E N C E I M M U N OA S S AY + TOTA L P R OT E I N N O R M A L I Z AT I O N U S I N G C H E M I L U M I N E S C E N C E 
D E T E C T I O N

Each row contains an assay protocol step. Each step can contain a reagent assay plate row assignment and one or 
more parameter settings. To view the details for a step, click on the gray arrow next to the step name. We recommend 
using the default protocol settings for the assays. An expanded list of the default protocol step parameters for a 
standard Stellar Assay is shown:
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NOTE: To expand all parameters, click the  button at the upper right of the pane. To collapse all parameters, click 
the  button at the upper right of the pane. 

2.	 You can change the primary or secondary antibody incubation time. Click the cell in the value column next to Primary 
Antibody Time (min) or Secondary Antibody Time (min) and enter a new value in minutes.

3.	 The default detection mode is High Dynamic Range (HDR). See “High Dynamic Range Detection Profile (Jess and Abby) 
and Default Detection Profile (Leo)” on page 100 for more information.
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Additional exposures can be collected in the assay if desired. To do this, click the gray arrow next to Detection to 
expand the row. Click the HDR cell in the column next to Detection Profile (NIR) or (IR) and click the … button that 
appears to open the Detection Profile window.

Deselect the High Dynamic Range checkbox. To remove exposure times, click the Remove button or click Remove All if 
the ladder was not run in the channel you are modifying. To add additional exposure times to the protocol, click the Add 
button and enter the values. Select OK when you are done.

For Stellar Assays with Chemiluminescence or Total Protein, when the High Dynamic Range box is unchecked in 
Detection Profile (Chemi), you also have the option of selecting the RePlex Dynamic Range. See “High Dynamic Range 
Detection Profile (Jess and Abby) and Default Detection Profile (Leo)” on page 100 and “RePlex Dynamic Range 
Detection Profile (Jess and Abby) and Default Detection Profile for RePlex assays (Leo)” on page 102 for more 
information. 



65

Chapter 2: Size Assays  //  Protein Normalization on Jess: Creating a New Assay

Compass for Simple Western User Guide

4.	 You can modify any other protocol parameters as needed.

NOTE: For more information on changing protocol step parameters, contact ProteinSimple Technical Support at 
support@bio-techne.com (US/Canada) or Instrument.Support.EMEA@bio-techne.com (Europe). You can also 
contact your local Field Application Scientist for help.

Steps 4–8
Steps 4 through 8 for creating a Stellar Assay are the same as when you’re creating an Immunoassay. Please go to “Step 4 
- Add Assay Notes (Optional)” on page 51 to continue. 

Protein Normalization on Jess: Creating a New Assay

Step 1 - Open a Template Assay
1.	 Select the Assay screen.

2.	 If Jess is not connected to Compass for Simple Western, select File in the main menu, click New Assay, and choose 
Jess:

If Jess is connected to Compass for Simple Western select File in the main menu and click New Assay.

Alternatively, you can choose Open Assay from the File menu to select from the menu of saved assays.

3.	 Select the template assay by selecting Protein Normalization in addition to Fluorescence and/or Chemiluminescence 
as your assay type, Size Range, and Cartridge Type. 

mailto:support%40bio-techne.com%20?subject=
mailto:Instrument.Support.EMEA%40bio-techne.com?subject=
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4.	 Or choose Open Assay from the File menu to select from the menu of saved assays.

5.	 Click OK. 

NOTES:  
Protein Normalization isn’t available with Stellar Assays. A Stellar Total Protein Assay can be used instead when 
normalization is needed.  
 
If you make changes to the assay, such as defining the wells in the plate, be sure to select File and Save before 
proceeding.

Step 2 - Assign Assay Plate Reagents
1.	 Click on the Layout tab. Displayed is the default row location (green) where the protein normalization reagent should be 

placed on the assay plate.

J E S S P L AT E L AYO U T

•	 Row A – Biotinylated Ladder (A1) and Sample (A2–A25)

•	 Row B – Antibody Diluent (B1) and Protein Normalization Reagent 
(B2–B25)

•	 Row C – Antibody Diluent

•	 Row D – Antibody Diluent (D1) and Primary antibody (D2–D25)

•	 Row E – Streptavidin-NIR (E1) and Secondary conjugate (E2–E25)

•	 Row F – Empty for fluorescence only, Luminol-S/Peroxide mix for 
chemiluminescence

NOTE: For details on sample, reagent and assay plate preparation, please refer to the product insert provided with 
Jess Simple Western kits.

Step 3–8
Steps 3 through 8 for creating a Protein Normalization Assay on Jess are the same as when you’re creating an 
Immunoassay. Please go to “Step 3 - Modifying the Assay Protocol (Optional)” on page 45 to continue.
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RePlex Assays on Jess and Abby: Creating a New Assay

NOTE: To create a RePlex Assay on Leo, see “RePlex Assays on Leo: Creating a New Assay” on page 87. 

Step 1 – Open a Template Assay
1.	 Select the Assay screen.

2.	 If your instrument is not connected to Compass for Simple Western, select File in the main menu, click New Assay, and 
select your instrument:

If your instrument is connected to Compass for Simple Western select File in the main menu and click New Assay.

Alternatively, you can choose Open Assay from the File menu to select from the menu of saved assays.

NOTE: If you make changes to the assay, such as defining the wells in the plate, be sure to select File and Save 
before proceeding.

3.	 Select RePlex.
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These RePlex Assay combinations are currently validated on Jess and Abby:

•	 Chemiluminescence Immunoassay + Chemiluminescence Immunoassay using RePlex: Performs a 
chemiluminescence immunoassay followed by another chemiluminescence immunoassay. 

•	 Chemiluminescence Immunoassay + Total Protein Normalization using RePlex and Chemiluminescence 
Detection: Performs a chemiluminescence immunoassay followed by total protein detection. 

•	 Chemiluminescence Immunoassay/Fluorescence NIR Immunoassay + Total Protein Normalization using RePlex 
and Chemiluminescence Detection (Jess only): Performs a chemiluminescence or fluorescence NIR immunoassay 
followed by total protein detection. 

•	 Fluorescence NIR Immunoassay + Fluorescence NIR Immunoassay using RePlex (Jess only): Performs a 
fluorescence NIR immunoassay followed by another fluorescence NIR immunoassay.

•	 Fluorescence NIR Immunoassay + Chemiluminescence Immunoassay using RePlex (Jess only): Performs a 
fluorescence NIR immunoassay followed by a chemiluminescence immunoassay. 

The assay selected for Probe 1 is run first. When Probe 1 is complete, the instrument performs a wash, RePlex purge, 
and wash step combination prior to beginning the assay selected for Probe 2. 

4.	 Select the type of assays.

To run an Immunoassay + Immunoassay using RePlex 
Abby: When RePlex is selected as the Assay Type, chemiluminescence will be run for both Probe 1 and 2.

Jess: Select any combination of chemiluminescence or fluorescence for Probes 1 and 2. The default selection is 
chemiluminescence for both. For example:
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To run a Chemiluminescence or Fluorescence Immunoassay + Total Protein Normalization using RePlex and 
Chemiluminescence Detection
Abby: Select Total Protein. Probe 1 will be used for chemiluminescence. Probe 2 will be used for the Total Protein 
assay.

Jess: Select Total Protein, then select any combination of chemiluminescence or fluorescence for Probe 1. Probe 2 will 
be used for the Total Protein assay. For example:

5.	 Select the Size Range and Cartridge Type.

6.	 Click OK. 
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Step 2 - Assign Assay Plate Reagents
1.	 Click on the Layout tab. Default row locations where each reagent should be placed on the assay plate are displayed. 

Reagents used in Probe 1 are labeled ‘P1’ on the plate, those used in Probe 2 are labeled ‘P2’:

I M M U N OA S S AY + I M M U N OA S S AY U S I N G R E P L E X

•	 Row A – Biotinylated Ladder (A1) and Sample (A2–A25)

•	 Row B – Antibody Diluent

•	 Row C – Primary Probe 1: Antibody Diluent (C1) and Primary antibody 
for Probe 1 (C2–C25)

•	 Row D – Secondary Probe 1: Streptavidin-HRP or NIR (D1) and 
Secondary antibody for Probe 1 (D2–D25)

•	 Row E – Primary Probe 2: Antibody Diluent (E1) and Primary antibody 
for Probe 2 (E2–E25)

•	 Row F – Secondary Probe 2: Antibody Diluent (F1) and Secondary 
antibody for Probe 2 (F2–F25)

•	 Row J – Luminol/Peroxide mix (chemiluminescence only)

•	 Row K – RePlex reagent mix

I M M U N OA S S AY + TOTA L P R OT E I N N O R M A L I Z AT I O N U S I N G R E P L E X A N D C H E M I L U M I N E S C E N C E 
D E T E C T I O N

•	 Row A – Biotinylated Ladder (A1) and Sample (A2–A25)

•	 Row B – Antibody Diluent (B1) and Total Protein Biotin Labeling Reagent  
(B2-B25)

•	 Row C – Antibody Diluent

•	 Row D – Primary Probe 1: Antibody Diluent (D1) and Primary antibody for 
Probe 1 (D2–D25)

•	 Row E – Secondary Probe 1: Streptavidin-HRP or NIR (E1) and Secondary 
antibody for Probe 1 (E2–E25)

•	 Row F – Total Protein Streptavidin-HRP for Probe 2 (F1–F25)

•	 Row J – Luminol/Peroxide mix

•	 Row K – RePlex reagent mix

NOTE: For details on sample, reagent and assay plate preparation, please refer to the product insert provided with 
Jess and Abby Simple Western kits.
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2.	 If needed, the Secondary antibody row assignments for either Probe 1 or 2 can be deleted for assays where the 
Primary antibody contains HRP. Any row assignments changed in the Layout pane are updated in the Protocol pane 
automatically.

Click the Secondary antibody row you want to delete, then click the red X icon (Delete a row) in the toolbar. Only 
Secondary antibody rows can be deleted. Rows required for other assay reagents cannot be deleted

Step 3 - Modifying the Assay Protocol (Optional)
1.	 Click on the Protocol tab. This pane shows the individual steps of the assay protocol and allows you to change 

parameters. When creating a new assay, the default protocol automatically assigns all reagent locations for the 
assay. A Jess Chemiluminescence/Fluorescence NIR Immunoassay + Total Protein Normalization using RePlex and 
Chemiluminescence Detection is shown in this example:
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Each row contains an assay protocol step. Each step can contain a reagent assay plate row assignment and one or 
more parameter settings. To view the details for a step, click on the gray arrow next to the step name. We recommend 
using the default protocol settings for the assays. An expanded list of the default protocol step parameters for 
a Jess Chemiluminescence/Fluorescence NIR Immunoassay + Total Protein Normalization using RePlex and 
Chemiluminescence Detection is shown below:

NOTE: To expand all parameters, click the  button at the upper right of the pane. To collapse all parameters, click 
the  button at the upper right of the pane. 
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2.	 You can change the primary or secondary antibody incubation time. Click the cell in the value column next to Primary 
Antibody Time (min) or Secondary Antibody Time (min) and enter a new value in minutes:

3.	 The default detection mode for chemiluminescent RePlex Assays is RePlex Dynamic Range (RDR). See “RePlex 
Dynamic Range Detection Profile (Jess and Abby) and Default Detection Profile for RePlex assays (Leo)” on page 102 
for more information. The default detection mode for a fluorescence immunoassay using RePlex assay (Jess only) is 
NIR with 6 standard exposures.

The number of exposures collected in the assay can be adjusted if desired.
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Chemiluminescent 

Click the gray arrow next to Detection to expand the row. Click the cell in the RDR column next to Detection Profile (Chemi) 
in either the Probe 1 or Probe 2 column and click the … button that appears to open the Detection Profile window.

Deselect the RePlex Dynamic Range checkbox. Up to 6 additional exposure times (for a total of 7 exposures) can be added 
to the protocol. To remove exposure times, click the Remove button. To add additional exposure times to the protocol, 
click the Add button and enter the values. Select OK when you are done.

NOTE: You can only use the Remove All button to remove exposures if your ladder was not run in the channel you 
are modifying. See “Ladder Channel (Jess only)” on page 77 for more information.
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NIR Fluorescent (Jess only)

Click the gray arrow next to Detection to expand the row. Click the cell in the exposure cell column next to Detection Profile 
(NIR) in either the Probe 1 or Probe 2 column and click the … button that appears to open the Detection Profile window. 

To remove exposure times, click the Remove button. To add additional exposure times to the protocol, click the Add 
button and enter the values. Select OK when you are done.

NOTE: You can only use the Remove All button to remove exposures if your ladder was not run in the channel you 
are modifying. See “Ladder Channel (Jess only)” on page 77 for more information.
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IR Fluorescent (Jess only, if added to the protocol)

NOTES: IR exposures are not selected in a default Jess RePlex assay. Add exposures to add IR fluorescence 
detection to the assay. 

Click the gray arrow next to Detection to expand the row. Click None in the exposure cell column next to Detection Profile 
(IR) in either the Probe 1 or Probe 2 column and click the … button that appears to open the Detection Profile window. 

To add exposure times to the protocol, click the Add button and enter the values. To remove exposure times, click the 
Remove or Remove All button. Select OK when you are done.

NOTE: You can only use the Remove All button to remove exposures if your ladder was not run in the channel you 
are modifying. See “Ladder Channel (Jess only)” on page 77 for more information.



77

Chapter 2: Size Assays  //  RePlex Assays on Jess and Abby: Creating a New Assay

Compass for Simple Western User Guide

Ladder Channel (Jess only)

NOTE: The ladder channel defaults to NIR in assays including fluorescence detection. 

To change the ladder channel, select the cell next to Ladder Channel and select the desired channel in the drop-down 
menu. 

4.	 You can modify any other protocol parameters as needed.

NOTE: For more information on changing protocol step parameters, contact ProteinSimple Technical Support at 
support@bio-techne.com (US/Canada) or Instrument.Support.EMEA@bio-techne.com (Europe). You can also 
contact your local Field Application Scientist for help.

Steps 4–8
Steps 4 through 8 for creating a RePlex Assay are the same as when you’re creating an Immunoassay. Please go to “Step 4 
- Add Assay Notes (Optional)” on page 51 to continue.

mailto:support%40bio-techne.com?subject=
mailto:nstrument.Support.EMEA%40bio-techne.com?subject=
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Immunoassays on Leo: Creating a New Assay
To create a new assay, we recommend using one of the template assays and making any necessary modifications from 
there.

NOTES: 
This section provides details on how to create a Chemiluminescence Immunoassay on Leo. To create a 
Chemiluminescence Immunoassay on Jess or Abby, see “Immunoassays on Jess and Abby: Creating a New Assay” 
on page 41.  
 
To create a RePlex Assay on Leo, that includes an immunoassay, see “RePlex Assays on Leo: Creating a New Assay” 
on page 87. 

Step 1: Open a Template Assay
1.	 Select the Assay screen.

2.	 If Leo is not connected to Compass for Simple Western, select File in the main menu, click New Assay, and select Leo. 

If Leo is connected to Compass for Simple Western, select File in the main menu and click New Assay. 

Alternatively, you can choose Open Assay from the File menu to select from the menu of saved assays. 

3.	 Select the appropriate Size Range.
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4.	 Click OK.

5.	 A template assay with default reagent locations will display in the Sample Layout tab of the Assay screen. The numbers 
on the Sample Plate indicate the cartridge that will load reagents from that row. The Reagent tab will display the size 
range selected. 

NOTE: If you make changes to the assay, such as defining the wells in the plate, be sure to select File and Save 
before proceeding. 

Step 2: Assign Sample Plate Reagents
1.	 Click on the Layout tab and click the Assay Setup button.

You can also select Edit in the main menu when the Assay pane is active and click Assay Setup.

2.	 Define the assay parameters.

a.	 Click the boxes next to the cartridge holder to indicate which holders will be loaded with a cartridge.
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b.	 Select the number of sample, primary antibody, and secondary antibody rows pipetted on the Sample Plate using 
the drop-down list. 

NOTE: An alert will appear if you try to specify a number of reagent rows that exceeds the number of rows available 
on the Sample Plate. 

3.	 Click Next. 

4.	 An ‘Assay Setup - Sample Plate’ prompt will appear. 

•	 Row A–D – Biotinylated ladder (A1, B1, C1, D1) and Samples 
(A2–25, B2–25, C2–25, D2–25)

•	 Row E – Antibody Diluent (E1) and Primary antibody  
(E2–E25)

•	 Row F – Streptavidin-HRP (F1) and Secondary conjugate 
(F2–F25)

•	 Row M – Antibody Diluent

•	 Row N – Wash Buffer

•	 Row P – Luminol/Peroxide mix
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5.	 The default protocol automatically assigns all reagent locations for the assay. Reagents assignments to rows M–P 
should not be modified. 

To modify the reagents assigned to rows A–L: 
a.	 Reorder row locations by clicking on the row and dragging it to the correct location. 

b.	 Change the row a cartridge will load a reagent from by clicking on the cell in the Cartridges column and typing in the 
cartridge number. 

c.	 An alert will appear at the bottom of the prompt if too many rows are assigned to one cartridge, if a cartridge is 
missing a reagent assignment, or if you try to move a reagent to a row that is not allowed.
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d.	 To add or remove a row, click the Back button and adjust the number of rows using the drop-down list. 

6.	 Click Finish. You can also adjust the row a cartridge will load from later in the Protocol pane. 
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7.	 A Sample Plate with updated reagent locations will display in the Sample Layout tab of the Assay screen. Numbers on 
the Sample Plate indicate the row each cartridge will load reagents from. The Reagent tab will display the size range 
selected and the number of Pre-filled Reagent Plates required to perform your run. 

Step 3: Modifying the Assay Protocol (Optional)
The capillary cartridges are all run in parallel, so voltage- and time-based parameters for all the cartridges must be the 
same. Changing the parameter for cartridge 1 will change the parameter for all other cartridges in the protocol. Grayed-out 
parameters or reagent locations cannot be changed. 

To modify the protocol:

1.	 Click on the Protocol tab. This pane shows the individual steps of the assay protocol and allows you to change some 
assay parameters. The example below is for a chemiluminescence Immunoassay.

Each row contains an assay protocol step. Each step contains a Pre-filled Reagent Plate row assignment (gray) or 
Sample Plate row assignment (color-coded), and one or more parameter settings. To view the details for a step, click on 
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the gray arrow next to the step name. We recommend using default protocol settings for the assay. An expanded list of 
the default protocol step parameters is shown below: 

NOTE: To expand all parameters, click the  button at the upper right of the pane. To collapse all parameters, click 
the  button at the upper right of the pane. 

2.	 You can change the primary or secondary antibody incubation time. 

To change the primary antibody incubation time: Click the arrow in the cell next to Primary Antibody Time (min) in the 
‘Cartridge 1’ column and select a new incubation time from the drop-down list. The values for the other cartridges will 
automatically update. 
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To change the secondary antibody incubation time: Click the cell next to Secondary Antibody Time (min) in the 
‘Cartridge 1’ column and enter a new value in minutes. The values for the other cartridges will automatically update. 

3.	 You can change the location of Sample Plate reagents in rows A–L. Click the cell in the column next to the Well Row and 
select a different row on the Sample Plate:

NOTE: Only rows you’ve designated in the Assay Setup as the appropriate content type will appear in the drop-
down list. 
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4.	 The default Leo protocol uses a default detection profile. Exposures in the assay can be adjusted if desired. To do this, 
click the gray arrow next to Detection to expand the row. Click the Default cell in the column next to Detection Profile 
and click the … button that appears to open the Detection Profile window. 

Deselect the Default Profile checkbox. To remove times, click the Remove button. To add additional times to the 
protocol, click the Add button, enter the values, and select OK. 

NOTES: 
No more than two exposures can be longer than 32 seconds.  
 
The Default Detection Profile for chemiluminescence in Immunoassays for Leo is similar to the High Dynamic Range 
(HDR) exposure series used for Jess and Abby assays, but removes the 512 second exposure. See “High Dynamic 
Range Detection Profile (Jess and Abby) and Default Detection Profile (Leo)” on page 100 for more information.  
 
For more information on changing protocol step parameters other than incubation times, contact ProteinSimple 
Technical Support support@bio-techne.com (US/Canada) or Instrument.Support.EMEA@bio-techne.com 
(Europe). You can also contact your local Field Application Scientist for help.

mailto:support%40bio-techne.com?subject=
mailto:Instrument.Support.EMEA%40bio-techne.com?subject=
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Steps 4–8
Steps 4 through 8 for creating an Immunoassay on Leo are the same as when you’re creating an Immunoassay on Jess or 
Abby. Please go to “Step 4 - Add Assay Notes (Optional)” on page 51 to continue.

RePlex Assays on Leo: Creating a New Assay

NOTE: To create a RePlex Assay on Jess or Abby, see “RePlex Assays on Jess and Abby: Creating a New Assay” on 
page 67. 

Step 1 – Open a Template Assay
1.	 Select the Assay screen.

2.	 If Leo is not connected to Compass for Simple Western, select File in the main menu, click New Assay, and select Leo.

If Leo is connected to Compass for Simple Western, select File in the main menu and click New Assay. 

Alternatively, you can choose Open Assay from the File menu to select from the menu of saved assays. 

3.	 Select RePlex.
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These RePlex Assay combinations are currently validated on Leo:

•	 Chemiluminescence Immunoassay + Chemiluminescence Immunoassay using RePlex: Performs a 
chemiluminescence immunoassay followed by another chemiluminescence immunoassay. 

•	 Chemiluminescence Immunoassay + Total Protein Normalization using RePlex and Chemiluminescence 
Detection: Performs a chemiluminescence immunoassay followed by total protein detection. 

The assay selected for Probe 1 is run first. When Probe 1 is complete, Leo performs a wash, RePlex purge, and wash 
step combination prior to beginning the assay selected for Probe 2.

4.	 Select the type of assays.

To run a Chemiluminescence Immunoassay + Chemiluminescence Immunoassay using RePlex – check the boxes for 
Probe 1 and Probe 2. 

To run a Chemiluminescence Immunoassay + Total Protein Normalization using RePlex and Chemiluminescence 
Detection Assay – check the boxes for Probe 1 and Total Protein (Chemiluminescence). The assay for Probe 1 will be 
performed first. 

5.	 Select the Size Range.

6.	 Click OK.

A template assay with default reagent locations will display in the Sample Layout tab of the Assay screen. The numbers on 
the Sample Plate indicate the cartridge that will load reagents from that row. The Reagent tab will display the size range 
selected. 

NOTE: If you make changes to the assay, such as defining the wells in the plate, be sure to select File and Save 
before proceeding.
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Step 2 - Assign Assay Plate Reagents
1.	 Click on the Sample Layout tab and click Assay Setup. 

You can also select Edit in the main menu when the Assay pane is active and click Assay Setup.

2.	 Define the assay parameters.

a.	 Click the boxes next to the cartridge holder to indicate which holders will be loaded with a cartridge.

b.	 Select the number of samples, primary antibody, and secondary antibody rows pipetted on the Sample Plate 
using the drop-down list. The example below is for a Chemiluminescence Immunoassay + Chemiluminescence 
Immunoassay using RePlex assay. 
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NOTE: An alert will appear if you try to specify a number of reagent rows that exceeds the number of rows available 
on the Sample Plate. 

3.	 Click Next. 

4.	 An ‘Assay Setup – Sample Plate’ prompt will appear. 

C H E M I L U M I N E S C E N C E I M M U N OA S S AY + C H E M I L U M I N E S C E N C E I M M U N OA S S AY U S I N G R E P L E X

•	 Row A–D – Biotinylated ladder (A1, B1, C1, D1) and Samples 
(A2–25, B2–25, C2–25, D2–25)

•	 Row E – Primary Probe 1: Antibody Diluent (E1) and Primary 
antibody for Probe 1 (E2–E25)

•	 Row F –Secondary Probe 1: Streptavidin-HRP (F1) and 
Secondary conjugate for Probe 1 (F2–F25)

•	 Row G – Primary Probe 2: Antibody Diluent (G1) and Primary 
antibody for Probe 2 (G2–G25)

•	 Row H –Secondary Probe 2: Antibody Diluent (H1) and 
Secondary conjugate for Probe 2 (H2–H25)

•	 Row M – Antibody Diluent

•	 Row N – Wash Buffer

•	 Row O – RePlex reagent mix

•	 Row P – Luminol/Peroxide mix
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C H E M I L U M I N E S C E N C E I M M U N OA S S AY + TOTA L P R OT E I N N O R M A L I Z AT I O N U S I N G R E P L E X A N D 
C H E M I L U M I N E S C E N C E D E T E C T I O N

•	 Row A–D – Biotinylated ladder (A1, B1, C1, D1) and Samples 
(A2–25, B2–25, C2–25, D2–25)

•	 Row E – Primary Probe 1: Antibody Diluent (E1) and Primary 
antibody for Probe 1 (E2–E25)

•	 Row F – Secondary Probe 1: Streptavidin-HRP (F1) and 
Secondary conjugate for Probe 1 (F2–F25)

•	 Row K – Antibody Diluent (K1) and Total Protein Biotin Labeling 
Reagent (K2–K25)

•	 Row L – Total Protein Streptavidin–HRP for Probe 2 (L1–L25)

•	 Row M – Antibody Diluent

•	 Row N – Wash Buffer

•	 Row O – RePlex reagent mix

•	 Row P – Luminol/Peroxide mix

5.	 The default protocol automatically assigns all reagent locations for the assay. Regent assignments to rows M–P cannot 
be modified. 

To modify the reagents assigned to rows A-L:
a.	 Reorder row locations by clicking on the row and dragging it to the correct location. 

b.	 Change the row a cartridge will load a reagent from by clicking on the cell in the Cartridges column and typing the 
cartridge number. 
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c.	 An alert will appear at the bottom of the prompt if too many rows are assigned to one cartridge or if a cartridge is 
missing a reagent assignment. 
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d.	 To add or remove a row, click the Back button and adjust the number of rows using the drop-down lists. 

6.	 Click Finish. You can also adjust the row a cartridge will load from later in the Protocol pane. 

7.	 A Sample Plate with updated reagent locations will display in the Sample Layout tab of the Assay screen. Numbers on 
the Sample Plate indicate the row each cartridge will load reagents from. Reagents used in Probe 1 are labeled ‘P1’ on 
the plate, those used in Probe 2 are labeled ‘P2’. 
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The Reagent tab will display the size range selected and the number of Pre-filled Reagent Plates required to perform 
your run. 

Step 3: Modifying the Assay Protocol (Optional)
The capillary cartridges are all run in parallel, so voltage- and time-based parameters for all the cartridges must be the 
same. Changing the parameter for cartridge 1 will change the parameter for all other cartridges in the protocol. Grayed-out 
parameters or reagent locations cannot be changed. 

To modify the protocol:

1.	 Click on the Protocol tab. This pane shows the individual steps of the assay protocol and allows you to change some 
assay parameters. The example below is for a 2 Chemiluminescence Immunoassay with RePlex assay. 

Each row contains an assay protocol step. Each step contains a Pre-filled Reagent Plate row assignment (gray) or Sample 
Plate row assignment (color-coded) and one or more parameter settings. To view the details for a step, click on the gray 
arrow next to the step name. We recommend using default protocol settings for the assay. 
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An expanded list of the default protocol step parameters is shown below: 

NOTE: To expand all parameters, click the  button at the upper right of the pane. To collapse all parameters, click 
the  button at the upper right of the pane. 

2.	 You can change the primary or secondary antibody incubation time. The examples shown below are for a 2 
Chemiluminescence Immunoassay with RePlex assay. 

To change the primary antibody incubation time: Click the arrow in the cell next to Primary Antibody Time (min) in the 
‘P1 Cart 1’ column for Probe 1 and ‘P2 Cart 1’ column for Probe 2. Select a new incubation time from the drop-down list. 
The values for other cartridges in that Probe will automatically update. 

NOTE: The column header will change depending on the position of the first cartridge loaded in Leo. For example, if 
two cartridges are loaded in position 2 and 3, the first column header will be ‘P1 Cart 2’. 
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To change the secondary antibody incubation time: Click the cell next to Secondary Antibody Time (min) in the ‘P1 
Cart 1’ column for Probe 1 or the ‘P2 Cart 1’ column for Probe 2 and enter a new value in minutes. The values for the 
other cartridges in the Probe will automatically update. 

3.	 You can change the location of Sample Plate reagents in rows A–L. Click the cell in the column next to the Well Row and 
select a different row on the Sample Plate:

NOTE: Only rows you’ve designated in the Assay Setup as the appropriate content type will appear in the drop-
down list. 
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4.	 The default Leo protocol uses a default detection profile. Exposures in the assay can be adjusted if desired. To do this, 
click the gray arrow next to Detection to expand the row. Click the Default cell in the column next to Detection Profile 
and click the … button that appears to open the Detection Profile window. 

Deselect the Default Profile checkbox. To remove exposure times, click the Remove button. To add additional 
exposure times to the protocol, click the Add button and enter the values. Select OK when you are done. 

NOTES:  
A total of seven exposures are allowed, but no more than one exposure can be longer than 32 seconds.  
 
The Default Detection Profile in RePlex assays for Leo is the same as the RePlex Dynamic Range (RDR) detection 
profile used for Jess and Abby assays. See “RePlex Dynamic Range Detection Profile (Jess and Abby) and Default 
Detection Profile for RePlex assays (Leo)” on page 102 for more information.  
 
For more information on changing protocol step parameters other than incubation times contact ProteinSimple 
Technical Support at support@bio-techne.com (US/Canada) or Instrument.Support.EMEA@bio-techne.com 
(Europe). You can also contact your local Field Application Scientist for help.

mailto:support%40bio-techne.com?subject=
mailto:Instrument.Support.EMEA%40bio-techne.com?subject=
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Steps 4–8
Steps 4 through 8 for creating an RePlex assay on Leo are the same as when you’re creating an Immunoassay on Jess or 
Abby. Please go to “Step 4 - Add Assay Notes (Optional)” on page 51 to continue.

Making Changes to an Existing Assay
1.	 Select the Assay screen.

2.	 Select File in the main menu and click Open Assay.

3.	 A list of the last five assays opened will display. Select one of these assays or click Browse to open the assay folder 
and select a different assay.

4.	 Follow the steps for the appropriate assay to make changes and save the assay:

•	 “Immunoassays on Jess and Abby: Creating a New Assay” on page 41.

•	 “Stellar Assays on Jess: Creating a New Assay” on page 59.

•	 “Protein Normalization on Jess: Creating a New Assay” on page 65. 

•	 “RePlex Assays on Jess and Abby: Creating a New Assay” on page 67.

•	 “Immunoassays on Leo: Creating a New Assay” on page 78.

•	 “RePlex Assays on Leo: Creating a New Assay” on page 87. 

Switching Between Open Assays
If more than one run file is open, you can switch between viewing the assays for each run. To do this:

1.	 Click the down arrow in the Run box.

2.	 Select the run for the assay you want to view from the drop-down list.
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Creating a Template Assay
You can create and save template assays that can be used as a starting point for creating new assays. To do this:

1.	 Select the Assay screen.

2.	 Select File in the main menu. Click Open Assay to open an existing assay or click New Assay to open an existing 
template assay.

3.	 Follow the steps for the appropriate assay to make changes to the assay:

•	 “Immunoassays on Jess and Abby: Creating a New Assay” on page 41.

•	 “Stellar Assays on Jess: Creating a New Assay” on page 59.

•	 “Protein Normalization on Jess: Creating a New Assay” on page 65. 

•	 “RePlex Assays on Jess and Abby: Creating a New Assay” on page 67.

•	 “Immunoassays on Leo: Creating a New Assay” on page 78.

•	 “RePlex Assays on Leo: Creating a New Assay” on page 87. 

4.	 When changes are complete, select File in the main menu and click Save As. Select the New Assays folder:

5.	 Type the name for the new template assay and click Save.

6.	 Select File in the main menu and click Open Assay. The new template assay will now be available in the drop-down list:
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Viewing and Changing the Detection Exposures
To view the current detection profile, roll the cursor over the exposures cell in Protocol pane. In this example, a Jess 
chemiluminescence + fluorescence immunoassay is shown:

High Dynamic Range Detection Profile (Jess and Abby) and Default 
Detection Profile (Leo)
Starting with Compass for Simple Western 4.0 and the Jess instrument, HDR (high dynamic range) is the default detection 
profile for chemiluminescent detection, and with Compass for Simple Western 6.1 and higher, HDR is the default detection 
profile for Stellar fluorescence detection (Jess only). In Compass for Simple Western 7.0, the Default detection profile for 
the Leo system is similar to the chemiluminescence HDR exposure series used for Jess and Abby assays, but removes 
the 512 second exposure. Exposure times for HDR have been optimized for best performance and can’t be edited. These 
exposures were selected for maximum performance for each instrument when HDR mode is selected. Below is an example 
of different exposure settings: 
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To achieve a broader detection dynamic range, you need Compass for Simple Western version 4.0 or higher. To download 
the latest version of the software, go to Help > Check for Updates.

The higher dynamic range is achieved by using a more effective algorithm to create the High Dynamic Range multi-image 
analysis, refreshing substrate from the assay plate prior to each exposure (chemiluminescence only) and minimizing the 
time between substrate aspiration and imaging (chemiluminescence only).

NOTE: See “Images Analysis Settings” on page 287 to find out more about how data sets are analyzed under HDR 
and standard detection profiles.

To use a detection profile used in a previous run or if you prefer not to use HDR (Jess and Abby) or Default (Leo) detection 
profiles, uncheck the box next to High Dynamic Range or Default Profile, respectively, in the Detection Profile window. 
Edit the exposure times as desired. 

NOTE: Only two exposures greater than 32 seconds can be added to a Leo chemiluminescence assay Detection 
Profile. 
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For non-RePlex chemiluminescence assays on Jess and Abby, when the High Dynamic Range box is unchecked, you also 
have the option of selecting RePlex Dynamic Range:

RePlex Dynamic Range Detection Profile (Jess and Abby) and Default 
Detection Profile for RePlex assays (Leo)
For RePlex assays that use chemiluminescent detection, RDR (RePlex dynamic range) is the default detection for Jess and 
Abby. The Default profile on Leo is the same as the RDR exposure series used for Jess and Abby RePlex assays. Exposure 
times for these detection profiles use the short exposure times from HDR, eliminating the 128 and 512 second exposures. 
Below is an example of the RDR exposure settings:

NOTE: See “Images Analysis Settings” on page 287 to find out more about how data sets are analyzed under HDR 
and standard detection profiles.
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If you prefer not use the RDR (Jess/Abby) or Default (Leo) detection profile, uncheck the box next to RePlex Dynamic 
Range or Default Profile, respectively, in the Detection Profile window and edit the exposure times as desired. Up to 
7 exposures may be added to the RePlex assay Detection Profile. For more information on RDR, please refer to Simple 
Western assay optimization guidelines. 

NOTE: Only one exposure greater than 32 seconds can be added to a Leo RePlex assay Detection Profile for 
chemiluminescence. 

Changing the Detection Profile
While we recommend using the default detection profile, you can change the profile, exposure times and exposure 
sequences if needed. To do this:

1.	 To open a Detection Profile, select the exposures cell in the Protocol pane and click the ... button. Examples of the 
Detection Profile screen for chemiluminescence are shown below: 
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a.	 To change an existing chemiluminescence exposure time - Uncheck High Dynamic Range or RePlex Dynamic 
Range (Jess and Abby) or Default Profile (Leo) if checked. Then click in the exposure cell and enter a new time in 
seconds. An example from Jess is shown below:

b.	 To change an existing fluorescence exposure time - Click in the exposure cell in the Detection Profile window and 
enter a new time in seconds. An example from Jess is shown below:

c.	 To delete an existing exposure - Select an exposure cell and click Remove. For runs performed on Jess with 
fluorescence detection, you can delete all exposures if the ladder was not run in that channel or if it is not the only 
channel used in the probe by selecting Remove All. 

d.	 To add a new exposure - Select Add. A new exposure will be added to the end of the list. Click in the exposure cell 
and enter an exposure time in seconds.

2.	 Click OK to save and exit.
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Copying Protocols and Templates
The steps and parameters in the Protocol pane can be copied and pasted into other documents, as can the graphic image 
of the names and attributes in the Template pane.

Copying an Assay Protocol
1.	 Click on the Protocol tab.

2.	 Select Edit in the main menu and click Copy.

3.	 Open a document (Microsoft® Word®, Excel®, etc.). Right-click in the document and select Paste. All assay protocol 
steps and parameters will be copied into the document as a list in the same format shown in the Protocol pane.

Copying an Assay Template
You can copy cells or an entire row from your assay template to paste into another document. 

1.	 Click on the Template tab.

2.	 Select the cell(s) or row. 

3.	 Select Edit in the main menu and click Copy.

4.	 Open a document (Microsoft® Word®, Excel®, etc.). Right-click in the document and select Paste. The assay template 
will be copied into the document as an image, exactly as it is shown in the Template pane.

Printing Protocols and Templates
The information in the Protocol pane can be printed, as can a graphic image of the information in the Template pane.

Printing an Assay Protocol
1.	 Select File in the main menu, click Print, and then click Print Protocol.

All assay protocol steps and parameters will be printed as a list in the same format shown in the Protocol pane.
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Printing an Assay Template
1.	 Select File in the main menu, click Print, and then click Print Template.

The assay template will print as an image, exactly as it is shown in the Template pane.

Importing and Exporting Protocols and Templates
The assay protocol in an open assay or run file can be exported as a separate file, as can the assay template name and 
attribute information. This allows the same assay protocol and template information to be imported into another assay 
later, rather than having to re-enter assay protocol and template information manually.

Importing an Assay Protocol

NOTE: Importing an assay protocol imports information into the Protocol pane only.

1.	 Open the assay you want to import the assay protocol in to.

2.	 Select File in the main menu and click Import Protocol.

3.	 Select a protocol file (*.protocol) and click OK. The imported information will display in the Protocol pane.

Exporting an Assay Protocol

NOTE: Exporting an assay protocol exports information in the Protocol pane only.

1.	 Open the assay you want to export the assay protocol from.
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2.	 Select File in the main menu and click Export Protocol. The following window displays:

3.	 The default directory is Compass for SW/Assays. Change the directory if needed.

4.	 Enter a protocol name and click Save. The protocol will be saved as a *.protocol file.

Template Export and Import
The Template information including the sample and reagent names can be exported to a file.

There are two file format options:

•	 A comma separated CSV file that is best opened in a spreadsheet.

•	 A tab delimited TXT file that can be opened in a spreadsheet even when the decimal separator is set to a comma.
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Exporting then Importing the Template to a CSV file
Follow the steps below to easily export a template from Compass for Simple Western, populating it with reagent names 
(sample, antibody, etc.) and their corresponding attributes (concentration, dilution factor, etc.).

1.	 Select File in the main menu and click Export Template. You can also select the Export button in the top right corner of 
the Template (Jess and Abby) or Sample Template (Leo) pane. 

2.	 The following window displays:

It is recommended to set the ‘Save as type’ to CSV.

3.	 Enter a template name and click Save. The template will be saved as a *.csv file.

4.	 Open the CSV file in a spreadsheet program like Microsoft® Excel®.
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The names in the spreadsheet are arranged in the same order as the Compass Template, and the rows alternate 
between names and attributes.

NOTE: The default assay has no attributes so these rows will be empty.

5.	 Edit the names and add attributes, then save the spreadsheet as a CSV file.

NOTE: Make sure not to edit the first column of the spreadsheet, this corresponds to the ladder wells.

6.	 To import the edited CSV file into Compass for Simple Western, select File in the main menu and click Import 
Template. You can also select the Import button in top right corner of the Template (Jess and Abby) or Sample 
Template (Leo) pane. Browse to the .csv file you just saved. Once imported, the edited CSV file displays the edited 
Sample names and Primary Antibody with attributes in the Template.

Template Cut and Paste
The names and attributes in the Template can be copied and pasted within Compass for Simple Western, between two 
copies of Compass, and between Compass and a spreadsheet like Microsoft® Excel®.

Enter names in a spreadsheet row, then copy to the clipboard. Next, select the top of a well in the Template and paste a 
name from the clipboard or select the bottom of a well and past an attribute from the clipboard. The new names will be 
pasted into the row at the selected column and columns to the right. Here’s a quick example of how to do it:

1.	 Copy these three rows from a spreadsheet:
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2.	 Select a well in the Template, A2 is selected for this example:

3.	 Paste the names from the clipboard into the first row.

NOTE: Make sure not to select any of the ladder wells (A1, B1, C1, etc.)

 

4.	 Paste the attributes from the clipboard into the second row:

5.	 Pasting into the Template will update the names and attributes.
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Multiple rows can also be copied and pasted with names and attributes on alternate rows:

Only wells in the same row can be selected, but multiple rows will be pasted into the rows below.

NOTE: Make sure not to select any of the ladder wells (A1, B1, C1, etc.).
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Starting a Run

NOTE: If you are using a Wes, Peggy Sue, Sally Sue, or NanoPro 1000, Compass for Simple Western version 
7.0 and higher does not support these instruments. You can still use software versions 5.x and lower for Peggy 
Sue, Sally Sue, or NanoPro 1000 and software versions 6.x and lower for Wes to create, load, and run assays on 
these systems, and to analyze data. Lower versions of Compass can be downloaded at the Instrument Software 
Download Center on the Bio-Techne website.

Step 1 - Get Ready
1.	 Turn your system on and allow it to remain on for at least 1.5 hours before starting a run to ensure the instrument 

reaches its temperature setpoint.

2.	 Open Compass for Simple Western Software. 

3.	 Create or open an assay file in Compass for Simple Western.

4.	 Prepare the assay plate for Jess and Abby using the information provided in the Simple Western kit product insert. 
Prepare the Sample Plate for Leo using the information provided in the Leo Quick Start Guide. 

IMPORTANT 
If a row on the assay plate contains reagents in some wells but not in others, pipette DI water or the diluent used for 
other reagents in the row into the empty wells of that row. This prevents air aspiration and bubble formation in the 
capillary cartridge. To prevent well evaporation and ensure best results, keep a lid on the assay plate until ready to 
use.

5.	 Prepare the instrument following the procedure described in the instrument User Guide.

IMPORTANT 
Capillaries are light sensitive. Keep them covered until you are ready to transfer the capillary cartridge to the 
instrument.

6.	 For Leo only – place the Pre-filled Reagent Plate(s) into the Pre-Filled Reagent Plate holder(s) in Leo. 

7.	 Remove the capillary cartridge(s) from the packaging and insert the into the cartridge holder(s). 

8.	 Place Assay Plate/Sample Plate into the sample tray/sample plate holder of the instrument. 

https://www.bio-techne.com/resources/instrument-software-download-center
https://www.bio-techne.com/resources/instrument-software-download-center
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Step 2 - Start the Run
You can start a run in one of two ways depending on whether you want to run an assay using existing parameters or set up 
a new assay.

NOTES:  
Start runs from the Assay screen only. 
 
Your Leo, Jess, or Abby system must be connected to Compass for Simple Western to start a run. 

1.	 New run of an existing assay:

a.	 In the Assay screen, select File in the main menu and click Open Assay.

b.	 A list of the last five assays opened will display. Select one of these assays or click Browse to open the Assay folder 
and select a different assay.

2.	 Alternatively, choose New Assay and select one of the size assays to get the default assay conditions for using Leo, 
Jess, or Abby.

a.	 The Start button will display. This indicates that an assay has been loaded.
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3.	 Click Start to begin the run.

The Start Run window for immunoassays displays with the default run file name and location. In the examples below 
are Start Run windows for a Chemiluminescence Immunoassay, RePlex Assay, and Stellar Assay on Jess. You can edit 
the file name and/or click Browse if you want to save it in a different location.

NOTE: Run file names should not exceed 255 characters. Only space, -, _, A-Z, a-z, 0-9 are allowed when naming 
run files.
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4.	 The instrument will scan cartridge and plate barcodes after the door is closed. The instrument status indicator will blink 
blue until the instrument has initialized and completed the barcode scan:

a.	 For Jess and Abby: confirms that the cartridge type and plate installed matches the assay selected for the run. 

b.	 For Leo: confirms that the number of cartridges and Pre-filled Reagent Plates matches the assay setup, that the 
Pre-filled Reagent Plates match the assay selected for the run, and that a Sample Plate has been loaded in the 
instrument. 

c.	 Check the cartridge and plate expiration dates. You can still start the run if these are expired, but performance is not 
guaranteed. 
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5.	 Scanning barcodes will initiate Start Run check.

a.	 If the cartridge type or plate installed in the instrument doesn’t match the assay selected for the run or the number 
of cartridges and Pre-filled Reagent Plates for a Leo run doesn’t match the assay setup, messages indicating this 
will display in the Start Run window. If this happens, click Cancel and adjust your assay settings before starting the 
run again.
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b.	 If a cartridge or plate is expired or a barcode is not readable, a warning will appear. You will still be able to start the 
run and the warning information will be saved in the run History.

6.	 Click Start to begin the run. Instrument status will change to Running, the Start button will change to Stop, and the Run 
Progress bar will display:

Step 3 - Post-Run Procedures
1.	 Remove the capillary cartridge(s).

2.	 Remove the Jess and Abby assay plate or remove the Leo Sample Plate and Pre-filled Reagent Plate(s).

3.	 Dispose of the plate(s) and capillary cartridge(s). Disposal will depend on the samples that have been assayed. If 
sample origins are unknown, we recommend that used capillary cartridges and plates be disposed of as biohazard 
waste.

WARNING! SHARPS HAZARD 
The capillaries may present a potential sharps hazard. Dispose of used capillary cartridges in biomedical waste 
sharps containers.
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!WARNING! BIOHAZARD  
Samples and plates contents should be handled by procedures recommended in the CDC/
NIH manual: Biosafety in Microbiological and Biomedical Laboratories (BMBL). The manual 
is available from the U.S. Government Printing Office or online at https://www.cdc.gov/labs/
bmbl/index.html. 
 
Depending on the samples used, residual plate contents may constitute a biohazard. Dispose 
of plates in accordance with good laboratory practices and local, state/provincial and national 
environmental and health regulations. Read and understand the Material Safety Data Sheets 
(MSDSs) provided by the manufacturers of the chemicals in the plates before you store, 
handle or dispose of chemical waste.

Stopping a Run
To stop a run, click Stop.

When the run stops, the Start button with reappear and the instrument will start a process that plugs the capillaries in the 
cartridge. Once that’s done, you can then remove the capillary cartridge(s) and plate(s) and discard them. The stopped 
status, date and time will display in the Run Summary screen.

 

https://www.cdc.gov/labs/bmbl/index.html
https://www.cdc.gov/labs/bmbl/index.html
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Starting a Run

Step 1 - Get Ready
1.	 Prepare the membrane and assemble the blot cartridge following the product insert.

2.	 Open Compass for Simple Western software on your desktop.

3.	 Make sure that the software is connected to the instrument.

4.	 Insert the blot cartridge into the blot holder. The light in the blot holder will change from orange to blue when correctly 
seated.

5.	 Close the instrument door by gently pushing it until you feel Jess pull it closed.

Blot Holder

The software will automatically change to the Blot screen:

Step 2 - Start the Imaging Run

NOTE: The Jess system door must be closed before starting the imaging run.
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Once the blot cartridge is installed and the Jess system’s door is closed, Compass for Simple Western will automatically 
provide a preview image.

1.	 Edit the exposure settings in the Exposures table.

•	 To add an exposure: Click Add then select the exposure time to change it.

•	 To remove an exposure: Select the exposure and click Remove.

•	 To edit exposure time: Click on an exposure and enter a new time.
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2.	 Check the Markers box if the blot contains a molecular weight ladder.

3.	 To load the saved settings from an existing blot imaging protocol file (*.blot), click Open. Select the protocol file and 
click Open.

4.	 You can change the Results File name and location if desired. Imaging file names are automatically generated as date_
time_blot.btz and saved in the Compass for SW\Blots folder of your My Documents folder.

5.	 Optional: Add any comments you would like saved with your imaging run in the Comments box and click Save.

6.	 Optional: To save the settings associated with this blot imaging protocol for future use, click Save.

7.	 Click Start to begin imaging.
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Step 3 - Imaging Run Summary and Analysis

Reviewing Imaging Data

When the imaging run starts, thumbnails are shown in the Run Summary screen.

As images are acquired, they populate the predefined thumbnail boxes and also display in the Review pane. Unless you 
click on a thumbnail, the most recently acquired image displays in the Review pane. Images that haven’t been taken yet will 
display blank until the image is acquired.

The Run Summary pane will display thumbnail images for each exposure configured in the imaging protocol:

NOTE: The Markers image is taken at the end of the imaging run. If you click Stop before all exposures are taken, 
the software will prompt you to confirm that you want to stop the run before the Markers image is taken.
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Adjusting Blot Images

You can adjust the blot image using the Review pane toolbar.

The toolbar has the following options:

Contrast Adjustment

Auto Contrast

Invert

Overlay Markers

An unadjusted blot image is shown in the following example:
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Exporting Image Files

To export raw images for further analysis, from the main menu, select File > Export Images. Then select a folder to export 
the files to.

Compass for Simple Western will automatically launch a Windows Explorer window for you to access the saved files. 
Images are saved in .png format, and both raw and adjusted images are saved in the folder.

•	 Raw chemiluminescence images are saved as: <Results File Name>_Chemi_<Exposure Number>_<Exposure Time>.

•	 Processed images, as shown in the Review pane, are saved as: <Results File Name>_<Exposure Time>_view.

•	 Raw and processed marker images are saved as: <Results File Name>_Markers and <Results File Name>_Markers_
view, if selected during the blot imaging protocol.

Step 4 - Post-Imaging Procedures
When imaging is done, you’ll need to:

1.	 Remove the blot cartridge.

2.	 Remove your membrane and clean the blot cartridge by rinsing it with water. Dry with a lint-free wipe.

3.	 Wipe down the area underneath the blot cartridge in the instrument with a dry lint-free wipe.

4.	 Keep the blot cartridge in a dry, clean area protected from dust.

Stopping a Run
To stop an imaging run, click Stop and confirm your choice. When the run stops, the Start button will reappear so you can 
start another run when you’re ready.
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Run Summary Screen Overview
The Run Summary screen is used to monitor run progress, watch movies of the fluorescent standards separation, and view 
current and voltage plots for a run. To access this screen, click Run Summary in the screen tab:

The run in progress will automatically load when the instrument is connected to Compass for Simple Western Software. 

Run Summary Screen Panes
The Run Summary screen has the following panes:

•	 Status – Displays run file information and current status of a run in progress.

NOTE: If status doesn’t update during a run, there may be a disconnect between the instrument and computer. If 
this happens and the status light on the instrument is still blinking, let the run complete first and then reconnect to 
the instrument.

•	 Separation – Lets you view a movie of the fluorescent standards separation for each cartridge in the experimental run.

•	 IV Plots – Lets you view plots of the total current and voltage measured during separation for all capillaries for each 
cartridge in the experimental run.

•	 Barcodes (Leo only) – Displays the barcodes and expiration dates for the cartridge(s), and the barcodes for the 
Pre-filled Reagent Plate(s) and Sample Plate used in a run. This information can be found in the Status pane on Jess 
and Abby systems. 
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Software Menus Active in the Run Summary Screen
The following software menus are available:

•	 File

•	 Edit

•	 Instrument 

NOTE: The Instrument submenu options will change depending on whether Compass is connected to an instrument. 

•	 Window

•	 Help

The File and Edit menu options specific to the Run Summary screen are described next.

File Menu

The following options can be found in the File menu:

•	 Open Run – Opens a run file.

•	 Add Run – Open and view other run files in addition to the one that is already open.

•	 Close – Closes the run file currently being viewed.

•	 Close All – Closes all open run files.

•	 Save – Saves the open run file.

•	 Save As – Saves the open run file under a different file name.

•	 Run Report – Creates a report of the run in .pdf format. See “Running Reports” on page 206 for more information

•	 Exit – Closes Compass for Simple Western.
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Edit Menu

The following options can be found in the Edit menu:

•	 Preferences – Set and save custom preferences for data export, and plot colors in the graph. See Chapter 8: “Setting 
Your Preferences” for more information.

Viewing File and Run Status Information
Information specific to each run file is shown in the Status pane for Jess and Abby, and the Status pane and Barcode pane 
for Leo.  

J E S S S TAT U S PA N E
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L E O S TAT U S PA N E

The run file name, path (directory location) and assay used is displayed along with instrument serial number and the run 
start/complete date and time.

•	 To go to the run file directory location – Double click the path hyperlink, or right-click and select Open Directory.

•	 To copy the path – Right-click on the path hyperlink and click Copy Path. The path can then be copied into documents. 
The path can also be copied into the Windows Explorer address bar to launch Compass for Simple Western and open 
the run file automatically.

•	 Kit info – Compass for Simple Western v2.7 and higher displays the type of kit used to run the assay (regular for 
immunoassays or total protein) and the molecular range.

•	 Plate S/N (Jess and Abby) – The plate serial number (S/N) information is captured and displayed for all assays.

•	 Cartridge S/N (Jess and Abby) – the cartridge serial number (S/N) information is captured and displayed for all assays. 

•	 Cartridge expires (Jess and Abby) – the cartridge expiration date is captured and displayed. 
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The Leo Barcode pane records the scanned barcodes and expiration dates for the Sample Plate, Pre-filled Reagent 
Plate(s), and Cartridge used in the run. 

L E O B A R C O D E PA N E

Assay Steps: Size-based Assays
Each assay step that is executed during the run is represented by an icon. The time the individual step is scheduled to start 
is shown under each icon. Details on what happens during each assay step is as follows:

S TA N DA R D S I Z E A S S AYS

Step Description

Sample Loading Step - Separation Matrix and Stacking Matrix are aspirated first into the capillaries followed by 
biotinylated ladder and samples. Capillaries are then transferred to the running buffer trough.

Separation Step - Samples and fluorescent standards are separated in the capillaries. During the separation, 
voltage and current are monitored and displayed in the IV Plot. Separation of the fluorescent standards is recorded, 
and a movie of the separation is compiled for viewing when separation is complete in the Separation pane. 
Capillaries are then exposed to UV light, which immobilizes the separated proteins to the walls of each capillary. 
After separation, Matrix Removal Buffer is aspirated.

Protein Normalization Step (Jess only) - Protein normalization reagent is aspirated and incubated in the capillary. 
When the incubation is complete, Wash Buffer is aspirated.

Blocking Step - Blocking reagent (Antibody Diluent) is aspirated and incubated in the capillary. When the 
incubation is complete, Wash Buffer is aspirated.

Primary Antibody (1°) Step - Primary antibody is aspirated and incubated in the capillary. When incubation is 
complete, Wash Buffer is aspirated.
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Step Description

Secondary Antibody (2°) Step - Secondary HRP/NIR/IR antibody conjugate and Streptavidin-HRP/NIR is aspirated 
and incubated in the capillary. When incubation is complete, Wash Buffer is aspirated.

Detect Step - Luminol-Peroxide solution is aspirated into the capillary (chemiluminescence only). Emitted 
chemiluminescent light is detected with the CCD camera. For fluorescence detection on Jess, emitted fluorescent 
signal is detected.

Results Step - Results are available in the Analysis screen.

When a run is in progress, icons for steps that have not executed will be gray (inactive). In the following example, the 
Secondary Antibody (2°) step is executing and the Detect and Results steps have not started:

R E P L E X A S S AYS

Step Description

Sample Loading Step - Separation Matrix and Stacking Matrix are aspirated first into the capillaries followed by 
biotinylated ladder and samples. Capillaries are then transferred to the running buffer trough.

Separation Step - Samples and fluorescent standards are separated in the capillaries. During the separation, 
voltage and current are monitored and displayed in the IV Plot. Separation of the fluorescent standards is recorded 
and a movie of the separation is compiled for viewing when separation is complete in the Separation pane. 
Capillaries are then exposed to UV light, which immobilizes the separated proteins to the walls of each capillary. 
After separation, Matrix Removal Buffer is aspirated.

Label Step (Total Protein only) - Total Protein Biotin Labeling Reagent is aspirated and incubated in the capillary. 
When incubation is complete, Wash Buffer is aspirated.

Blocking Step - Blocking reagent (Antibody Diluent) is aspirated and incubated in the capillary. When incubation is 
complete, Wash Buffer is aspirated.

Primary Antibody (1°) Step - Primary antibody is aspirated and incubated in the capillary. When incubation is 
complete, Wash Buffer is aspirated.
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Step Description

Secondary Antibody (2°) Step - Secondary HRP/NIR/IR antibody conjugate and Streptavidin-HRP/NIR is aspirated 
and incubated in the capillary. When incubation is complete, Wash Buffer is aspirated.

HRP Step (Total Protein only) - Total Protein Streptavidin-HRP is aspirated and incubated in the capillary. When 
incubation is complete, Wash Buffer is aspirated.

Detect Step - Luminol-Peroxide solution is aspirated into the capillary (chemiluminescence only). Emitted 
chemiluminescent light is detected with the CCD camera. For fluorescence detection on Jess, emitted fluorescent 
signal is detected.

Purge Step - Wash Buffer and then RePlex reagent mix is aspirated to remove the Probe 1 primary and secondary 
antibodies from the immobilized sample proteins. This is followed by another round of Wash Buffer.

Results Step - Results are available in the Analysis screen.

When a run is in progress, icons for steps that have not executed will be gray (inactive). In the following example, the 
Secondary Antibody (2°) step is executing and the Detect and Results steps have not started:

S T E L L A R A S S AYS (J E S S O N LY )

Step Description

Sample Loading Step - Separation Matrix and Stacking Matrix are aspirated first into the capillary followed by 
biotinylated ladder and samples. Capillaries are then transferred to the running buffer trough.

Separation Step - Samples and fluorescent standards are separated in the capillaries. During the separation, 
voltage and current are monitored and displayed in the IV Plot. Separation of the fluorescent standards is recorded 
and a movie of the separation is compiled for viewing when separation is complete in the Separation pane. 
Capillaries are then exposed to UV light, which immobilizes the separated proteins to the walls of each capillary. 
After separation, Matrix Removal Buffer is aspirated.
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Step Description

Label Step (Total Protein only) - Total Protein Biotin Labeling Reagent is aspirated and incubated in the capillary. 
When incubation is complete, Wash Buffer is aspirated.

Blocking Step - Blocking reagent (Antibody Diluent) is aspirated and incubated in the capillary. When incubation is 
complete, Wash Buffer is aspirated.

Primary Antibody (1°) Step - Primary antibody is aspirated and incubated in the capillary. When incubation is 
complete, Wash Buffer is aspirated.

Secondary Antibody (2°) Step - Stellar secondary antibody is aspirated and incubated in the capillary. When 
incubation is complete, Wash Buffer is aspirated.

Amplify Step - Stellar IR or NIR Anneal is aspirated into the capillary followed by Stellar IR or NIR Label. These 
steps are repeated 10 times. When amplification is complete, Wash Buffer is aspirated.

Detect Step - Luminol-Peroxide solution is aspirated into the capillary (chemiluminescence only). Emitted 
chemiluminescent light is detected with the CCD camera. For Stellar fluorescence detection, emitted fluorescent 
signal is detected.

Results Step - Results are available in the Analysis screen.

When a run is in progress, icons for steps that have not executed yet will be gray (inactive). In the following example, the 
Amplify step is executing and the Detect and Results steps have not started:
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Watching Standards Separation Movies
You can view a movie of the fluorescent standards separation in the capillaries. To do this:

1.	 Click the Separation tab.

J E S S/A B BY R E P L E X

L E O

2.	 The player control panel has play/pause, rewind and fast forward buttons, and a slider bar that allows you to scroll 
through the movie manually:



137

﻿ Chapter 5: Run Status  //  Viewing Current and Voltage Plots

Compass for Simple Western User Guide

Click Play (button on far left) to view the movie. In the example below, standards for a Jess size assay are shown:

NOTE: Complete separation movies of the fluorescent standards are not available until the separation step has 
finished executing. If the movie is played while the separation step is still executing, the movie will only show 
separation progress up to the current point in time.

Viewing Current and Voltage Plots
You can view plots of the total current and voltage measured during separation. To do this, click the IV Plot tab. The 
example below is from a Leo Chemiluminescence Immunoassay.



138

﻿ Chapter 5: Run Status  //  Switching Between Open Run Files

Compass for Simple Western User Guide

The blue Y-axis and plot show the separation voltage in volts (V), and the red Y-axis and plot shows the separation current 
in microamps (μA). The X-axis displays time in seconds.

•	 To zoom in on an area of the plot – Hold the mouse button down and draw a box around the area with the mouse.

•	 To zoom out – Click Zoom Out in the upper right corner of the pane.

NOTE: The IV plot for a run in progress will not be available until the separation step starts executing. The plot is 
then displayed in real-time.

Switching Between Open Run Files

NOTE: See “Opening Run Files” on page 153 for more information. 

If more than one run file is open, you can switch between viewing the run information in each while in the Run Summary 
screen. To do this:

1.	 Click the down arrow in the Run box.

2.	 Select the run you want to view from the drop-down list.

Closing Run Files
If more than one run file is open, you can close just one file or all the open files at the same time.

•	 To close one run file

a.	 Select File from the main menu and then click Close to open the submenu.
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b.	 Select the run you want to close. 

•	 To close all open run files – Select File from the main menu and click Close All.
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Instrument Control
The instrument menu allows you to control Jess, Abby, and Leo.

NOTES:  
Instrument menu options are active only when a computer with Compass for Simple Western is connected directly 
to Jess, Abby, or Leo. Available functions will vary depending on the instrument. 
 
When your instrument is not connected to Compass, the Instrument menu allows you to connect Jess, Abby, or Leo 
to the software. 
 
If the instrument is in an Error state, a Reset option will appear in the menu and the Self Test option will be disabled. 

Self Test
Jess, Abby, and Leo can perform a series of tests to check for proper instrument performance. To start the test, select 
Instrument and click Self Test. The test takes approximately 15 to 30 minutes for Jess and Abby and approximately 
20 minutes for Leo.

NOTE: We recommend performing the self test monthly or when encountering issues with the system. When 
performing a self test, start the test before preparing your sample, reagents, and pipetting plates for your 
instrument.
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To view the test log at completion of the test, select Instrument, click Properties and click View Logs. See “Self Test 
Report” on page 145 for more information.

Viewing and Changing System Properties
Select Instrument and click Properties to display system properties which include:

•	 Name

•	 Location

•	 Type

•	 Serial number

•	 Instrument software version (embedded)

•	 Network name and address

•	 Date and time of the instrument clock

To change system name or location – click in the name or location boxes and enter the new information.

To sync the instrument clock with the computer – click Set to PC time.

NOTE: Reboot the computer and instrument and wait for about one minute.

To confirm the time was set properly after syncing:

1.	 Open Compass for SW.

2.	 Go to Instrument > Properties.

3.	 Check if Instrument Date and Time matches your local time.

4.	 If it doesn’t match, click Set to PC time again.
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If the time zone is not set correctly:

1.	 In Windows, go to Date and Time Settings and turn on Set time zone automatically.

NOTE: Windows may handle Daylight Savings Time differently.

2.	 Under Synchronize your clock, click Sync now.

3.	 Confirm that the computer now has the correct time and time zone.

4.	 Start Compass for Simple Western.

5.	 Connect the software to your instrument.

6.	 Select Instrument and click Properties.

7.	 Click Set to PC Time.

8.	 Close Compass for Simple Western.

9.	 Turn the instrument off.

10.	Turn the instrument on.

11.	 Open Compass for Simple Western.

12.	Connect the software to your instrument.

13.	Select Instrument and click Properties.

14.	Confirm the instrument time.

Viewing Log Files

System Logs
1.	 Select Instrument in the main menu and click Properties to display system properties.
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2.	 Select Logs and then click All Logs. A list of system logs will display:

3.	 Select a log file and click View. The details for that log will display: 

4.	 Click Save File As to save a copy of the log file.
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Self Test Report
To view a self test report from the Instrument Log. 

1.	 Select Instrument in the main menu and click Properties to display system properties.

2.	 Click Logs. A list of self tests that have been performed will display:

NOTE: The “All Logs” button will not appear when Compass for SW is connected to a Jess instrument.

3.	 Select a self test and click View. The individual test details will display:
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4.	 Click Save File As to save a copy of the log file.

To download self test reports. 

1.	 Select Instrument in the main menu and click Properties to display system properties.

2.	 Click Reports. 

3.	 Select the number of self test reports to download and the self test details to include. You can also select a date to 
download reports from that day onward. 

4.	 Enter a file name for the report.

5.	 Click OK to save the self test report(s) to the designated file directory. 

Software Updates
To check for software updates, go to Compass for Simple Western, select Help in the main menu, and click Check for 
Updates.

Instrument Software (Embedded) Updates
To view the version installed, open Compass for Simple Western, select Instrument in the main menu, then click 
Properties. The current version of system software will be displayed.

To check for embedded updates, go to Compass for Simple Western, select Instrument in the main menu, then Update, 
and select Network. If you are not on the network, contact ProteinSimple Technical Support for assistance on how to 
obtain the latest update.
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Status Modes
The instrument status bar displays status, buttons, and progress bars depending on what Jess, Abby, or Leo is doing.

•	 Ready/Start button - The instrument is ready and an assay is loaded. The indicator light will be solid blue. Click Start 
to begin a run. 

•	 Not Ready/Reset button - The instrument is not ready and must reinitialize. The indicator light will be red or magenta. 
Click Reset to start the initialization protocol.

•	 Running/Stop button - The instrument is running an assay. The indicator light will be blinking blue. The run name, time 
the run started and when it will complete display in the run progress bar. Click Stop to stop the run.

•	 Error/Reset button - An error has occurred. Go to the Status window in the Run Summary screen to view details. The 
indicator light will be red. When the source of the error is corrected, click Reset.
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Analysis Screen Overview
The Analysis screen is used to view run data including electropherograms, capillary images, lane view data and tabulated 
results. Any post-run analysis is also done in this screen. To access this screen, click Analysis in the screen tab:

Analysis Screen Panes
The Analysis screen has seven panes, each displays the following data for capillaries in the experimental run:

•	 Experiment – Lists sample, reagent, cartridge, and capillary information for the data generated. Sample and reagent 
information is defined the assay template and is automatically updated in the Experiment pane. 

•	 Graph – Displays electropherogram data for sample proteins or fluorescent standards.

•	 Image – Displays an image of the separated sample proteins or fluorescent standards in the capillaries

•	 Lane – Displays data for sample proteins or fluorescent standards as bands in individual lanes. This virtual blot-like 
image is similar to traditional blot results.

•	 Peaks – Lists the tabulated results for sample proteins and information for identified fluorescent standards.

•	 Capillaries – Displays a list of the sample proteins Compass for Simple Western named automatically using the user-
defined peak name analysis parameters.

•	 Analysis Options – Displays options to change various exposure settings and edit/label peak attributes.

•	 Annotations – Creates annotated lane view figures.

NOTE: If you don’t see data in the Analysis screen after a run, there may have been a disconnection between the 
instrument and computer during the run. If this happens, the instrument’s embedded computer will have a copy of 
the run file. Go to Instrument > Runs... to find and save a copy of the run file.
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NOTE: The reported molecular weight for sample proteins in Compass for Simple Western may vary from apparent 
molecular weights using other techniques and based on sample and assay conditions.1,2

Software Menus Active in the Analysis Screen
The following software menus are available:

•	 File

•	 Edit

•	 View

•	 Instrument 

NOTE: The Instrument submenu options will change depending on whether Compass is connected to an instrument. 

•	 Window

•	 Help

The File, Edit and View menu options specific to the Analysis screen are described next.

1 Electrophoresis. 2021 Aug;42(14-15):1521-1531. doi: 10.1002/elps.202100068. 
2Electrophoresis. 2021 Feb;42(3):206-218. doi: 10.1002/elps.202000199. 
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File Menu

The following options can be found in the File menu:

•	 Open Run – Opens a run file.

•	 Add Run – Opens and views other run files in addition to those that are already open in the active Compass window.

NOTES:  
The run files must be the same assay type and use the same detection channels.  
 
When multiple runs are open in the active Compass window, a menu expand arrow will appear next to the close, 
save as, export tables, export spectra, and run report menu options. Choose the run you want to close, save, or 
export information from. 

•	 Close – Closes the run file currently being viewed. 

•	 Close All – Closes all open run files in the active Compass window. 

•	 Save – Saves changes to the open run file.

•	 Save As – Saves changes to the open run file under a different file name. 

•	 Export Tables – Exports the results for all capillaries in the run in .txt format.

•	 Export Spectra – Exports the raw data traces for each capillary in the run in .txt or .cdf format.

•	 Run Report – Creates a report of the run in .pdf format.

•	 Exit – Closes Compass for Simple Western.
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Edit Menu

The following options can be found in the Edit menu:

•	 Copy – Lets you copy data shown in the graph, image, lane, peaks, or capillaries panes. See “Copying Data Views and 
Results Tables” on page 203 for more information.

•	 Analysis – Displays the analysis settings used to analyze the run data when a run file is open and lets you change them 
as needed. See “Analysis Settings Overview” on page 277“ for more information. 

•	 Preferences – Lets you set and save custom preferences for data export and plot colors in the graph. See Chapter 8: 
“Setting Your Preferences” for more information.

View Menu

The following option can be found in the View menu:

•	 Selected View – Displays data in a per capillary (single) view format.

•	 All View – Displays data in a multiple capillary view format.

•	 Standards – Lets you change the data view to show only the fluorescent standards.

•	 Samples – Lets you change the data view to show sample proteins.

•	 Filter – Lets you display data only for specific capillaries, cartridges (Leo only), or named proteins.

•	 View Region – Lets you change the molecular weight (x-axis) range of the data displayed.

•	 Show Hidden – Shows capillaries that have been hidden from the data view.
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Opening Run Files
You can open one or multiple run files at a time to compare data between runs.

Opening One Run File

NOTE: If you need to open a run file when another run is executing, launch another instance of Compass for Simple 
Western and disconnect the instrument by clicking Instrument and selecting Disconnect. Then open the run file. 

1.	 Select File in the main menu and click Open Run.

2.	 A list of the last 10 runs opened will display. Select one of these runs or click Browse to open the Runs folder and select 
a different file.

Opening Multiple Run Files

NOTE: If you need to open a run file when another run is executing, launch another instance of Compass for Simple 
Western and disconnect the instrument by clicking Instrument and selecting Disconnect. Then open the run file. 

1.	 To open the first run file, select File in the main menu and click Open Run.



154

Chapter 7: Size Assay Data Analysis  //  Opening Run Files

Compass for Simple Western User Guide

2.	 A list of the last 10 runs opened will display. Select one of these runs or click Browse to open the Runs folder and select 
a different file. When connected to an instrument, you can also select Instrument in the main menu and click Runs to 
select a different run file.

3.	 To open another run file, select File in the main menu and click Add Run.

4.	  A list of the last 10 runs opened will display. Select one of these runs or click Browse to open the Runs folder and 
select a different file. When a run is added, its data will append to the open run file, and will display as a second set of 
capillaries (Jess/Abby/Leo) in all screen panes. The second run file name will also appear in the Compass title bar: 

5.	 Repeat the last two steps to add additional runs.

NOTES: 
A Leo run cannot be added to a Jess/Abby run even if the channels match. 
 
When adding multiple data files for analysis, the assay type and detection channel (for example chemi, IR/NIR 
fluorescence, or IR/NIR fluorescence with Normalization) between the runs must be the same.  
 
When adding multiple RePlex data files, both probes must contain matching probe types and channels. For example, 
a chemiluminescence with Total Protein data file can’t be added to a chemiluminescence data file.
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How Run Data is Displayed in the Analysis Screen
Data in the run file is compartmentalized for easy review in one of six panes in the Analysis screen.

Experiment Pane: Assay and Capillary Information
The Experiment pane displays assay, cartridge (Leo only), and capillary information for each of the capillaries in the run. A 
view of the Experiment panes for some assay types are shown below. 

C H E M I L U M I N E S C E N C E 
I M M U N OA S S AY O N A B BY

R E P L E X A S S AY O N J E S S C H E M I L U M I N E S C E N C E I M M U N OA S S AY 
O N L E O

•	 To view all columns – Click the Experiment tab, then use the scroll bar or click Maximize in the upper right corner.

•	 To resize columns – Click the Experiment tab. Roll the mouse over a column border until the sizing arrow appears, then 
click and drag to resize.

•	 To select columns for display – Right-click in the Experiment pane, then select Columns... and select the columns to 
display. Options that appear will depend on the assay run. 
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Experiment pane column descriptions are as follows:

•	 Sample – Sample name. If sample names were entered in the assay template (Assay screen), those names will display 
here. Otherwise, Sample (default name) will display.

•	 Sample Attr – Sample attribute. If sample attributes were entered in the assay template (Assay screen), those names 
will display here.

NOTE: Data notification icons will display in the sample column if Compass for Simple Western detected a potential 
analysis issue or if data was manually modified by the user. For more information see “Run Data Notifications and 
Warnings” on page 189.

•	 Primary – Primary antibody name. If primary antibody names were entered in the assay template (Assay screen), those 
names will display here. Otherwise, Primary (default name) will display.

•	 Primary Attr – Primary antibody attribute. If primary antibody attributes were entered in the assay template (Assay 
screen), those names will display here.

•	 Primary 1 (RePlex Assays only) – Primary antibody name for Probe 1. If primary antibody names were entered in the 
assay template (Assay screen), those names will display here. Otherwise, Primary Probe 1 (default name) will display.

•	 Primary Attr 1 (RePlex Assays only) – Primary antibody attribute for Probe 1. If primary antibody attributes were 
entered in the assay template (Assay screen), those names will display here.

•	 Primary 2 (RePlex Assays only) – Primary antibody name for Probe 2. If primary antibody names were entered in the 
assay template (Assay screen), those names will display here. Otherwise, Primary Probe 2 (default name) will display.

•	 Primary Attr 2 (RePlex Assays only) – Primary antibody attribute for Probe 2. If primary antibody attributes were 
entered in the assay template (Assay screen), those names will display here.

•	 Secondary – Secondary antibody name. If secondary antibody names were entered in the assay template (Assay 
screen), those names will display here. Otherwise, Secondary (default name) will display.

•	 Secondary Attr – Secondary antibody attribute. If secondary antibody attributes were entered in the assay template 
(Assay screen), those names will display here.

•	 Secondary 1 (RePlex Assays only) – Secondary antibody name for Probe 1. If secondary antibody names were entered 
in the assay template (Assay screen), those names will display here.

•	 Secondary Attr 1 (RePlex Assays only) – Secondary antibody attribute for Probe 1. If secondary antibody attributes 
were entered in the assay template (Assay screen), those names will display here.

•	 Secondary 2 (RePlex Assays only) – Secondary antibody name for Probe 2. If secondary antibody names were entered 
in the assay template (Assay screen), those names will display here. 

•	 Secondary Attr 2 (RePlex Assays only) – Secondary antibody attribute for Probe 2. If secondary antibody attributes 
were entered in the assay template (Assay screen), those names will display here.
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NOTE: The Secondary column will not display for RePlex Assays with two immunoassays by default.

•	 Cartridge (Leo only) – Cartridge number.

•	 Cap – Capillary number.

NOTES:  
Selection of columns applies to Compass views only. These column selection changes are not reflected in exports 
and reports. 
 
Data notification icons will display in the sample column if Compass for Simple Western detected a potential 
analysis issue or data was manually modified by the user. For more information see “Run Data Notifications and 
Warnings” on page 189.

Graph Pane: Electropherogram Data
Click the Graph tab to view data for sample proteins or fluorescent standards. Data for samples is shown in the following 
example, and proteins are displayed as peaks:

More Graph view options will be described in more detail in “Graph Options: Customizing the Data Display” on page 259.
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Image Pane: Capillary Separation Image Data
Click the Image tab to view final images of sample proteins or fluorescent standards. Image data for samples is shown in 
the following example:

Click the blue Show All Images icon at the top right of the Image pane to display images for all exposures in the run for 
sample, raw (fluorescence only), and background (fluorescence only) images. Use the mouse to scroll down to view the 
images. 

You can also view all the sample images for the selected exposure time in one pane by clicking View in the main menu and 
selecting All. For runs with multiple detection channels, select the desired channels to display. The image data for multiple 
detection channels (NIR and IR) is shown in the following example:
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Lane Pane: Virtual Blot-Like Image Data

NOTE: Lane view is a digitally created image to aid with data visualization and is not quantitative.

Click the Lane tab to view data for sample proteins or fluorescent standards as bands in individual lanes. This virtual 
blot-like image is similar to traditional blot results. Data for samples in the lane view for an Immunoassay with Protein 
Normalization (for Jess only), and from an assay with Total Protein Normalization using RePlex are displayed as bands in 
the examples below. 

 

To view information for a band, roll the mouse over a band until the info box appears.
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NOTE: The reported molecular weight for sample proteins detected by an Immunoassay or a Total Protein Assay 
in Compass for Simple Western may vary from apparent molecular weights using other techniques and based on 
sample and assay conditions.1,2

Lane data displayed in the virtual blot is automatically aligned by Compass for Simple Western. To view raw, unaligned 
lane data and learn more about virtual blot viewing options, see “Changing the Virtual Blot View” on page 220.

Std Curve Pane: Standard Curve Fit Data
Click on the tab displaying the name of the standard curve sample and detection channel to view a linear, 4-parameter, 
or Log-Log curve fit of your standard curve proteins. Data for the samples in the standard curve view is shown in the 
following example for a standard curve performed on a Leo instrument where individual data points are displayed as dots.

Concentration of the sample proteins is automatically determined by Compass based on defined values of the standard 
curve. Refer to “Standard Curve Settings” on page 300 for more information.

Click on the Curve Options button to adjust the x-axis and y-axis scale. 

The Std Curve pane displays the equation and parameters used for the standard curve. 

1 Electrophoresis. 2021 Aug;42(14-15):1521-1531. doi: 10.1002/elps.202100068. 
2Electrophoresis. 2021 Feb;42(3):206-218. doi: 10.1002/elps.202000199. 
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Peaks Pane: Calculated Results
Click the Peaks tab to view tabulated results for sample proteins, normalized sample proteins shown as Corr. Area (when 
Normalization, Loading Control, or Cartridge Correction is enabled), or fluorescent standards. Each row in the table shows 
the individual results for each peak detected in each capillary. Some examples of data for samples in the Peaks table are 
shown below:

I M M U N OA S S AY

TOTA L P R OT E I N U S I N G R E P L E X: P R O B E 1 ,  C H E M I L U M I N E S C E N C E , P R O B E 2 , TOTA L P R OT E I N N O R M A L I Z AT I O N

P R OT E I N N O R M A L I Z AT I O N (J E S S O N LY )

R E P L E X A S S AY
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NOTES:  
Peaks named automatically by Compass for Simple Western using the user-defined peak name analysis parameters 
are color-coded. 
 
The reported molecular weight for sample proteins detected using an Immunoassay or a Total Protein Assay in 
Compass for Simple Western may vary from apparent molecular weights using other techniques and based on 
sample and assay conditions.1,2

•	 To view all rows – Click the Peaks tab, then use the scroll bar or click Maximize in the upper right corner.

•	 To resize columns – Click the Peaks tab. Roll the mouse over a column border until the sizing arrow appears, then click 
and drag to resize.

•	 To select columns for display – Right-click in the Peaks pane, then select Columns... and select the Peak table 
columns to display.

NOTE: Selection of columns applies to Compass views only. These column selection changes are not reflected in 
exports and reports.

1 Electrophoresis. 2021 Aug;42(14-15):1521-1531. doi: 10.1002/elps.202100068. 
2Electrophoresis. 2021 Feb;42(3):206-218. doi: 10.1002/elps.202000199. 
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Peak table column descriptions are as follows:

•	 Sample - Sample name. If sample names were entered in the assay template (Assay screen), those names will display 
here. Otherwise, ‘Sample’ (default name) will display.

•	 Sample Attr - Sample attribute. If sample attributes were entered in the assay template (Assay screen), those names 
will display here.

•	 Primary - Primary antibody name. If primary antibody names were entered in the assay template (Assay screen), those 
names will display here. Otherwise, Primary (default name) will display. 

•	 Primary Attr - Primary antibody attribute. If primary antibody attributes were entered in the assay template (Assay 
screen), those names will display here.

•	 Secondary - Secondary antibody name. If secondary antibody names were entered in the assay template (Assay 
screen) or Analysis Options pane, those names will display here. Otherwise, Secondary (default name) will display.

•	 Secondary Attr - Secondary antibody attribute. If secondary antibody attributes were entered in the assay template 
(Assay screen), those names will display here.

•	 Cap

•	 Jess/Abby Immunoassays (non-RePlex): Capillary number.

•	 Jess/Abby RePlex Assays: Probe and capillary number. For example, P1:4 indicates Probe 1, capillary 4.

•	 Leo Immunoassays (non-RePlex): Cartridge and capillary number. For example, C1:4 indicates cartridge 1, 
capillary 4

•	 Leo RePlex Assays: Cartridge, Probe, and capillary number. For example, C1P1:4 indicates cartridge 1, Probe 1, 
capillary 4. 

•	 Peak - Peak number. Peaks are numbered in order of detection.

•	 Name - Peak name. Displays peaks that Compass for Simple Western named automatically using the user-defined peak 
name analysis parameters. Cells will be blank if Compass was not able to name the peak or if naming parameters were 
not entered.

•	 Position - Displays the pixel position of a peak in the image.

•	 MW (kDa) - Displays the calculated molecular weight in kDa for the peak (shown for sample data only).

•	 Height - Displays the calculated peak height.

•	 Area - Displays the calculated peak area (shown for sample data only).

•	 % Area - Displays the calculated percent area for the named peak compared to all named peaks within the same Peak 
Names Analysis Group. This value results from dividing the individual peak area by the sum of all named peak areas for 
the capillary and multiplying by 100 (shown for named peak sample data only).

•	 % Total - Reported when area is calculated using the Dropped Lines methods (“Peak Find Settings” on page 317 for 
more information). Displays the calculated percent area for the peak compared to the total peak area measured in the 
capillary. This value results from dividing the individual peak area by the entire area under the curve for the capillary 
and multiplying by 100.
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•	 Conc (Concentration) - Displays the calculated concentration of protein for the named peak. This column will not 
appear unless a standard curve is defined.

•	 Known Conc (Concentration) – Displays the known concentration of a protein for the named peak used to generate the 
standard curve. This column will not appear unless a standard curve is defined. 

•	 Corr. Area - Displays the corrected area for the peak. This column will not appear unless a Loading Control is defined, 
Cartridge Corrections is enabled, or Normalization is enabled in Analysis Preferences.

•	 For PN channel - A linear correction calculation is applied to peak area to represent amount of protein. The linear 
calculation correction factor is Corr. Area = Area + (1e-5 * Area2).

•	 For Chemi, NIR, and IR channel peaks - Corrected area is determined by first calculating the Capillary 
Normalization factor for each capillary and then correcting the peak area as follows:

Capillary Normalization Factor = Normalization area for chosen capillary/Normalization area for reference capillary 
in Analysis settings

Then, 

Corr. Area = Peak area/Capillary Normalization factor.

•	 For Cartridge Corrections - Corrected Area of the selected Peak is based on the Correction Factor per cartridge where 
Corr. Area = Peak Area * Corr. Factor. Refer to “Cartridge Corrections (Leo only)” on page 311 for more information.

•	 Width - Displays the calculated peak width, in pixels at half height (shown for sample data only).

•	 S/N - Displays the calculated signal to noise ratio for the peak (shown for sample data only). Please note this calculation 
is either based on a peak finding algorithm to provide a relative ratio comparing all peaks within the electropherogram 
or a signal to noise ratio that follows USP/NF regulations. These settings are selected in Advanced Analysis settings. 
For more information see “Signal to Noise Settings” on page 326.

•	 Baseline - Displays the raw baseline signal of each peak

•	 Channel - Detection channel (Chemi, NIR, IR, PN)
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Capillaries Pane: User-Specified Peak Names
Click the Capillaries tab to view tabulated results for sample proteins associated with specific primary antibodies, 
Protein Normalization area, or Total Protein area in the run data. Compass for Simple Western labels these sample peaks 
automatically using user-defined peak name settings. Each row in the table shows the individual results for the named 
peaks detected in each capillary. Examples of data for samples in the Capillaries table are shown.

C H E M I L U M I N E S C E N C E I M M U N OA S S AY

C H E M I L U M I N E S C E N C E I M M U N OA S S AY + C H E M I L U M I N E S C E N C E I M M U N OA S S AY U S I N G R E P L E X

Each row in the table shows the individual results for the named peaks detected in each capillary.

Viewing the Capillaries Pane

•	 To view all rows - Click the Capillaries tab, then use the scroll bar or click Maximize in the upper right corner.

•	 To resize columns - Click the Capillaries tab. Roll the mouse over a column border until the sizing arrow appears, then 
click and drag to resize. 

•	 To select columns for display - Right-click in the Capillaries pane, then select Columns... and select the Capillaries 
table columns to display.

NOTE: Selection of columns applies to Compass views only. These column selection changes are not reflected in 
exports and reports.
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Capillaries table column descriptions are as follows:

•	 Sample - Sample name. If sample names were entered in the assay template (Assay screen), those names will display 
here. Otherwise, Sample (default name) will display.

•	 Sample Attr - Sample attribute. If sample attributes were entered in the assay template (Assay screen), those names 
will display here. 

•	 Primary - Primary antibody name. If primary antibody names were entered in the assay template (Assay screen), those 
names will display here. Otherwise, Primary (default name) will display.

•	 Primary Attr - Primary antibody attribute. If primary antibody attributes were entered in the assay template (Assay 
screen), those names will display here.

•	 Secondary - Secondary antibody name. If secondary antibody names were entered in the assay template (Assay 
screen), those names will display here. Otherwise, Secondary (default name) will display.

•	 Secondary Attr - Secondary antibody attribute. If secondary antibody attributes were entered in the assay template 
(Assay screen), those names will display here.

•	 Capillary

•	 Jess/Abby Immunoassays (non-RePlex): Capillary number.

•	 Jess/Abby RePlex Assays: Probe and capillary number. For example, P1:4 indicates Probe 1, capillary 4.

•	 Leo Immunoassays (non-RePlex): Cartridge and capillary number. For example, C1:4 indicates cartridge 1, 
capillary 4

•	 Leo RePlex Assays: Cartridge, Probe, and capillary number. For example, C1P1:4 indicates cartridge 1, Probe 1, 
capillary 4. 

•	 Peak Name Columns - An individual column per peak name will display for every peak identified by name in the run 
data. Cells for capillaries in these columns will be blank if Compass for Simple Western did not find peaks automatically 
using the user-defined peak name analysis parameters (or none were entered).

•	 To view peak area in the peak name columns (default) - Select Area in the upper right corner of the pane. This 
displays calculated peak area for the individual peak only.
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•	 Viewing % area in the peak name columns - Select % Area in the upper right corner of the pane. This displays 
the calculated percent area for the named peak compared to all named peaks. This value results from dividing the 
individual peak area by the sum of all named peaks within the same Peak Names Analysis Group for the capillary 
and multiplying by 100.

•	 To view corrected peak area in the peak name columns - Select Corr. Area in the upper right corner of the pane. 
This displays the corrected peak area for the named peak compared with the loading control peak when a Loading 
Control is defined in the Analysis settings, or correction capillary and cartridge when Cartridge Corrections is 
enabled in the Analysis settings, or the reference capillary when Normalization is enabled in the Analysis settings.

•	 To view concentration in the peak name columns - Select Conc. in the upper right corner of the pane. This 
displays the calculated concentration for the named peak compared with the standard curve when a Standard 
Curve is defined in the Analysis settings.

•	 To view % total in the peak name columns - The Dropped Lines or Dropped Lines (manual) area calculation setting 
must first be selected. To do this, select Analysis from the Edit menu, then select Peak Fit. In the Peak Find box, 
select Dropped Lines or Dropped Lines (manual) for the Area Calculation setting. Next, select % Total in the upper 
right corner of the Capillaries pane. This displays the calculated percent total for the named peak compared to 
the total area measured in the capillary. This value results from dividing the individual peak area by the entire area 
under the curve for the capillary and multiplying by 100.

RePlex and Stellar Assays with Total Protein

For RePlex and Stellar Assays with Total Protein enabled, each row in the table shows the individual results for the total 
protein and named peaks detected in each capillary, as shown below.

•	 TP Area - Total area measured in the capillary for the Total Protein signal.
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TPN (%) is calculated as follows: 

Capillary Normalization Factor = Total Protein signal for chosen capillary/Total Protein signal for reference capillary in 
Analysis settings

Then,

TPN (%) = Capillary Normalization Factor x 100, as percentage

Peak Normalization Jess

When using the Protein Normalization Module on Jess, where the PN Corr.Area column accounts for the Protein 
Normalization signal automatically, the Capillaries pane is shown below.

PN Corr.Area is calculated as follows:

PN Corr.Area = PN Area + (1e-5 * PN Area2)

PN (%) is calculated as follows: 

Capillary Normalization Factor = Protein Normalization signal for chosen capillary/Protein Normalization signal for 
reference capillary in Analysis settings.

Then,

PN (%) = Capillary Normalization Factor x 100, as percentage

Cartridge Corrections (Leo only)

To view the Corr.Area in the Capillaries pane when Cartridge Corrections is enabled, click the Corr.Area button at the 
upper, right corner of the Capillaries pane. Cartridge Corrections is only applied to the named peak chosen under Peak in 
Cartridge Corrections analysis settings.

Cartridge Correction Corr.Area is determined by first calculating the cartridge correction factor for each cartridge using 
the correction capillaries and either a single correction cartridge or the cartridge average, and then correcting peak area 
for each signal as follows: 
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•	 Using a single correction cartridge: Correction Factor for a cartridge = Average peak area of the named peak for 
the chosen Correction Capillaries on a cartridge/Average peak area of the named peak for the chosen Correction 
Capillaries on the Correction Cartridge 

•	 Using the cartridge average: Correction Factor for a cartridge = Average peak area of the named peak for the chosen 
Correction Capillaries on a cartridge/Average peak area of the named peak for the chosen Correction Capillaries on all 
cartridges 

Then, 

Corr.Area = Peak Area * Correction Factor

NOTE: Peaks that Compass for Simple Western names automatically with user-defined peak name settings are 
color-coded. Information displayed for fluorescent standards data will be for identified standards.

Viewing Run Data
Each run file contains the following data for up to 25 capillaries for Jess and Abby and up to 100 capillaries for Leo:

•	 Sample data - For the proteins in the sample. 

•	 Standards data - For the fluorescent standards run with each sample. 

Data can be viewed for one, all, or individually selected capillaries.

Switching Between Sample and Standards Data Views
You can switch between viewing sample and standards data in a run file using the View bar or View menu:
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Data buttons in the View bar:

Show Standards

Show Samples

•	 To view sample data - Click Show Samples in the View bar, or select View in the main menu and click Samples:

•	 Data in this view is for sample proteins only.

•	 Graph view data displays electropherograms in chemiluminescence, NIR or IR units (y-axis) and molecular weight in 
kDa (x-axis). If Protein Normalization was performed in the same immunoassay run, the overlay is also displayed in 
the Graph view.

•	 Lane view data displays sample proteins only.

•	 Image view data displays sample proteins only.

•	 Results for each protein are shown in the Peaks and Capillaries tables.

NOTE: The reported molecular weight for sample proteins detected by an Immunoassay or a Total Protein Assay 
in Compass for Simple Western may vary from apparent molecular weights using other techniques and based on 
sample and assay conditions.1,2

1 Electrophoresis. 2021 Aug;42(14-15):1521-1531. doi: 10.1002/elps.202100068. 
2Electrophoresis. 2021 Feb;42(3):206-218. doi: 10.1002/elps.202000199. 
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For information on checking and identifying sample peaks, see “Step 3 – Checking the Ladder” on page 195 or 
“Step 4 – Checking Samples” on page 197.

•	 To view standards data - Click Show Standards in the View bar, or select View in the main menu and click Standards:

NOTE: For RePlex Assays standards data will be displayed regardless of what channel (Probe 1 or Probe 2) is 
selected.

•	 Data in this view is for the fluorescent standards only. These standards are premixed with each sample prior to 
analysis.

•	 Graph view data displays electropherograms in fluorescence (y-axis) and position (x-axis).

•	 Lane view data displays fluorescent standards only.

•	 Image view data displays fluorescent standards only.

•	 Standards are highlighted in the Peaks tables and marked with an S.

For information on checking and identifying standards peaks, see “Step 2 – Checking Fluorescent Sizing Standards” 
on page 193.

Selecting and Displaying Capillary Data
You can choose to view data from one, multiple, or all capillaries at once.

1.	 Select View in the main menu and click View Selected. 
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•	 To look at data for one capillary - Click a row in the Experiment pane. Data for just the row selected will display in 
all data views and tables. The following example shows sample data displayed in the Lane and Peaks panes when 
one sample is selected:

•	 To look at data for multiple non-sequential capillaries - Hold the Ctrl key and select the rows you want to view in 
the Experiment pane. Data for only the rows selected will display in all data views and results tables. The following 
example shows sample data displayed in the Graph (in Overlay the Plots view) and Peaks panes when multiple rows 
are selected:
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•	 To look at data for multiple sequential capillaries - Hold the Shift key and select the first and last rows you want 
to view in the Experiment pane. Data for only the selected rows will display in all data views and results tables. The 
following example shows standards data displayed in the Image and Peaks panes when multiple sequential rows are 
selected:

•	 To look at data for all capillaries - Hold the Shift key and select the first and last rows in the Experiment pane. Data 
for all rows will display in all data views and results tables. You can also select All in the View menu. The following 
example shows standards data displayed in the Lane and Peaks panes when all rows are selected.
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Switching Between Fluorescence Channel Views (Jess Only)
You can switch between displaying run data in the Graph, Image, and Lane panes for samples run using HRP-tagged or 
fluorophore dye-containing secondaries in the View bar. Protein normalization overlay data can also be selected here. 

Detection channels in the View bar:

Detection channels in the View bar:

Overlay chemiluminescent channel (gray)

Overlay near infrared channel (red)

Overlay infrared channel (green)

Overlay protein normalization channel (blue)

Unused channel (no color)

Color is available but not selected

Switching Between Single and Multiple Views of the Capillaries
You can switch between displaying run data in the Graph, Image, and Lane panes in a per capillary (single) format or a 
multiple capillary format. This view is selected in the View bar or the View menu.

Capillary view buttons in the View bar:

View Selected

View All
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•	 To view data in a per capillary format - Click View Selected in the View bar or select View in the main menu and click 
Selected:

Data for the row(s) selected in the Experiment pane will display as follows:

•	 Electropherograms in the Graph pane display overlaid or stacked (depending on the graph option chosen).

•	 Results for only the selected row(s) will display in the Peaks and Capillaries tables.

•	 The selected row(s) are highlighted in the Image pane:

:
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•	 Lanes for only the selected row(s) are displayed in the Lane pane:

•	 To view data in a multiple capillary format - Click View All in the View bar, or select View in the main menu and click 
All:

Data for the row(s) selected in the Experiment pane will display as follows:

•	 Electropherograms corresponding to the selected row(s) are highlighted in the Graph pane.

•	 Results for selected capillaries are highlighted in the Peaks and Capillaries tables.
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•	 The selected row(s) are highlighted in the Image pane:

•	 All selected lanes display in the Lane pane, and lanes corresponding to the selected row(s) are highlighted.
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Viewing RePlex Channel Views 
Probe 1 data displays by default when you open a RePlex run file. To display a second Probe 1 or Probe 2 channel data, 
click the channel icon in the View bar.

C H A N N E L D E S I G N AT I O N S F O R J E S S A N D L E O:

Probe 1 Channels

Probe 2 Channels

NOTE: NIR, IR, and Protein Normalization Channels are inactive (gray) when viewing a Leo RePlex run. 

Detection channels in the View bar:

Overlay chemiluminescent channel (gray)

Overlay near infrared channel (red)

Overlay infrared channel (green)

Unused channel (no color)

Channel data is displayed

Channel data is available but not selected

C H A N N E L D E S I G N AT I O N S F O R A B BY:

Probe 1 Channel

Probe 2 Channel
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Detection channels in the View bar:

Overlay probe 1 channel

Overlay probe 2 channel

Channel data is available but not selected

The initial view displays Probe 1 data only. In this example showing Jess RePlex Assay data, the Probe 1 channel is 
chemiluminescence.

Probe 1 data is labeled in all data views as P1 or Probe 1:

•	 Graph view:
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•	 Image view:

J E S S/A B BY

L E O
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•	 Lane view  
Jess and Abby: Sample lanes are labeled probe number:capillary number

Leo: Sample lanes are labeled probe number:capillary number with the cartridge number below. 
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•	 Peaks and Capillaries table:  
Jess and Abby: Rows are labeled probe number: capillary number

Leo: Rows are labeled cartridge number: probe number: capillary number

Viewing Data for Probe 2

To view chemiluminescent or NIR data (Jess only) for Probe 2, select its channel in the view bar. 

J E S S

Probe 2 Channel

L E O

Probe 2 Channel

A B BY

Probe 2 Channel
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In this example, showing Jess RePlex Assay data, Probe 2 is labeled P2 or Probe 2: 

•	 Graph view will display data stacked or overlaid depending on the option chosen:
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•	 Image view will display separate images for each probe:

•	 Lane view will display P1 and P2 lanes side by side:

Jess and Abby: Sample lanes are labeled probe number: capillary number
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Leo: Sample lanes are labeled probe number:capillary number with the cartridge number below

•	 Peaks and Capillaries tables will display all row data for P1 first, then P2:

Jess and Abby: Rows are labeled probe number : capillary number

 

Leo: Rows are labeled cartridge number : probe number : capillary number
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Viewing Data for a Second Channel in Probe 1 (Jess only)

To view the second channel data for Probe 1, for example in a Chemiluminescence and Fluorescence NIR Immunoassay + 
Total Protein Normalization using RePlex and Chemiluminescence Detection assay, select its channel in the view bar:

Probe 1 Channel 1

Probe 1 Channel 2

•	 Graph view will display data stacked or overlaid channel data depending on the option chosen:



187

Chapter 7: Size Assay Data Analysis  //  Viewing Run Data

Compass for Simple Western User Guide

•	 Image view will display individual images for each channel:

•	 Lane view will display lanes for each channel overlaid:

•	 Peaks and Capillaries tables will list data for both channels:
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Hiding Capillary Data
Capillary data can be hidden from view if needed. Hidden caps will not appear in the graph or lane view, will not appear in 
the Peaks and Capillary tables, and will be excluded from statistical analysis with group data and the exported table files. 

To hide capillaries:

1.	 Click the Experiment tab.

2.	 Select the rows you want to hide, then right-click on one of the selected rows and click Hide:

Data for selected rows will be hidden in all data views and results tables (except for the Image pane).

•	 To view hidden rows - Select View in the main menu and click Show Hidden. Hidden rows will become visible again in 
all panes, and hidden rows will be marked with an X in the Experiment pane:

•	 To unhide rows - Select the hidden row(s). Right-click on one of the selected rows and click Unhide.

Setting Run Data Display Filters
The filter lets you auto-hide specific capillaries in the run file data, or only show data for peaks that Compass for Simple 
Western identified automatically using the user-defined peak name analysis parameters.

NOTE: When more than one run file is open, filter settings will be applied to all files.
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•	 To filter data to show specific capillaries only - Select View in the main menu and click Filter. Uncheck the boxes for 
the capillaries you do not want shown, then click OK.

Only data for the checked capillaries will display in data views and results tables, unchecked capillaries will be hidden.

•	 To filter data to show named peaks only - Select View in the main menu and click Filter. Select Show named peaks 
only then click OK. Only data for peaks that Compass for Simple Western identified automatically using the user-
defined peak name analysis parameters will display in data views and results tables, all other peak data will be hidden.

Run Data Notifications and Warnings
If Compass for Simple Western detects a potential data issue, a notification or warning will display next to the row in the 
Experiment pane. A list of warnings, notifications and corrective actions are as follows:

Manual correction of sample data notification - Indicates the user modified sample data manually, such as 
adding or removing a sample peak. Rolling the mouse over the icon displays the type of data modification made.

Standards warning - Indicates that one of the standards may not be identified properly. This can be resolved 
by manually identifying the standards. Please refer to “Step 2 – Checking Fluorescent Sizing Standards” on 
page 193 for details. Rolling the mouse over the icon displays warning details.

Manual correction of standards data notification - Indicates the user modified the standards data manually. 
Rolling the mouse over the icon displays the type of data modification made.
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Peak fit warning - Indicates that a peak cannot be fit properly. This is typically caused either by a very small 
peak in the electropherogram or a peak that is very close to the end of the molecular weight range. This can 
be resolved by removing the peak. Please refer to “Step 3 – Checking the Ladder” on page 195 or “Step 4 – 
Checking Samples” on page 197 for details. Rolling the mouse over the icon displays warning details.

Peak warning: saturated signals - Saturation warnings in the Experiment pane indicate there are one or more 
saturated pixels in the current capillary at the selected exposure setting. If there is a saturation warning when 
HDR is the selected exposure, it means that a pixel within the capillary was saturated at the shortest exposure 
time in the image series. Pixels in a peak are considered saturated when they can no longer quantify the data 
reliably for analysis (i.e., the pixels have hit the threshold value of the amount of light they can absorb). These 
warnings are displayed for Chemi, NIR, IR, and PN channels and take precedence over all other warnings that 
are shown for capillaries in the Experiment pane.

When accurate quantitation is needed for samples displaying this warning, we recommend re-running the 
samples at a higher dilution factor. Rolling the mouse over the icon displays warning details.

Undo/Redo
Specific actions in Compass for Simple Western can be undone or redone by pressing Ctrl+Z and Ctrl+Y, or selecting 
Undo or Redo from the Edit menu. These actions include:

Assay Changes
•	 Assay Template

•	 Assay Protocol

•	 Assay Layout

•	 Assay Default Analysis Settings

Run File Changes
•	 All Analysis Settings

•	 All Analysis Options

•	 Graph - Add/Remove Peaks
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•	 Graph - Add/Remove Baselines

•	 Graph - Peak Start End

•	 Graph - Peak Names

•	 Graph - Force Standard

•	 Graph - Not a Standard

•	 Peaks Table - Hide/Unhide

•	 Peaks Table - Remove Peaks

•	 Peaks Table - Peak Names

•	 Lane - Contrast Adjustment

•	 Lane - Name Peak

•	 Lane - Samples, Overlay Standards: Not a Standard

•	 Lane - Samples, Overlay Standards: Force Standard

•	 Lane - Standards: Not a Standard

•	 Lane - Standards: Force Standard

•	 Experiment - Sample Clear Manual settings

•	 Experiment - Hide/Unhide caps

•	 Experiment - Standards Clear Manual settings

•	 Run file - Assay template changes

•	 Import Analysis Settings

•	 Import Template

•	 Template changes

Checking Your Results

NOTE: Visit the Bio-Techne Academy for more information about Simple Western size assay data analysis. 

Compass for Simple Western detects proteins and fluorescent standards and reports results automatically with no user-
interaction. However, we recommend you review the data as outlined in this section as good general practice to ensure 
accurate results. If a data warning is presented in the Experiment pane, the following steps will also help you identify and 
correct any issues.

https://academy.bio-techne.com/learn
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Step 1 – Review the Fluorescent Sizing Standards Movie
All capillaries should have three fluorescent sizing standards for 12-230 kDa size assays or two fluorescent standards for 
66-440 kDa and 2-40 kDa size assays. To verify the standards separated in the capillary correctly:

1.	 When the run has completed, click the Run Summary screen tab.

2.	 Click the Separation tab and play the movie (this will be the fluorescent standards separation).

2-40 k D a FLU O R ES C E NT STA N DA R DS O N J ES S 

1 2 –23 0 k D a FLU O R ES C E NT STA N DA R DS O N LEO

6 6 – 4 40 k D a FLU O R ES C E NT STA N DA R DS O N A B BY
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3.	 For each capillary, verify that the standards visibly separated. Each fluorescent point in the capillary represents one of 
the sizing standards.

Step 2 – Checking Fluorescent Sizing Standards
To verify the standards are identified correctly:

1.	 Click the Analysis screen tab.

2.	 Click Show Standards in the View bar. Verification that the standards have been correctly identified can be done in 
either the Graph or Lane panes.

Graph Pane:

a.	 Click View Selected in the View bar.

b.	 Click on the first row in the Experiment pane, then click the Graph tab. Check that the electropherogram has 
standard peaks labeled Std 1, Std 29 and Std 230 (for 12-230 kDa size assays), Std 57 and Std 280 (for 66-440 kDa 
size assays) or Std 1 and Std 26 (for 2-40 kDa size assay). They will also be identified with a green S in the Peaks 
table.

If standards are not identified correctly, they can be manually corrected as follows:

•	 If an incorrect peak is identified as a standard - Right-click the peak in the electropherogram or Peaks table and 
select Not a Standard. Compass for Simple Western should correctly reassign the remaining peaks as standards, 
and update the Peaks table.

•	 To set an unidentified peak as a standard - Right-click the peak in the electropherogram or Peaks table and 
select Force Standard. Compass for Simple Western will assign the peak as a standard, and correctly reassign the 
remaining standard peaks. A lock icon indicating the standard was set manually will display next to the peak in the 
Peaks table.
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NOTE: To remove standards peak assignments that were made manually, right-click on the peak in the 
electropherogram or Peaks table and click Clear.

c.	 Repeat the previous steps for the remaining rows in the Experiment pane to make sure all standards are identified 
correctly.

Lane Pane:

NOTE: We recommend checking Fluorescent Sizing Standards using the Graph pane. 

a.	 Click View All in the View bar.

b.	 Click on the first row in the Experiment pane, then click the Lane tab. Standards will be bands and identified with a 
green outline. Check that all standard bands are labeled by rolling the cursor over the individual bands: Std 1, Std 
29 and Std 230 (for 12-230 kDa size assays) or Std 57 and Std 280 (for 66-440 kDa size assays) or Std 1 and Std 26 
(for 2-40 kDa size assays). They will also be identified with a green S in the Peaks table. To view band labels, roll the 
mouse over the individual bands.

If standards are not identified correctly, they can be manually corrected as follows:

•	 If an incorrect band is identified as a standard - Right-click the band in the Lane or Peaks table and select Not a 
Standard. Compass for Simple Western should correctly reassign the remaining bands as standards.

•	 To set an unidentified band as a standard - Right-click the band in the Lane or Peaks table and select Force 
Standard. Compass for Simple Western will assign the band as a standard, and correctly reassign the remaining 
standard bands.
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NOTE: To remove standards peak assignments that were made manually, right-click on the peak in the 
electropherogram or Peaks table and click Clear.

c.	 Repeat the previous steps for the remaining rows in the Experiment pane to make sure all standards are identified 
correctly.

Step 3 – Checking the Ladder
Depending on the size assay you are running, the biotinylated ladder should have the following sizing standards: 12, 40, 
66, 116, 180 and 230 kDa (for 12-230 kDa size assays), 66, 116, 200, 280 and 440 kDa (for 66-440 kDa assays) or 2, 5, 12, 
26, and 40 kDa (for 2-40 kDa assays). To verify the ladder standards are identified correctly:

1.	 Click the Analysis screen tab.

2.	 Click Show Samples in the View bar. Verification that the ladder standards have been correctly identified can be done 
in either the Graph or Lane panes, but manual corrections must be done in the Graph pane.

Graph Pane:

a.	 Click View Selected in the View bar.

b.	 Click on the row in the Experiment pane that contains the ladder (typically row 1), then click the Graph tab. Check 
that the electropherogram has either six ladder peaks (for 12-230 kDa size assays) or five ladder peaks (for 66-440 
and 2-40 kDa size assays). In the example below, the electropherogram has six peaks labeled Ldr 12, Ldr 40, Ldr 66, 
Ldr 116, Ldr 180 and Ldr 230.
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If ladder peaks are not identified correctly, they can be manually corrected as follows:

•	 If an incorrect peak is identified as a ladder peak - Right-click the peak in the electropherogram or Peaks table 
and select Remove peak. Compass for Simple Western should correctly reassign the remaining peaks as ladder 
standards.

•	 To set an unidentified peak as a ladder peak - Right-click the peak in the electropherogram or Peaks table and 
select Add Peak. Compass for Simple Western will assign the peak as a ladder standard, and correctly reassign the 
remaining ladder standards peaks.

NOTE: To remove ladder peak assignments that were made manually and go back to the original view of the 
data, right-click in the electropherogram, and click Clear.

Lane Pane:

a.	 Click either View Selected or View All in the View bar.

b.	 Click on the row in the Experiment pane that contains the ladder (typically row 1), then click the Lane tab. Check that 
the lane has either six ladder bands (for 12-230 kDa size assays) or five ladder bands (for 66-440 kDa and 2-40 kDa 
size assays). In the example below, the lane has six peaks labeled Ldr 12, Ldr 40, Ldr 66, Ldr 116, Ldr 180 and Ldr 
230. To view band labels, roll the cursor over the individual bands. If ladder bands are not identified correctly, they 
must be corrected in the Graph pane as described in the previous section.
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Step 4 – Checking Samples
All sample proteins in the Graph and Lane panes will be labeled automatically with the calculated protein size.

NOTE: The reported molecular weight for sample proteins detected by an Immunoassay or a Total Protein Assay 
in Compass for Simple Western may vary from apparent molecular weights using other techniques and based on 
sample and assay conditions.1,2

To verify that sample proteins are identified correctly:

1.	 Click the Analysis screen tab.

2.	 Click Show Samples in the View bar. Verification that sample proteins have been correctly identified can be done in 
either the Graph or Lane panes, but manual corrections must be done in the Graph pane.

Graph Pane:

a.	 Click View Selected in the View bar.

b.	 Click on the row in the Experiment pane that contains the sample you wish to check, then click the Graph tab.

If sample peaks are not identified correctly, they can be manually corrected as follows:

•	 If an incorrect peak is identified as a sample peak - Right-click the peak in the electropherogram or Peaks 
table and select Remove peak. Compass for Simple Western will no longer identify it as a sample peak in the 
electropherogram and the peak data will be removed in the results tables.

1 Electrophoresis. 2021 Aug;42(14-15):1521-1531. doi: 10.1002/elps.202100068. 
2Electrophoresis. 2021 Feb;42(3):206-218. doi: 10.1002/elps.202000199. 
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•	 To set an unidentified peak as a sample peak - Right-click the peak in the electropherogram or Peaks table and 
select Add Peak. Compass for Simple Western will calculate and display the results for the peak in the results tables 
and identify the peak in the electropherogram.

NOTE: To remove sample peak assignments that were made manually and go back to the original view of the 
data, right-click in the electropherogram, and click Clear.

c.	 Repeat the previous steps for the remaining sample rows in the Experiment pane to make sure all sample proteins 
are identified correctly.

Lane Pane:

a.	 Click either View Selected or View All in the View bar.

b.	 Click on the row in the Experiment pane that contains the sample you wish to check, then click the Lane tab. To view 
sample protein band labels, roll the cursor over the individual bands. If sample bands are not identified correctly, 
they must be corrected in the Graph pane as described in the previous section.

Step 5 – Assigning Peak Names (Optional)
Compass for Simple Western can identify and automatically name sample proteins associated with specific primary 
antibodies in the run data using user-specified peak name settings. For more information on how to do this see “Peak 
Names Settings” on page 293.
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Group Statistics
The Grouping View is used to analyze replicates by calculating the mean, standard deviation, coefficient of variation 
(%CV), and standard error of the mean of named proteins (see “Peak Names Settings” on page 293 for detailed 
information on entering named proteins). Statistics for each protein are also plotted for easy comparison between 
samples, antibodies, and proteins.

Using Groups

The default group settings groups capillaries with the same sample and primary antibody name. Groups can be adjusted to 
include parameters like secondary antibodies, attributes, probes, channels (Jess only), and cartridges (Leo only). 

1.	 To use the grouping feature, you will need to annotate the plate in the Assay template. To do this:

a.	 Click the Assay tab and go to the Template (Jess/Abby) or Sample Template (Leo) pane.

b.	 Annotate the parameters used to group (i.e. sample names, primary antibody names, attributes) as described in 
“Step 5 - Add Assay Plate Annotations (Optional)” on page 52. Be sure to enter the same sample and/or antibody 
names for the groups of samples you want to calculate statistics for.

In this example there are two sample types, Sample A and Sample B, which were run with two different antibodies, 
Primary 1 and Primary 2.

Each of the two samples were run with each of the two antibodies. This creates four groups for the combination of two 
samples and two antibodies.

2.	 To set a grouping option

a.	 Go to Edit > Analysis and select Groups. 
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b.	 Check the boxes next to the parameters you want to use. 

For a RePlex assay:

c.	 Click Apply and then select OK. 

3.	 Group your results and view the associated statistics by selecting View and clicking on Grouping.
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Grouping Across Runs
Groups will be applied to capillaries within a run by default. Groups can be applied across runs with matching detection 
channels and when analysis settings are the same. 

To group across runs:

1.	 Open multiple runs in Compass for Simple Western. See “Opening Multiple Run Files” on page 153. 

2.	 Group your results based on the instructions in “Using Groups” on page 199. 

3.	 Click on the Group Across Runs icon in the Cap Groups pane. 

Viewing Statistics

Peak and Capillary Groups

The Peak Groups pane reports statistics for each named protein in every group. Each group shows the statistics for named 
proteins which includes peak area average, standard deviation (Std.Dev.), coefficient of variation (%CV), and standard 
error of the mean (SEM). The number in parenthesis after the sample name indicates the number of capillaries in the 
group. 

Clicking the arrow next to a group lists the individual capillaries in the group and reported data for each capillary:
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The Capillary Groups pane pivots the Peak Groups results to show statistics for named protein peaks in individual 
columns.

Group Plots

NOTE: Group Plots are not available for runs performed on Leo systems. 

The mean peak area values for named peaks in each group are plotted in bar graphs with error bars showing the standard 
deviation. The plots compare different antibodies for the same sample and different samples for the same antibody to 
allow a choice of presentation. The y-axis on the plot will be concentration if a standard curve is defined.

Hiding or Removing Capillaries in Group Analysis
Hidden capillaries are not included in groups. Hiding capillaries provides an easy way to reject individual capillaries from 
the statistical analysis. See “Hiding Capillary Data” on page 188 for details on how to do this. 
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Larger groups of capillaries can also be excluded from analysis. To do this, select View and click Filter.

J E S S/A B BY L E O

Uncheck the box next to the capillaries or cartridges you wish to remove and click OK. This data will now be removed from 
the grouped view statistics.

Copying Data Views and Results Tables
You can copy and paste data and results tables into other documents or save a data view as a graphic file.

Copying Data Views
1.	 Click the Graph or Lane tab, or on an image in the Image pane. In the Image pane, make sure to select the entire image 

by clicking the top or bottom edge of the image. This adds a yellow border around the image to indicate it’s selected.

2.	 Select Edit in the main menu and click Copy, or right-click and select Copy.

3.	 If you selected copy from the Graph or Lane pane, one of the following windows will display, then click Copy. If you 
selected copy from the Image pane skip to the next step.

4.	 Open a document (Microsoft® Word®, Excel®, PowerPoint®, etc.). Right-click in the document and select Paste. A 
graphic of the copied data view will be pasted into the document.



204

Chapter 7: Size Assay Data Analysis  //  Exporting Run Files

Compass for Simple Western User Guide

Copying Results Tables
1.	 Select one or multiple rows in the Peaks or Capillaries pane.

2.	 Select Edit in the main menu and click Copy, or right-click and select Copy.

3.	 Open a document (Microsoft® Word®, Excel®, PowerPoint®, etc.). Right-click in the document and select Paste. Data 
for the rows selected will be pasted into the document.

Saving the Graph or Lane View as an Image File
1.	 Click the Graph or Lane tab.

2.	 Select Edit in the main menu and click Copy, or right-click and select Copy.

3.	 Select an image option (EMF, PNG or PDF for graph, PNG, JPG or BMP for lane) in the pop-up window, then click Save.

4.	 Select a directory to save the file to and enter a file name, then click OK.

Exporting Run Files
Results tables and raw plot data can be exported for use in other applications.

Exporting Results Tables
To export the information in the Peaks and Capillaries tables when one run is open:

1.	 Click File in the main menu and click Export Tables.

2.	 Select a directory to save the files to and click OK. Data will be exported in .txt format.

NOTE: To exclude export of standards data or export results table data in .csv format, see “Setting Data Export 
Options” on page 341.
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To export the information in the Peaks and Capillaries tables for a specific run when multiple runs are open:

1.	 Click File in the main menu.

2.	 Select the run you want to export result tables from in the Export Tables submenu. 

3.	 Select a directory to save the files to and click OK. Data will be exported in .txt format.

To export the information in the Peaks and Capillaries tables for all runs when multiple runs are open:

1.	 Click File in the main menu. 

2.	 Select the Batch Report... in the Export Tables submenu. 

3.	 Select a directory to save the files to and click OK. Data will exported in .txt format. An additional file named “Batch 
Export” lists the order of run files exported.
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Raw Sample Electropherogram Data
To export raw sample plot data:

1.	 Click File in the main menu and click Export Spectra.

•	 To export data in .txt format - Select Text Format. Plots will be exported in one file for all capillary sample data. If a 
standard curve is performed, standard curve trace data will be exported in a separate file. 

•	 To export data in .cdf format - Select ANDI Format. Plots will be exported in one file per capillary.

2.	 Select a directory to save the files to and click OK. Data will be exported in the selected format.

Running Reports
Compass for Simple Western v3.0 and higher can create and export run reports in .pdf format.

1.	 Open your run file, then select File > Run Report. The Run Report window is displayed.
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2.	 Select or deselect the information you want included in your report.

3.	 Enter a file name for the report. The report file is saved in the same location as the run file by default.

4.	 Report PDFs generated by Compass for Simple Western are secured by default, which means they can be viewed and 
printed but not modified or renamed. Uncheck Secure PDF if you don’t want to generate a secure report.

5.	 Click OK. When the report is done, the directory containing the report will display so you can open the report.

A full report includes the following:

•	 Run information

J E S S/A B BY

L E O

•	 Cartridge and Plate (Leo only)
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•	 Protocol details

•	 Plate layout

•	 Analysis settings
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•	 Lane views:
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•	 Lane views (Channel Lanes Overlay for Jess Only):

NOTE: The channel lanes overlay is also divided in the report as individual chemiluminescence, NIR, IR, Protein 
Normalization (PN), Total Protein (TP) channels and Standard lanes.

•	 IV plot:
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•	 Sample plots for each capillary:

You can also include the fluorescent standards graphs for each capillary and the standard peaks position in pixels in the 
report.

•	 Sample plots for each capillary by channel (Jess only):

NOTE: The example shown is for the NIR channel on Jess only. The report can also include the IR channel, 
fluorescent standards graphs and protein normalization for each capillary, in addition to sample peak area data 
and the standard peaks position in pixels.
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•	 Peak tables:

•	 Standard Plots for each capillary:

•	 Standard Peaks by pixel for each capillary
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•	 Standard Curves: 

•	 Grouping by peak groups:

•	 Sample images:
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NOTE: The report can also include images of other channels and standards.

•	 Analysis log:

Changing Sample Protein Identification
Compass for Simple Western allows you to customize what sample proteins are reported in the results tables by making 
manual adjustments in the electropherogram or Peaks table.

Adding or Removing Sample Data
1.	 Click Show Samples in the View bar.

2.	 Click Single View in the View bar.

3.	 Click on the row in the Experiment pane that contains the sample you wish to correct, then click the Graph tab.

•	 To remove a peak from the data - Right-click the peak in the electropherogram or Peaks table and select Remove 
Peak. Compass for Simple Western will no longer identify it as a sample peak in the electropherogram and the peak 
data will be removed in the results tables.
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•	 To add an unidentified peak to the data - Right-click the peak in the electropherogram or Peaks table and select 
Add Peak. Compass for Simple Western will calculate and display the results for the peak in the results tables and 
identify the peak in the electropherogram.

NOTES: 
To remove sample peak assignments that were made manually and go back to the original view of the data, right-
click in the electropherogram and click Clear. 
 
Virtual blot data in the Lane pane will also update to reflect changes made in the Graph pane.

Hiding Sample Data
You can hide the results for a sample protein in the results tables without completely removing it from the results 
calculated by Compass for Simple Western. To do this:

1.	 Click Show Samples in the View bar.

2.	 Click Single View in the View bar.

3.	 Click on the row in the Experiment pane that contains the sample you wish to correct, then click the Graph tab.

4.	 Right-click the peak in the electropherogram or Peaks table and select Hide. Compass for Simple Western will hide the 
peak data in the results tables.
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5.	 To view hidden peak data, click View in the main menu and click Show Hidden. Hidden peak data will display in the 
results table and be marked with an X.

6.	 To unhide a peak, right-click on the peak in the electropherogram or Peaks table and select Unhide.

Changing Peak Names for Sample Data
If Compass for Simple Western did not automatically name a sample protein associated with a specific primary antibody, 
this can be adjusted manually. You can do this in the Analysis Options pane. 

NOTES: 
For details on how to specify peak name settings, see “Peak Names Settings” on page 293 
 
Virtual blot data in the Lane pane will also update to reflect changes made in the Graph pane.
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The New option in the Name drop-down box creates a new default Peak Name using the current channel and capillaries 
that are selected.

Rename the peak and modify the parameters, then click Create.

The tooltip next to the Caps field has useful information on acceptable nomenclature when designating capillaries to apply 
a Peak Name to:

Alternatively, right-click the peak in the electropherogram, Peaks table, or Lane view. Then click Name Peak and either 
select a name in the list or create a new peak name by selecting New.... Compass for Simple Western will change the peak 
name in the electropherogram and results tables and adjust peak names for other sample proteins accordingly.
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When creating a new peak name, enter the appropriate name in the Peak Name box:



219

Chapter 7: Size Assay Data Analysis  //  Changing Sample Protein Identification

Compass for Simple Western User Guide

For a named peak, you can change the name, molecular weight, the channel, its associated color, or designate 
corresponding capillaries. Click the desired peak in the Graph view, band in the Lane view, or row in the Peaks table. Then 
in the Peak Names menu of the Analysis Options pane, make the desired modification and click Modify:

Displaying Sample Data for Named Peaks Only
You can adjust the sample data to display results only for user-specified named peaks. To do this:

1.	 Click Samples in the View bar.

2.	 Click View in the main menu and click Filter.

3.	 Check the Show Named Peaks only box and click OK.

J E S S/A B BY L E O

Compass for Simple Western will hide peak data in the electropherogram and results tables for all unnamed peaks, and 
instead only display data for named peaks in the electropherogram and results tables.
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Changing the Virtual Blot View
Options in the Lane pane let you change the contrast or invert the virtual blot, visualize baseline corrected data, change 
lane labels or overlay standards data on sample lanes.

The Lane pane toolbar has the following options:

Protein Overlay (only when a Total Protein assay or Protein Normalization was run)

Contrast Adjustment

Invert

Lane Options

Overlay Standards Data

Overlaying Protein Normalization or Total Protein Data

To view Total Protein or Protein Normalization data, make sure the Protein Normalization channel (Jess only), 
chemiluminescence channel in a Stellar assay with Total Protein (Jess only), or Total Protein in Probe 2 of RePlex Assays is 
selected first, then click the Protein Overlay icon. 

Normalized data will appear.

P R OT E I N N O R M A L I Z AT I O N N O R M A L I Z E D DATA O N J E S S
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TOTA L P R OT E I N N O R M A L I Z E D DATA O N A B BY

Protein Normalization or Total Protein data is shown as peak area counts, or peak area count percentages relative to a 
selected reference capillary on the secondary y-axis in lane view.

NOTE: Normalization must be enabled in the Analysis settings to display peak count percentage values.

For Protein Normalization runs (Jess only), RePlex runs with Total Protein (Jess/Abby/Leo), and Stellar runs with Total 
Protein (Jess only), Compass automatically displays the normalized peak area for detected peaks in Chemiluminescence, 
NIR, and/or IR channels in the Corr. Area column in the Peaks table. Additionally, if Protein Normalization is on (Jess only), 
the total peak area used for normalization is listed in the Corr. Area column.
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For RePlex runs with Total Protein in Probe 2, total peak area used for normalization is listed in the Area column when 
the Probe 2 channel is on as shown in the Peaks table below. For Stellar runs with Total Protein, total peak area used for 
normalization is listed in the Area column when the chemiluminescence channel is on.

Normalization is enabled by default. For more details on enabling or disabling Normalization, or to choose a different 
reference capillary see “Normalization” on page 290.

Adjusting the Contrast
1.	 Click the Contrast Adjustment button. 

2.	 The contrast tool will display:

3.	 There are two ways you can use the Contrast Adjustment tool. The slider is unlocked by default, so you can slide it 
left or right until the desired contrast is reached. You can also lock the slider at a fixed position and save your desired 
contrast levels. This lets you reproduce the same contrast level across data files.
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4.	 To lock the slider, select Edit > Analysis, and choose the Lane Contrast page. Select Fixed Levels. The numbers 
displayed refer to the current White and Black levels for the chemiluminescence or fluorescence (Jess only) run being 
analyzed. Change these settings and click Apply to see how they impact the contrast on the lane view. Once you’re 
satisfied with the changes, click OK.

•	 When you select Fixed Level, the slider won’t be available in the lane view.

•	 The Lane Contrast setting can also be determined and saved in the Default Analysis of the Assay. That way, any 
data obtained by running the assay will all have the same contrast settings.

•	 Lane Contrast settings from the assay or run analysis windows can be exported to be applied to other assays or 
runs.

Inverting the Virtual Blot
1.	 Click the Invert button. The virtual blot image will invert:

2.	 Click the Invert button again to return to the default view.
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Lane Options

NOTE: If you save the run file after updating Graph, Lane, and Table options in the Analysis screen, those selections 
will override the Default Analysis settings and will automatically display the next time you open the run file. See 
“Step 8 - Modify Default Analysis View (Optional)” on page 57 for more information.

Selecting Lane Labels

The labels shown above the lanes in the virtual blot can be customized. To do this:

1.	 Click the Lane Options button. The label box will display. Lane labels for a Chemiluminescence Immunoassay and a 
RePlex Assay are shown:

C H E M I L U M I N E S C E N C E I M M U N OA S S AY O N J E S S/A B BY
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R E P L E X A S S AY O N J E S S/A B BY



226

Chapter 7: Size Assay Data Analysis  //  Changing the Virtual Blot View

Compass for Simple Western User Guide

R E P L E X A S S AY O N L E O

2.	 The following lane display options are available. Check one or multiple label boxes, and uncheck those you don’t want 
to display. To remove labels completely, uncheck all boxes.

•	 Baseline On - Checking this box applies the baseline correction to the view.

•	 Independent Cartridge Scales (Leo only) - Checking this box lets you have independent control of contrast scales 
for cartridges in a run when using the Contrast Adjustment button.

•	 Independent Probe Scales (RePlex Assays only) - Checking this box lets you have independent control of contrast 
scales for Probe 1 and Probe 2 data for RePlex assays when using the Contrast Adjustment button.

•	 Lane order by Probe (RePlex Assays only) - Checking this box displays lanes based on the probe number. All Probe 
1 data will be displayed side by side, followed by Probe 2 data.

•	 Sample - Sample name. If sample names were entered in the assay template (Assay screen), those names will 
display here. Otherwise, Sample (default name) will display.

•	 Primary - Primary antibody name. If primary antibody names were entered in the assay template (Assay screen), 
those names will display here. Otherwise, Primary (default name) will display.

•	 Secondary Ab - Secondary antibody name. If a secondary antibody name was entered in the assay template (Assay 
screen), those names will display here. Otherwise, Secondary (default name) will display.

•	 Capillary

•	 Jess/Abby Immunoassays (non-RePlex): Capillary number.

•	 Jess/Abby RePlex Assays: Probe and capillary number. For example, 1:4 indicates Probe 1, capillary 4.

•	 Leo Immunoassays (non-RePlex): Capillary and cartridge number. 
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•	 Leo RePlex Assay: Probe and capillary number, followed by cartridge number. For example, 1:4 C1 indicates 
Probe 1, capillary 3, cartridge 1. 

•	 Attributes - Attribute text. If attribute information was entered for any of the rows or wells in the assay template 
(Assay screen), up to three can be selected and displayed as lane labels.

Viewing the Corrected Sample Baseline

1.	 Click the Lane Options button and select the Baseline On box (active for sample data only). This will apply the 
automatic baseline correction.

2.	 Deselect the Baseline On box to return to the default, uncorrected baseline view.
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Overlaying Standards Data on Sample Lanes
Data for the standards can be overlaid on the sample data in the virtual blot so you can view the raw, unaligned 
(uncorrected) lane data. To do this:

1.	 Click the Overlay Standards Data button (active for sample data only). An overlay of the standards data, in green 
boxes, and raw sample data will display:

2.	 Click the Overlay Standards Data button again to return to the default, auto-aligned view.

Moving Lanes in the Virtual Blot View
Lanes in the virtual blot view can be moved to make it easier to compare specific lanes of data. To do this:

1.	 Click a lane in the virtual blot. Hold the mouse button down and drag the lane to a new position.
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2.	 Release the mouse button. The lane will now be repositioned in the virtual blot view.

NOTE: If you change the channel selection or exposure, the lanes will revert back to the default order. 

Creating Annotated Lane View Figures
The Annotations pane lets you create annotated figures of the Compass Lane view for use in presentations or publications.

NOTES: 
You can only create annotated figures from one run file at a time. The Annotations pane is not active when multiple 
run files have been opened using File > Add Run. 
 
The Annotations pane can’t be used when Access Control is enabled for 21 CFR Part 11 compliance.

To create a figure:

1.	 Select the lanes you want to create a figure from. For RePlex runs, select the probe/channel(s) to include.

2.	 Adjust the lane contrast as needed.

3.	 Click the Create a figure icon in the Annotations pane.
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The Lane pane shows a figure preview in a pink bounding box. The Annotations pane displays the crop region information 
for the bounding box, which includes capillaries for the selected lanes, the MW range of the assay type used for the run 
file, and contrast settings.

C H E M I L U M I N E S C E N C E I M M U N OA S S AY

R E P L E X A S S AY W I T H T WO C H A N N E L S S E L E C T E D

In the preview you can:

•	 Adjust the lane/capillary order - Click on a lane and drag it to the position you want it to be in, or type the capillary 
order in the Caps field. Separate each number with a comma.
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•	 Adjust the MW Range - Drag the pink bounding box until the desired range is displayed in the table, or just click in the 
table cell and type a range.

•	 Adjust the contrast - see “Adjusting Lane Contrast” on page 239.

For probe specific (Jess, Abby, and Leo) and cartridge specific (Leo only) contrast adjustment:

a.	 After the figure has been created, click in the Channel Contrast column and click on the … next to the available 
channels for the crop region.
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b.	 Select the Custom Contrast checkbox in the Custom Contrast dialog window.

c.	 Move the sliders for the specific channel, cartridge (C1, C2, etc.), or probe (P1 or P1) to adjust the lane contrast. 

d.	 Click OK to save the changes. 

•	 Add another crop region - Click in the first blank cell in the MW Range column.
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A second bounding box will display on the figure preview.

 

Drag the pink bounding box for the second crop region until the desired range is displayed in the table, or just click in 
the table cell and type a range.

•	 Add a channel/probe for RePlex assays - This lets you create a figure that stacks multiple channel/ probe views. Click 
in the first blank cell in the MW Range column. Select the channel checkbox(es) and click OK.
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A second bounding box will display in the figure preview:

Drag the pink bounding box for the second crop region until the desired range is displayed in the table, or just click in 
the table cell and type a range.

•	 To delete a crop region - click the cell on the left of the MW Range column to highlight the row, then right-click the 
column, and select Delete.
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4.	 Click Crop to create the figure file.

The figure displays in a new tab. 

C H E M I L U M I N E S C E N C E I M M U N OA S S AY W I T H O N E C R O P R E G I O N
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R E P L E X A S S AY W I T H T WO S TAC K E D C R O P R E G I O N S F O R E AC H P R O B E 

After the figure is cropped, the information in Caps and the table can’t be adjusted. If changes are needed, click 
Re-crop. This returns you to the prior view where you can reorder lanes, adjust the MW range, adjust the contrast, or 
add a new crop region.

NOTES: 
After you create a figure, saving the run file saves the figure with the run data and the figure will display the next 
time you open the file. 
 
If you don’t see the data you want to include in the figure preview, you can click on the Lane tab to review all run 
data and select/deselect channels.
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5.	 Optional: If you’d like to create a new figure, repeat the prior steps. Each new figure will display in its own tab:

NOTE: If Analysis settings are modified in the run file, for example peak name changes or changes that affect peak 
area, those changes are automatically applied to figures created from the run file.

Annotations Pane Toolbar
These options are available in the Annotations pane toolbar:

Figure 
selection

Duplicate 
selected 

figure

Export selected 
figure

Delete selected figure

Create a 
figure

To export a figure:

Click the Export selected figure icon or right-click on the figure and select Export. Browse to the directory you want to 
save the file to and update the file name as needed. File names must use these guidelines:

•	 Names must be between 1 and 20 characters

•	 Names must not already be in use in the same run file
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•	 Use Unicode characters only:

•	 Letters and numbers

•	 Spaces

•	 Hyphen, minus or underline

•	 $

Click the down arrow in Save as Type to choose a file format.

•	 .png and .jpg are best for use in external programs like Microsoft® Word® or PowerPoint®.

•	 .tiff is exported at 300 dpi and is the recommended format for submitting data to journals for publication.

To duplicate the current figure: Click the Duplicate selected figure icon. A duplicate of the figure currently selected will 
display in a new tab.

To create another figure: Follow the steps outlined earlier in this section. When you click the Create a figure icon, the new 
figure will display in a new tab.

To switch between annotating multiple figures: Click the Figure selection drop-down and select the figure you’d like to 
annotate.

To copy a figure: Right-click on the figure and select Copy. Open a document (Microsoft® Word®, Excel®, PowerPoint®, 
etc.). Right-click in the document and select Paste.

To delete a figure: Click the Delete selected figure icon.

To rename a figure: Select the figure in the Figure selection drop-down, then click on the text and type a new name.
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Adjusting Lane Contrast
After you create a figure, you can adjust the lane contrast in the figure two ways:

Contrast adjustment in the Lane pane:

This option lets you change the contrast for the Lane View and the figure at the same time. Note that contrast adjustments 
can be channel-specific and probe-specific depending on which Lane View options are selected.

Click the Contrast Adjustment icon in the Lane pane.

Click the bar and slide it left or right until the desired contrast is reached. The virtual blot lane contrast will change as you 
do this, but not the figure. The contrast adjustment will be applied to the figure when you release the mouse.

The following examples show Lane View and figure contrast before after adjusting the contrast using Contrast Adjustment:

B E F O R E A F T E R
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Custom contrast in the Annotations pane:

This option lets you change the contrast in the figure only.

NOTES: 
Custom contrast changes made in the Annotations pane are applied to the figure only. They are not applied to the 
run data or in Lane View. 
 
If Custom Contrast is selected in the Annotations pane, figure contrast can’t be changed using the Contrast 
Adjustment tool in the Lane View.

1.	 In the Annotations pane, click the down arrow next to Crop Regions to expand the section. Click the cell in the Contrast 
column for the crop region you’d like to adjust, then select the ... button:

2.	 Select the Custom Contrast checkbox.
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3.	 Click the bar and slide it left or right until the desired contrast is reached. Only the lane contrast in the figure, not Lane 
View, will change as you do this.
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Adding Lane Labels
This option lets you add lane labels on the figure, and change how they display.

NOTE: Lane labels cannot be added when Access Control is enabled. 

1.	 Click the down arrow next to Lane Labels to expand the section.

You can create different lane label groups based on assay attributes or create your own custom group.

NOTE: Assay attributes for the run file can be viewed in the Assay screen Template pane.

Compass automatically creates a default SampleGroup which is linked to the Sample name in the assay template. For 
more information on assay plate annotations, see “Step 5 - Add Assay Plate Annotations (Optional)” on page 52. This 
information for the run data is displayed in the table and above the lanes in the figure.
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2.	 Edit the default lane label group as needed:

a.	 Click in the Group field and enter a new name.

b.	 Select an attribute using the Link to drop-down menu.

In this example, Capillary was selected as the attribute (for RePlex assays, this attribute is Probe:Capillary). This 
displays capillary numbers above the lanes in the figure. This information is also displayed in the Lane table.

You can also create a custom group by selecting None from the Link to drop-down menu. Selecting None allows you to 
create custom names for each Lane Label in the table.
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3.	 Create new groups as needed. Lane labels for all groups will be displayed on the figure.

a.	 Click the Create a label group icon.

b.	 Click the Group field and enter a name.

c.	 Select an attribute using the Link to drop-down menu. In this example, two lane groups are displayed on the figure, 
one for capillaries and for samples:

4.	 Change the lane label styles using the Style icons. Styles are applied per group. If you’re using more than one lane 
label group, first select the group you want to change in the Group drop-down.

Merge labels Label location Overline/underline

Rotate label

Wrap label text Group name position
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Merge labels: Toggling this icon switches between having individual labels on every lane or merging labels across 
lanes with the same Lane Label name.

Wrap label text: Toggling this icon switches between the label text displaying on one line or wrapping onto the next 
line.

When this option is active, || displays in the label text in the table to indicate where the text will wrap. If you’ve created a 
custom group, you can add additional breaks by typing || next to a word.

Label location: Toggling this icon moves the labels to under the lanes and back to the top. The default position is above 
the lanes. If more than one set of group labels is displayed, toggling the icon will move the currently selected group’s 
labels under other group labels first before moving it under the lanes.
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Group name position: Toggling this icon displays the group name on the left, top and right of the lane labels, or turns 
the display off. The default is off.

Underline/Overline: Toggling this icon switches between displaying a line under the labels, above the labels, or off.

Rotate label: This lets you change the font angle of the labels. Click the Rotate label icon and enter a font angle. The 
default setting is 0 (horizontal). You can enter values from 0 to 90 degrees.

 Lane labels will rotate accordingly:

Adding Band Labels

NOTE: Band labels cannot be added when Access Control is enabled. 
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This option lets you add band labels on the figure and change how they display.

1.	 Click the down arrow next to Band Labels.

You can create different band label groups based on the Peak Names you created in the Analysis Settings for your run 
or create your own custom groups.

NOTE: The Peak Name groups associated with the run data can be viewed in the Analysis Screen in the Analysis 
Options pane.

Compass automatically creates default band label groups based on the Ladder and Peak Name groups in the run data, 
and these labels automatically display on the figure. In this example, the default groups included a Ladder, and a group 
with ERK1 and System Control. 
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2.	 Edit the default groups as needed:

a.	 Click in the Group field and select a group.

b.	 Change the name of the group as needed.

c.	 Select a Peak Name group using the Link to drop-down menu.

The peak names for the linked group will display in the table.
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3.	 Create new groups as needed. Band labels for all groups will be displayed on the figure.

a.	 Click the Create a label group icon.

b.	 Click the Group field and enter a name.

c.	 Select a Peak Name group using the Link to drop-down menu.

You can also create a custom band label group by selecting None as the Link to option. This lets you add new label 
names directly into the table. Click in the table cells and enter a name and a MW for each band. In this example, a 
custom group was added to indicate where a band was expected but not detected in the sample:

4.	 Change the band label styles using the Style icons. Styles are applied per group. If you’re using more than one group, 
first select the group you want to change in the Group drop-down.

Wrapping text

Line style Label location
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Line style: Toggling this icon changes the line style next to the band label between no line, a short line, a long line and 
a line with an arrow.

Wrap label text: Toggling this icon switches between the label text displaying on one line or it wrapping to the next line.

When this option is active, || displays in the label text in the table to indicate where the text will wrap. You can add 
additional breaks by typing || next to a word.
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Label location: Toggling this icon moves the labels back and forth between the left and right side of the lanes. The 
default setting is on the right.

Adding a Title and Notes

NOTE: Titles and notes cannot be added when Access Control is enabled. 

You can add a title, notes and insert the run file name on the figure.

1.	 Click the down arrow next to Title & Notes to expand the section.
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2.	 Enter a title and any notes. Text for both will display on the figure as you type. The title displays at the top of the figure, 
notes display under the lanes.

3.	 Clicking #cbz will insert the run file name in the Notes text box:
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Changing the Font

NOTE: Fonts cannot be changed when Access Control is enabled. 

You can change the font, font size, and style used for figure annotations.

1.	 Click the down arrow next to Settings to expand the section and click the ... button.

2.	 Select the desired font, font style, and size and click OK. The default font is Segoe UI.
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Font changes are applied to all text on the figure. The font for labels, titles, and notes can’t be changed individually. In 
this example, the selected font is Palatino bold:

 

Changing the Electropherogram View
Options in the Graph pane let you zoom and scale electropherograms, overlay or stack plots, and change the peak and plot 
information displayed.

The Graph pane toolbar has the following options:

Auto Scale

Graph Options

Stack the Plots

Overlay the Plots
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Autoscaling the Electropherogram
Click the Autoscale button to scale the y-axis to the largest peak in the electropherogram.

Click the Autoscale button again to return to default scaling.
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Stacking Multiple Electropherograms
Electropherogram data for multiple capillaries can be stacked vertically in the Graph pane for comparison. To do this:

1.	 Click the View Selected icon. You can also select View in the main menu and click Selected. 

2.	 Select multiple rows in the Experiment pane.

3.	 Click the Stack the Plots button. 

4.	 The individual electropherograms for each row selected will stack in the Graph pane.

You can customize the colors used for the stacked plot display. For more information see “Selecting Custom Plot Colors 
for Graph Overlay” on page 342.

NOTE: In Compass for Simple Western version 5.0 and higher, you can no longer change or save Custom 
Preferences outside of the first instance of the software that’s been opened. When running multiple instances of the 
software on the same computer, an error message displays if you try to change Custom Preferences in any instance 
except the first instance opened.
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Overlaying Multiple Electropherograms
The electropherogram data for multiple capillaries can also be overlaid on top of each other for comparison in the Graph 
pane. To do this:

1.	 Click the View Selected icon. You can also select View in the main menu and click Selected. 

2.	 Select multiple rows in the Experiment pane.

3.	 Click the Overlay the Plots button. 

4.	 The individual electropherograms for each row selected will overlay in the Graph pane.

You can customize the colors used for the overlay plot display. For more information see “Selecting Custom Plot Colors 
for Graph Overlay” on page 342.

NOTE: In Compass for Simple Western version 5.0 and higher, you can no longer change or save Custom 
Preferences outside of the first instance of the software that’s been opened. When running multiple instances of the 
software on the same computer, an error message displays if you try to change Custom Preferences in any instance 
except the first instance opened.
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Zooming
To zoom in on a specific area of the electropherogram, hold the mouse button down and draw a box around the area with 
the mouse:

To return to default scaling, right-click in the electropherogram and click Zoom Out.
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Graph Options: Customizing the Data Display

NOTES:  
If you save the run file after updating Graph, Lane, and Table options in the Analysis screen, those selections will 
override the Default Analysis settings and will automatically display the next time you open the run file. See “Step 8 
- Modify Default Analysis View (Optional)” on page 57 for more information. 
 
If multiple run files are open, the Graph, Lane, and Table options for the run added last will be applied to the rest of 
the open runs. 

You can customize electropherogram peak labels, plot labels, and display options. To do this, select the Graph Options 
button. An example of the Graph Options for an assay using RePlex is shown below. 

Peak Labels

You can customize the labels used to identify peaks in the electropherogram with these options:
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•	 Matching Peak Names - Checking this box will draw vertical lines through each named peak. Using this option with 
Stack the Plots or Overlay the Plots features is useful for visual comparison of named peaks across multiple capillaries.

•	 Peak Names - Checking this box will display peak name labels on all named peaks in the electropherogram.

NOTE: If more than one peak label option is selected, peak name labels will always be used for named peaks. 
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•	 Peak Values - Checking this box will display the molecular weight labels on all peaks in the electropherogram.

NOTES: 
When viewing standards data, this option is called Peak Positions. Labels displayed are peak positions rather than 
molecular weight. 
 
If more than one peak label option is selected, peak name labels will always be used for named peaks. 
 
The reported molecular weight for sample proteins detected by an Immunoassay or a Total Protein Assay in 
Compass for Simple Western may vary from apparent molecular weights using other techniques and based on 
sample and assay conditions.1,2

Baseline, All Exposures, and Grid Options

You can view the calculated baseline fit, peak integration, capillary region used to calculate noise, view all exposures, and 
show grid lines for sample date with these options. When viewing standards data, only the Grid Lines option is available.

1 Electrophoresis. 2021 Aug;42(14-15):1521-1531. doi: 10.1002/elps.202100068. 
2Electrophoresis. 2021 Feb;42(3):206-218. doi: 10.1002/elps.202000199. 
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•	 Fitted peaks - Checking this box will display how the peaks were fit by the software.

•	 For Immunoassays, the software uses Gaussian fit by default:

•	 Baseline Fit - Checking this box will display the calculated baseline for the peaks. Depending on your baseline type 
setting (baseline points or interpolated baseline), baseline points will also display for regions of the electropherogram 
considered to be at baseline.

•	 Noise Region - Checking this box will overlay the noise region on the electropherogram. The noise region is indicated 
by the two red dots. For more information on signal to noise methods and calculations, see “Signal to Noise Settings” 
on page 326.
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•	 All Exposures - Checking this option will overlay all the chemiluminescence or fluorescence (Jess only) exposure times 
acquired for a particular run. The peak that corresponds to the exposure time selected in the Analysis window on the 
Images page will be outlined in blue and the Peaks table below the graph window displays the data corresponding to 
the selected exposure time.

In the image below, the All Exposures option is displayed and the 30 second exposure selected in the Analysis window 
is outlined in blue.
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Viewing all the exposures in a single image can aid in spotting potential signal burnout.

Exposure times are sequential, so longer exposures may have less signal. Since the y-axis in the graph view reports 
signal/time, the peak heights for the different exposures should be fairly similar. The peak heights and areas will 
decrease over time with normal HRP enzyme or fluorophore decay, or signal saturation, which is expected to occur in 
the late exposures (longer than 120 or 240 seconds).

If on the other hand you observe a quicker signal (peak height) decline over time in the tall peaks vs. smaller peaks for 
a chemiluminescence run, then this decline is what we refer to as burnout and is a result of local Luminol depletion.

As a rule of thumb, start by looking at the shortest exposure times (typically between 5 to 30 seconds). If the peak 
heights from each exposure have similar values, then there is likely no signal burnout. If the peak height decreases 
significantly during those early exposure times, this is an indication of potential signal burn-out. Another hallmark of 
signal burnout is peaks developing shoulders and eventually splitting as exposure time increases.

If you experience burnout, the first thing to do is to reduce the signal level by lowering the sample concentration in the 
assay. We do not recommend lowering the primary or secondary antibody concentration. Keeping the primary antibody 
concentration at saturation conditions keeps your assay linear and reproducible.

The image below shows a chemiluminescence detection example where the peak height from 5 to 30 seconds declines 
significantly and it is split in two peaks by 30 seconds. In this case we would recommend that you start by lowering the 
sample concentration.
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•	 Grid Lines - Checking this box will display grid lines in the graph area.

Independent Probe Scales (RePlex Assays Only)

Checking this option displays Probe 1 and Probe 2 data using the same detection channel on independent y-axis scales. 
The Probe 1 y-axis will display on the left and the Probe 2 y-axis will display on the right. Y-axis labels will indicate P1 and/
or P2. The following example show the graph display with the Independent Probe Scales off (top) and on (bottom).

NOTE: When more than one channel is used for Probe 1, all data for a channel is displayed on the same y-axis when 
viewing three or more channels.
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Plot Labels

You can customize the plot labels displayed on the electropherogram with these options.

Plot labels are shown on the right side of the Graph pane.

•	 Sample - Checking this box will display the sample name. If sample names were entered in the assay template (Assay 
screen), those names will display here. Otherwise, Sample (default name) will display.

•	 Primary - Checking this box will display the primary antibody name. If primary antibody names were entered in the 
assay template (Assay screen), those names will display here. Otherwise, Primary (default name) will display.

•	 Secondary - Checking this box will display the secondary antibody name. If secondary antibody names were entered 
in the assay template (Assay screen), those names will display here. Otherwise, Secondary (default name) will display.

•	 Capillary - Checking this box will display the capillary number (Jess/Abby) or the capillary and cartridge number (Leo). 
For example, C1:3 indicates cartridge 1, capillary 3.

•	 Attributes - Checking this box will display attribute text. If attribute information was entered for samples, primary 
antibodies, or secondary antibodies in the assay template (Assay screen), they can be selected as plot labels.
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•	 Exposure - Checking this box will display the exposure time(s) used for the data. The following example shows an 
electropherogram with all plot labels selected:

Selecting Data Viewing Options
The graph view menu provides you with multiple options for changing what type of electropherogram data is displayed. To 
access the view menu, click the stacked dot icon in the Graph pane toolbar:
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A check mark next to the menu option indicates what is currently selected. Multiple options can be selected at a time.

NOTE: Unless otherwise noted, graph view menu options are available for sample data only.

•	 Sample - Clicking this option will display raw, uncorrected sample data.

•	 Sample Baseline Corrected - Clicking this option will display sample data with the baseline subtracted (zeroed). This is 
the default view.
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•	 Baseline Fit - Clicking this option will display the calculated baseline for the raw sample data. In the example that 
follows, both Baseline fit and Sample are selected.

NOTE: This option is selected automatically when Baseline Fit is selected in Graph Options.

•	 Baseline Points - Clicking this option will display regions of the electropherogram considered to be at baseline. In the 
example that follows, both Baseline Points and Sample are selected.

NOTE: This option is selected automatically when Baseline Fit is selected in Graph Options.
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•	 Fit - Clicking this option will display the bounding envelope of the fitted peaks as calculated by the software for the raw 
sample data. In the example that follows, both Fit and Sample are selected.

•	 Fit Baseline Corrected - Clicking this option will display the fitted peaks as calculated by the software for the sample 
baseline corrected data. In the example that follows, both Fit Baseline Corrected and Sample are selected, the fit plot is 
on the bottom.

NOTE: When viewing standards data, this option is called Standards Fluorescence.
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•	 Standards - Checking this box aligns the molecular weight of the raw standards data to the sample data and overlays 
both electropherograms in the Graph pane.

Adjusting the Baseline

Spline Baseline

NOTES:  
Baseline Type selection is only available when Dropped Lines and Dropped Lines (manual) is used for the Area 
Calculation.  
 
Spine baseline is the default setting for Baseline Type. It cannot be changed if Gaussian Fit is selected in the Peak 
Fit settings.

Points in the baseline can be added or removed as needed.

1.	 If you haven’t already, name your peaks of interest. Refer to “Changing Peak Names for Sample Data” on page 216 for 
more information. 

2.	 Select Edit > Analysis and click Peak Fit in the options list.

3.	 Choose Spline as the Baseline Type if it isn’t already selected.
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Then, to view the baseline:

1.	 Click the Graph Options button in the Graph pane toolbar and check Baseline Fit. This will display baseline points for 
the raw sample data.

2.	 Use the mouse to draw a box around the area you want to correct. This will zoom in on the area.

3.	 Right-click a baseline point and click Add Baseline Point or Remove Baseline Point.

NOTE: To clear the manual addition or removal of baseline points and go back to the original view of the data, right-
click in the electropherogram and click Clear.

Interpolated Baseline
Compass for Simple Western lets you interpolate baselines from the base of each peak for named peaks that use Dropped 
Lines (manual) integration.

1.	 If you haven’t already, name your peaks of interest.

2.	 Select Edit > Analysis and click Peak Fit in the options list.
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3.	 Choose Interpolate as the Baseline Type if it isn’t already selected.

4.	 Click OK.

5.	 In the Analysis window Graph pane, click Graph Options and select Fitted Peaks and Baseline Fit.

6.	 Select a capillary in the Experiment pane.

7.	 Hover the mouse over the peak you want to adjust the baseline on. Two magenta bars will display that show the start 
and end points of the peak’s integration.
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8.	 To change the baseline, hover the mouse over one of the magenta bars. Then click the mouse and drag the bar to move 
it. The cursor changes to indicate which direction you can move the integration point.

9.	 Baseline points can also be added between two adjacent peaks for a better fit. Hover the mouse over the region where 
you want to add the baseline point, then right-click and select Add Baseline Point. 
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10.	To remove the baseline point, hover the mouse over the area that you want to remove the baseline point, then right-
click and select Remove Baseline Point.

Selecting the X-Axis Molecular Weight Range
The molecular weight range used for the x-axis can be changed. To do this, select View in the main menu and click View 
Region. The following pop-up window will display:

•	 Selecting Analysis will match the range of the run data that was selected in the Peak Fit Analysis Settings in both the 
electropherogram and virtual blot view.
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•	 Selecting Full will display the range of the run data for the entire capillary in both the electropherogram and virtual blot 
view.

•	 Selecting Custom allows you to manually enter the Lower and Upper ranges of the run data to be displayed in both the 
electropherogram and virtual blot view.

NOTE: You can change the default x-axis range that Compass for Simple Western uses. For more information, see 
“Peak Fit Analysis Settings” on page 316.

Closing Run Files
If more than one run file is open, you can close just one file or all the open files at the same time.

•	 To close one run file

a.	 Select File from the main menu and then click Close to open the submenu.
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b.	 Select the run you want to close. 

•	 To close all open run files - Select File from the main menu and click Close All.

Analysis Settings Overview
Compass for Simple Western has a variety of analysis features and settings that you can modify as needed to enhance run 
data.

To access the analysis settings, select Edit in the main menu and click Analysis. If more than one run file is open, select 
the run file you want to view analysis settings for from the list:

The following screen will display:

J E S S/A B BY L E O
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To move between analysis pages in this window, click on an option in the list on the left. The following analysis settings 
can be user-customized in Compass for Simple Western:

•	 Standards - Lets you customize the positions Compass for Simple Western uses to identify fluorescent standards 
peaks.

•	 Ladders - Lets you customize the molecular weight Compass for Simple Western uses to identify molecular weight 
ladder peaks, as well as change the capillary, cartridge (Leo), and channel (Jess only) used.

•	 Images - Lets you view the exposures taken during the run and view data for different exposures in the Analysis 
screen.

•	 Normalization - Lets you change the reference capillary and cartridge (Leo) used for normalization calculations and 
define the region for normalization area. This setting will only appear if a Total Protein or Protein Normalization assay 
was run. 

•	 Peak Names - Lets you enter custom naming settings for sample proteins associated with specific blocking reagents, 
primary antibodies, secondary antibodies, or attributes and have Compass for Simple Western automatically label the 
peaks in the run data.

•	 Standard Curves – Lets you define a standard curve to quantitate the concentration of a target protein. 

•	 Cartridge Correction (Leo only) – Lets you define how to normalize data across cartridges. 

•	 Loading Controls – Lets you define a loading control to normalize data between capillaries, between runs, and 
between instruments. 

•	 Peak Fit - Lets you customize peak fit and baseline settings for sample data.

•	 Lane Contrast - Lets you enter custom contrast settings for detection channels in Lane View.

•	 Signal to Noise - Lets you change the method used to calculate signal to noise in sample data.

•	 Advanced - Lets you customize analysis settings for samples, standards and image data.

•	 Groups - Lets you customize how to group run data when the Grouping function is enabled. 

NOTES:  
Settings can be modified in an assay prior to starting a run, or in a run file once the run has finished executing. 
Analysis changes made to an executing run will not be saved to the final run file. 
 
Analysis settings are run-file specific. However, settings can be imported or exported for use with other run files. 
For more information see “Importing and Exporting Analysis Settings” on page 337.
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Standards Settings
The standards analysis settings page lets you view and change the position for fluorescent standards. To access this 
setting, select Edit in the main menu and click Analysis, then click Standards in the options list. The default standard 
settings for the 12-230 kDa size range is shown in the following example:

J E S S/A B BY L E O

•	 Click Import to import an analysis settings file. This is explained in more detail in “Importing Analysis Settings” on 
page 337.

•	 Click Export to export the current analysis settings file. This is explained in more detail in “Exporting Analysis Settings” 
on page 337.

•	 Click Apply to see effect of changes before saving. 

•	 Click OK to save changes and exit.

•	 Click Cancel to exit without saving changes.

NOTE: We recommend using the Compass for Simple Western default values for standards analysis settings. These 
settings are included in the default Standards group.
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Creating a New Standard
1.	 Select Edit in the main menu and click Analysis, then click Standards in the options list.

2.	 Click Add under the Fluorescent Peaks table. A new MW will be added.

3.	 Click in the first cell in the MW column in the Fluorescent Peaks table.

4.	 Enter the molecular weight (in kDa) for the fluorescent standard.

5.	 Click in the first cell in the Position column.

6.	 Enter the position of the fluorescent standard peak.

NOTE: Standards peak positions are relative to each other. Only the difference in their position is used to help 
identify the standard peaks. When entering standard peak information for the first time, review the standards data in 
the Analysis screen to find the correct peak position.

7.	 Repeat the steps above for the remaining standards in the table.

8.	 Select which standards should be used for molecular weight determination of sample proteins by clicking the checkbox 
in the Fit column.

Standards Analysis Settings Groups (Leo only)
Standards settings are saved as a group, and multiple settings groups can be created. Specific group settings can then be 
applied to individual cartridges in the run data.
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Ladders Settings
The ladders analysis settings page lets you view and change the molecular weight for the ladder and change the capillary, 
probe (RePlex assays), channel (Jess only), or cartridge (Leo only) used for it. To access these settings, select Edit in the 
main menu and click Analysis, then click Ladders in the options list.

For RePlex Assays, select the ladder in Probe 1 or Probe 2, depending on the assay setup.

NOTE: Probe selection is not available with RePlex Assays that include Total Protein.

The default ladder settings for the 12-230 kDa size range is shown in the following example for a Chemiluminescence 
Immunoassay on Jess/Abby (top) and a RePlex Assay (middle) on Jess/Abby, and a Chemiluminescence Immunoassay 
(bottom) on Leo.

C H E M I L U M I N E S C E N C E I M M U N OA S S AY O N J E S S/A B BY

R E P L E X A S S AY O N J E S S/A B BY
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C H E M I L U M I N E S C E N C E I M M U N OA S S AY O N L E O

NOTE: We recommend using the Compass for Simple Western default values for ladders analysis settings. These 
settings are included in the default Ladders group.

Changing the Capillary Used for the Ladder

Known ladders are used to calculate the molecular weights of unknown sample proteins. We strongly recommend that you 
use capillary 1 for the ladder. However, you can change the ladder capillary as needed, or opt to not use a ladder at all.

NOTES: 
When the ladder capillary is set to None, fluorescent standards information is used to calculate sample protein 
molecular weight instead of the ladder. 
 
The reported molecular weight for sample proteins detected by an Immunoassay or a Total Protein Assay in 
Compass for Simple Western may vary from apparent molecular weights using other techniques and based on 
sample and assay conditions.1,2

1 Electrophoresis. 2021 Aug;42(14-15):1521-1531. doi: 10.1002/elps.202100068. 
2Electrophoresis. 2021 Feb;42(3):206-218. doi: 10.1002/elps.202000199. 
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To change the ladder capillary on Jess/Abby:

1.	 Select Edit in the main menu and click Analysis, then click Ladders in the options list.

2.	 Click the arrow in the drop-down list next to Capillary, then click a capillary number or None from the list. 

3.	 Click Apply and then OK to save changes and exit. 

To change the ladder capillary on Leo with one ladder setting:

1.	 Select Edit in the main menu and click Analysis, then click Ladders in the options list.

2.	 Click the arrow in the drop-down list next to From Cartridge and select per Cartridge so each cartridge will have the 
same reference ladder capillary settings. 
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3.	 Click the arrow in the drop-down list next to Capillary, then click a capillary number or None from the list.

4.	 Click Apply and then OK to save changes and exit. 

To change the ladder capillary on Leo with multiple ladder settings:

1.	 Select Edit in the main menu and click Analysis, then click Ladders in the options list.

2.	 Click Add under the Analysis Group box. A new group will be created. Optional: click on the new group and enter a new 
name. 

3.	 Click the arrow in the drop-down list next to From Cartridge and select a cartridge. 
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4.	 Click the arrow in the drop-down list next to Capillary, then click a capillary number or None from the list. 

5.	 Click the arrow in the drop-down list in the Apply Default menu to define the default ladder group.

6.	 Apply a ladder analysis group to specific run data using the Apply Override box. Click Add under the override box. The 
override data set will be created. 

7.	 Click the cell in the Apply To column, then click the down arrow. Select the cartridges to apply the cartridge analysis 
group to. 

8.	 Click Apply and then OK to save changes and exit. 

Compass for Simple Western will use the data in the selected capillary to recalculate molecular weights for sample 
proteins in the run data using the information in the Ladder table. If None is selected, Compass for Simple Western will 
instead use the information in the fluorescent peaks table (fluorescent standards) to calculate molecular weight for sample 
proteins.
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Creating a New Ladder
1.	 Select Edit in the main menu and click Analysis, then click Ladders in the options list.

2.	 Click the arrow in the drop-down list next to Capillary, then click a capillary number. Capillary 1 is typically used for the 
ladder.

Compass for Simple Western will use the data in the selected capillary to calculate the molecular weights for sample 
proteins using the information in the Ladder table.

NOTE: The reported molecular weight for sample proteins detected by an Immunoassay or a Total Protein Assay 
in Compass for Simple Western may vary from apparent molecular weights using other techniques and based on 
sample and assay conditions.1,2

3.	 Click in the first cell in the MW column in the ladder table. Enter the molecular weight (in kDa) for the ladder standard.

1 Electrophoresis. 2021 Aug;42(14-15):1521-1531. doi: 10.1002/elps.202100068. 
2Electrophoresis. 2021 Feb;42(3):206-218. doi: 10.1002/elps.202000199. 
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4.	 Repeat the steps above for the remaining ladder MW values in the table.

5.	 Click Apply and then click OK to save changes.

Images Analysis Settings
The Images settings in the Analysis window lets you see what Detection Profile was selected, what exposures were taken 
during the run, and view data for different exposures in the Analysis screen. To access these settings, select Edit in the 
main menu and click Analysis, then click Images in the options list.

NOTES: 
If you’re using Compass for Simple Western v3.1 or higher, High Dynamic Range is the default setting. 
 
If the run was performed with HDR unchecked, the data can still be analyzed with the improved HDR algorithm by 
selecting High Dynamic range from the drop-down menu. For Jess, Abby, and Leo chemiluminescent runs, the 
increase in dynamic range will not be as noticeable since the substrate refresh was not performed.

NOTE: The Images pane will only list the channels of data that are present in the run data file.

•	 Click Import to import an analysis settings file. This is explained in more detail in “Importing Analysis Settings” on 
page 337.
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•	 Click Export to export the current analysis settings file. This is explained in more detail in “Exporting Analysis Settings” 
on page 337.

•	 Click Apply to see effect of changes before saving. 

•	 Click OK to save changes and exit.

•	 Click Cancel to exit without saving changes.

Exposure Settings
The exposure used for the sample data displayed in the Analysis screen is shown below for a Chemiluminescence 
Immunoassay with Protein Normalization (top), a 2 Chemiluminescence Immunoassay with RePlex (second), a Leo 
Chemiluminescence Immunoassay (third), and a Stellar Assay on Jess (bottom):

C H E M I L U M I N E S C E N C E I M M U N OA S S AY W I T H TOTA L P R OT E I N N O R M A L I Z AT I O N U S I N G P R OT E I N 
N O R M A L I Z AT I O N C H A N N E L 

C H E M I L U M I N E S C E N C E I M M U N OA S S AY + C H E M I L U M I N E S C E N C E I M M U N OA S S AY U S I N G R E P L E X

C H E M I L U M I N E S C E N C E I M M U N OA S S AY O N L E O
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S T E L L A R F L U O R E S C E N C E N I R / I R I M M U N OA S S AY

Even when the exposures for HDR are set and can’t be edited from the assay protocol, here you can choose to view each 
one separately including High Dynamic Range (HDR multi-image).

•	 High Dynamic Range (Chemiluminescence only) - The HDR method uses information from multiple exposures to 
achieve good signal-to-noise for low protein concentration while simultaneously maintaining signal monotonicity at 
high protein concentration (i.e. avoiding “burnout”).

•	 High Dynamic Range 4.0 - Algorithm improvements were made to the original High Dynamic Range analysis in HDR 4.0 
to handle a wider range of burnout cases. HDR 4.0 is less sensitive to the rate at which burnout occurs. 

•	 Exposure # - Sample data displayed in the Analysis screen is for this specific exposure only.

To see the number of exposures and exposure times used for the run data, click the arrow in the drop-down.

NOTE: The number of exposures taken and exposure times shown were specified in the assay protocol (Assay 
screen) prior to executing the run and cannot be modified.

Changing the Sample Data Exposure Displayed
The exposure used for the sample data displayed in the Analysis screen can be changed. To do this:

1.	 Select Edit in the main menu and click Analysis, then click Images in the options list.

2.	 Click the arrow in the drop-down list to select an exposure setting:

3.	 Click Apply and then click OK to save changes and exit. Sample data for the exposure selected will display in the 
Analysis screen.
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Normalization
The Normalization settings in the Analysis window lets you view and change the reference capillary used for total 
protein normalization calculations and adjust the control area and size region for determining the normalization area. 
Normalization settings are applicable when using the Protein Normalization Module (Jess Only) or when enabling the Total 
Protein feature for RePlex and Stellar Assays. To access these settings, select Edit in the main menu and click Analysis, 
then click Normalization in the options list.

NOTES: 
For Jess runs that include Protein Normalization, RePlex with Total Protein, and Stellar with Total Protein, the default 
Reference Capillary is set to 2. 
 
For Abby runs that include RePlex with Total Protein, the default Reference Capillary is set to 2. 
 
For Leo runs that include RePlex with Total Protein, the default Reference Capillary is set to 2 for each cartridge.  
 
The Enable checkbox is selected by default and must stay selected to normalize immunoassay targets. 
 
Only one type of normalization is allowed per analysis. Cartridge Correction and Loading Controls cannot be used if 
Normalization is enabled. 

J E S S/A B BY L E O

•	 Click Import to import an analysis settings file. This is explained in more detail in “Importing Analysis Settings” on 
page 337.

•	 Click Export to export the current analysis settings file. This is explained in more detail in “Exporting Analysis Settings” 
on page 337.

•	 Click Apply to see effect of changes before saving. 
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•	 Click OK to save changes and exit.

•	 Click Cancel to exit without saving changes.

NOTE: If you deselect the Enable checkbox in the Normalization settings, only total protein values will display, 
immunoassay target data won’t be normalized.

To use the Protein Normalization fluorescence signal or RePlex/Stellar Total Protein chemiluminescent signal from a 
reference capillary for protein normalization: Click the Reference Capillary drop-down menu and select the capillary 
you’d like to use as the normalization control to normalize all other capillaries against. 

For Leo RePlex runs with Total Protein chemiluminescent signal, you can choose to normalize each cartridge’s data to 
a reference capillary within each cartridge by clicking the Cartridge drop-down menu and selecting per Cartridge. To 
normalize all cartridges to a single reference capillary within the run, click the Cartridge drop-down menu and select the 
cartridge number.

We recommend choosing the capillary that had the highest sample concentration. The default reference capillary is 2.

To manually assign a reference signal for normalization: Select the Control Area box and enter a signal value. This 
setting is helpful when you want to use the average signal from more than one capillary for normalization.
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To change the sizing region that the normalization total area is determined: Enter new kDa values in the Area Start and 
Area End boxes.

To change the baseline type for normalization: Select the Type in the drop-down menu.

To change the region of points from which the baseline is being determined: Enter new pixel values in the Start (Pixel) 
and End (Pixel). This only applies to the Relative to Std 1 and Relative to Std 1 (Lower Points) baseline types.

•	 Relative to Std 1 - Uses the region defined by Start (Pixel) and End (Pixel) as it relates to the pixel position of the left-
most fluorescent standard (position 0).

•	 Relative to Std 1 (Lower Points) - Uses the region defined by Start (Pixel) and End (Pixel) as it relates to the pixel 
position of the left-most fluorescent standard (position 0). Within this region, greater weighting is given to pixel 
positions exhibiting lower signal.

•	 Full Range - Uses the region defined by the entire length of the capillary.

•	 Full Range (Lower Points) - Uses the region defined by the entire length of the capillary. Within this region, greater 
weighting is given to pixel positions exhibiting lower signal.

Click Apply and then click OK to save changes and exit. Updated sample data using the new normalization settings will 
display in the Analysis screen.
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Peak Names Settings
The peak names analysis settings page lets you enter custom naming settings for sample proteins. Compass for Simple 
Western can automatically label sample peaks in the run data associated with specific blocking reagent names, primary 
antibody names, secondary antibody names, attributes, probes (RePlex assays only), and cartridges (Leo only). To access 
these settings, select Edit in the main menu and click Analysis, then click Peak Names in the options list.

NOTES:  
Settings can be modified in an assay prior to starting a run, or in a run file once the run has finished executing. 
Analysis changes made to an executing run will not be saved to the final run file. 
 
Analysis settings are run-file specific. However, settings can be imported or exported for use with other run files. 
For more information see “Importing and Exporting Analysis Settings” on page 337.

•	 Click Import to import an analysis settings file. This is explained in more detail in “Importing Analysis Settings” on 
page 337.

•	 Click Export to export the current analysis settings file. This is explained in more detail in “Exporting Analysis Settings” 
on page 337.

•	 Click Apply to see effect of changes before saving. 
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•	 Click OK to save changes and exit.

•	 Click Cancel to exit without saving changes.

Peak Names Analysis Groups
Peak name settings are saved as a group, and multiple settings groups can be created. Specific group settings can 
then be applied to individual capillaries, blocking reagent names, primary antibody names, secondary antibody names, 
attributes, probes (RePlex assays only), and cartridges (Leo only) in the run data.

Peak name groups are displayed in the Analysis Groups box:

The Peak Names group shown is a Compass for Simple Western template group. You can make changes to this group and 
create new groups.

To view settings for a group, click on the group name in the Analysis Groups box.

Creating a Peak Names Group
1.	 Select Edit in the main menu and click Analysis, then click Peak Names in the options list.

2.	 Click on the Protein template group in the Analysis Groups box.

3.	 Enter a new name for the group.

4.	 Click in the first cell in the Name column in the Analysis Groups peak table.
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5.	 Enter a sample protein name associated with the primary antibody used in the run.

6.	 Click in the first cell in the MW column.

7.	 Enter the molecular weight (in kDa) for the sample protein.

8.	 Click in the first cell in the Color column, then click the button.

The color selection box will display:

The color selected will be used to identify the sample protein peak in the Peaks and Capillaries table in the Analysis 
screen.
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9.	 Click a color or define a custom color and click OK. The color selection will update in the table:

10.	Click in the first cell in the Range (%) column.

11.	 Enter a range window for the MW entered. Compass for Simple Western will automatically name peaks found within this 
percent of the molecular weight entered in the table. For example, if the molecular weight entered is 40 kDa and a 10% 
range is used, all peaks between 36 and 44 kDa will be identified with this peak name.

NOTE: The reported molecular weight for sample proteins detected by an Immunoassay or a Total Protein Assay 
in Compass for Simple Western may vary from apparent molecular weights using other techniques and based on 
sample and assay conditions.1,2

12.	For assays with more than one detection channel: Click in the Channel cell and select a channel from the drop-down 
menu.

Adding Peak Names Groups
1.	 Select Edit in the main menu and click Analysis, then click Peak Names in the options list.

2.	 Click Add under the Analysis Groups box. A new group will be created:

1 Electrophoresis. 2021 Aug;42(14-15):1521-1531. doi: 10.1002/elps.202100068. 
2Electrophoresis. 2021 Feb;42(3):206-218. doi: 10.1002/elps.202000199. 
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3.	 Click on the new group and enter a new name.

4.	 Enter information in the Analysis Groups peak table as described in “Creating a Peak Names Group” on page 294.

5.	 Click Apply and then click OK to save changes.

Modifying a Peak Names Group
1.	 Select Edit in the main menu and click Analysis, then click Peak Names in the options list.

2.	 Click on the group in the Analysis Groups box you want to modify.

3.	 Change the information in the Analysis Groups peak table as described in “Creating a New Peak Fit Group” on 
page 319.

4.	 Click Apply and then click OK to save changes.

Deleting a Peak Names Group
1.	 Select Edit in the main menu and click Analysis, then click Peak Names in the options list.

2.	 Click on the group in the Analysis Groups box you want to delete and click Remove.

3.	 Click Apply and then click OK to save changes.

Applying Peak Names Groups to Run Data
1.	 Select Edit in the main menu and click Analysis, then click Peak Names in the options list.
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2.	 Click on the group in the Analysis Groups box you want to apply to specific run data.

3.	 Application of peak names groups to specific run data is done in the Apply Settings box. Click Add under the Apply 
Settings box. The settings will be applied to the data. 

4.	 Click the cell in the Apply To column, then click the down arrow.

5.	 Select an option from the drop-down list. This will apply the settings group selected to specific run data as follows:

•	 All - When this option is selected, peak names group settings will be applied to all capillaries in the run file.

•	 Antibody names - All primary and secondary antibody names entered in the assay template (Assay screen) will 
display in the drop-down list, otherwise the default name of Primary and Secondary will be shown. Select a name to 
apply group settings to all capillaries that use the primary antibody name in the run file.
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•	 Attributes - All primary and secondary antibody attributes entered in the assay template (Assay screen) will display 
in the drop-down list. Select an attribute to apply group settings to all capillaries that use this attribute in the run file.

•	 Probe (RePlex Assays only) - Select a probe to apply group settings to all capillaries within that probe.

•	 Cartridge (Leo only) - Applies group settings to a specific cartridge. 

•	 Custom settings - Lets you choose specific cartridges and capillaries to apply the group settings to. When this 
option is selected, the following pop-up box appears to let you enter a specific capillary number or range of 
capillaries for a specific probe and/or cartridge depending on the assay type:

6.	 If you need to change the peak names group used for a data set, click the cell in the Settings column and click the 
down arrow. Select a group from the drop-down list.

7.	 Repeat the previous steps to apply other groups to specific run data.

8.	 To remove a data set, click on its cell in the Apply To column, then click Remove.
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9.	 Click Apply and then click OK to save changes. Named peaks will be identified with a peak name label in the 
electropherogram and virtual blot, and will be color coded in the Peaks and Capillaries tables:

Standard Curve Settings
To use a standard curve to quantitate the concentration of a target protein detected, first create peak names groups as 
described in “Creating a Peak Names Group” on page 294 for your standard curve protein and the target protein. In the 
example below, NucA is the standard curve protein and the target protein.
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NOTE: Analysis settings are run file-specific. However, settings can be imported or exported for use with other run 
files. For more information see “Importing and Exporting Analysis Settings” on page 337.

To set up a standard curve:

1.	 Select Edit in the main menu and click Analysis. 

2.	 Click Standard Curves from the Peak Name submenu in the options list. 

3.	 Click Add under Standard Curves. “Curve 1” will appear with default standard curve settings. Double-click on “Curve 1” 
to edit the name.

4.	 From the Peak Group drop-down list, select a Peak Group. 
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5.	 From the Peak drop-down list, select the peak name for your standard curve protein.

6.	 Choose either a Linear, 4 Parameter (4PL), or Log-Log curve fit from the Fit drop-down list.

7.	 Select a weighting factor from the drop-down list. Weighting factors are used to calculate a weighted least square 
calibration curve, which can be used to determine the %-error for each experimental value. Refer to “Standard Curve 
Fits and Weighting Factors” on page 305 for more information. 

8.	 In the Std column, click the checkboxes for the capillaries with standard curve samples. 
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9.	 In the Conc. column, enter the sample concentrations. In the following, twelve concentrations were entered. 

NOTE: If concentrations are entered in the Assay template, the Conc. column will automatically be filled with the 
Sample name or Sample attribute values in the template. If no number is available in the Sample name or Sample 
attribute, 1.0 will be entered by default. 

To remove a concentration, uncheck the box in the Std. column. 

10.	Enter the concentration units in the Units box (for example, pg/μL)

11.	 Click OK to save changes.

When running standard curves, capillaries with standard curve samples can be selected from a single cartridge or across 
multiple cartridges (Leo only). 

1.	 Set up a standard curve as described in “Standard Curve Settings” on page 300.
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2.	 In the Standards from drop-down list, select the cartridge to use for the standard curve or Across Cartridges. 

 

NOTE: We recommend enabling Cartridge Corrections when a standard curve is performed on Leo, especially if 
standard curve samples are all run on a single cartridge and will be used to calculate concentrations on multiple 
cartridges. See “Cartridge Corrections (Leo only)” on page 311 for more information. 
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Standard Curve Fits and Weighting Factors
Compass for Simple Western provides three different types of standard curve fits: Linear, 4 Parameter Logistic (4PL), and 
Log-Log. The equations applied are:

The linear curve is calculated using:

y = mX + c

where:

y = The peak area value

X = The concentration value

m = The slope of the fitted line

c = The intercept of the y-axis

The weighting factors associated with linear fits are calculated using:

For 1/y weighting factor: w=1/max(abs(y), ε)

For 1/y2 weighting factor: w=1/max(y2, ε)

where:

ε = 10. 
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The 4PL curve is calculated using:

where:

y = The peak area value

Min = The minimum peak area value that can be obtained 

Max = The maximum peak area value that can be obtained 

EC50 = The concentration at the midpoint of the curve 

HillSlope = The slope at the midpoint of the curve

The weighting factors associated with 4PL fit are calculated using:

For 1/y weighting factor: w=1/max(abs(y), ε)

For 1/y2 weighting factor: w=1/max(y2, ε)

where:

ε = 10. 
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The Log-Log curve is calculated using:

Log(Y)=m*Log(X)+c

where:

Y = The peak area value

X = The concentration value

m = The slope of the fitted line

c = The intercept of the y-axis

The weighting factors associated with log-log fit are calculated using:

For 1/y weighting factor: w=1/log(max(abs(Y), ε) 

For 1/y2 weighting factor: w=1/log(max(y2, ε)

where:

ε = 10. 
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Modifying Peak Names Groups Used for Standard Curves Settings
1.	 Select Edit in the main menu and click Analysis, then click Peak Names in the options list.

2.	 Click on the group in the Apply Settings box you want to apply to specific run data.

3.	 Click the cell in the Apply To column, then click the down arrow.

4.	 Select an option from the drop-down list. This will apply the settings group selected to specific run data as follows:

a.	 All - When this option is selected, peak names group settings will be applied to all capillaries in the run file.

b.	 Blocking reagent - When this option is selected, group settings will be applied to all capillaries that use this reagent 
name in the run file.

c.	 Primary antibody names - All primary antibody names entered in the assay template (Assay screen) will display in 
the drop-down list, otherwise the default name of Primary will be shown. Select a name to apply group settings to 
all capillaries that use the primary antibody name in the run file.

d.	 Primary antibody attributes - All primary antibody attributes entered in the assay template (Assay screen) will 
display in the drop-down list. Select an attribute to apply group settings to all capillaries that use this attribute in the 
run file.

e.	 Secondary antibody names - All secondary antibody names entered in the assay template (Assay screen) will 
display in the drop-down list, otherwise the default name of Secondary will be shown. Select a name to apply group 
settings to all capillaries that use the secondary antibody name in the run file.

f.	 Secondary antibody attributes - All secondary antibody attributes entered in the assay template (Assay screen) 
will display in the drop-down list. Select an attribute to apply group settings to all capillaries that use this attribute in 
the run file.
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g.	 Probe (RePlex Assays only) - Select a probe to apply group settings to all capillaries within that probe.

h.	 Cartridge (Leo only) - Applies group settings to a specific cartridge. 

i.	 Custom settings - Lets you choose specific capillaries to apply the group settings to. When this option is selected, 
the following pop-up box appears to let you enter a specific capillary number or range of capillaries for a specific 
Probe and/or cartridge:

5.	 If you need to change the peak names group used for a data set, click the cell in the Group column and click the down 
arrow. Select a group from the drop-down list.

6.	 Repeat the previous steps to apply other groups to specific run data.

7.	 To remove a data set, click on its cell in the Apply To column, then click Remove.
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8.	 Click Apply and then click OK to save changes. The curve fit will be visible on the Std Curve tab and the concentration 
of the proteins will appear in the Peaks table:

S TA N DA R D C U RV E W I T H N O N O R M A L I Z AT I O N ( TOTA L P R OT E I N O R LOA D I N G C O N T R O L ) O R CA R T R I D G E 
C O R R E C T I O N A P P L I E D

S TA N DA R D C U RV E W I T H N O R M A L I Z AT I O N ( TOTA L P R OT E I N O R LOA D I N G C O N T R O L ) O R CA R T R I D G E 
C O R R E C T I O N A P P L I E D
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Cartridge Corrections (Leo only)
The Cartridge Corrections settings in the Analysis window lets you view and change the reference cartridge and peak 
for cartridge correction calculations. Cartridge normalization settings are applied when enabling Cartridge Corrections. 
Cartridge Corrections is only applied to the named peak chosen under Peak in Cartridge Corrections analysis settings. 
To access these settings, select Edit in the main menu and click Analysis, then click Cartridge Corrections under Peak 
Names in the options list.

NOTES:  
You will need to set up a Peak Names Analysis Group to set up Cartridge Corrections. See “Peak Names Analysis 
Groups” on page 294.  
 
Only one type of normalization is allowed per analysis. Normalization using Total Protein with RePlex assays and 
Loading Controls cannot be used if Cartridge Corrections is set up. 

•	 Click Import to import an analysis settings file. This is explained in more detail in “Importing Analysis Settings” on 
page 337.

•	 Click Export to export the current analysis settings file. This is explained in more detail in “Exporting Analysis Settings” 
on page 337.

•	 Click Apply to see effect of changes before saving. 
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•	 Click OK to save changes and exit.

•	 Click Cancel to exit without saving changes.

To use Cartridge Corrections to normalize data:

1.	 Select Edit in the main menu and click Analysis.

2.	 Click Peak Names in the options list and select Cartridge Corrections. 

3.	 Click Add under Cartridge Corrections.
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4.	 “Correction 1” will appear along with default Cartridge Corrections settings. Optional: Click on the “Correction1” to 
enter a new name. 

5.	 Adjust the settings as needed.

•	 Peak Group – Lets you select the Peak Names Analysis Group. 

•	 Peak – Lets you select the named peak to use for the cartridge correction calculations. 

•	 Corr. Cart – Lets you select the reference cartridge. The reference signal can be from a specific cartridge or the 
average signal from all cartridges. 

•	 Corr. Cap –  Selecting the Same Positions for Cartridges checkbox enables the automatic selection of the reference 
capillary between cartridges to use for cartridge correction calculations. For example, capillary 1 in cartridges 
2–4 will automatically be selected when capillary 1 in cartridge 1 is selected. When the box is unchecked, unique 
capillary numbers can be used as the reference capillary for each cartridge. 

6.	 Click Apply and then click OK to save changes and exit. Updated sample data using the cartridge correction settings 
will display in the Analysis screen. 

NOTE: Normalization when using Cartridge Corrections is only applied to the peak selected in the Cartridge 
Corrections analysis settings. The normalization will not be applied to other named peaks or peaks identified in the 
samples. 
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Loading Controls Settings
It is possible to use loading control protein to normalize data between capillaries, between runs and between instruments. 
First create peak names groups as described in “Creating a Peak Names Group” on page 294 for your control protein and 
the target protein in the same peak analysis group. In the example below, System Control is the control protein and ERK1 is 
the target protein.

NOTES:  
Analysis settings are run file-specific. However, settings can be imported or exported for use with other run files. 
For more information see “Importing and Exporting Analysis Settings” on page 337. 
 
Only one type of normalization is allowed per analysis. Normalization and Cartridge Correction cannot be used if a 
Loading Control is set up. 

To identify the control protein:

1.	 Select Edit in the main menu and click Analysis. 

2.	 Click Peak Names in the options list and select Loading Controls.
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3.	 Select the desired peak name group using the Peak Names Group drop-down menu. All peak names in that group will 
be listed.

4.	 Select the checkbox in the Control column next to the peak name to use as the loading control.

5.	 Select a Reference Capillary from the drop-down menu(s). The peak area of this capillary will be used to normalize the 
peak area of the named peaks. For RePlex assays, the user can specify which probe to use as the reference, Probe 1 or 
Probe 2. All named peaks in both Probe 1 and Probe 2 will be normalized to the reference. For Leo runs, specify which 
cartridge to use as the reference.

6.	 To manually assign the Control Area, click the box and enter the peak area of your control protein.

7.	 Click Apply and then click OK to save changes. Compass for Simple Western will automatically normalize the peak area 
of the target protein against the control protein. The corrected area appears in the Corr. Area column in the Peaks table 
and in the Capillaries table:
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Peak Fit Analysis Settings
The peak fit analysis settings page lets you view and change peak fit settings for sample data. To access these settings, 
select Edit in the main menu and click Analysis, then click Peak Fit in the options list.

NOTES:  
Settings can be modified in an assay prior to starting a run, or in a run file once the run has finished executing. 
Analysis changes made to an executing run will not be saved to the final run file. 
 
We recommend using the Compass for Simple Western default values for peak fit analysis settings. These settings 
are included in the default Peak Fit group.  
 
Analysis settings are run-file specific. However, settings can be imported or exported for use with other run files. 
For more information see “Importing and Exporting Analysis Settings” on page 337.

•	 Click Import to import an analysis settings file. This is explained in more detail in “Importing Analysis Settings” on 
page 337.

•	 Click Export to export the current analysis settings file. This is explained in more detail in “Exporting Analysis Settings” 
on page 337.

•	 Click Apply to see effect of changes before saving. 

•	 Click OK to save changes and exit.

•	 Click Cancel to exit without saving changes.
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Range Settings
•	 Minimum - The molecular weight value (in kDa) below which peaks will not be identified. This value will also be used as 

the default lower MW range for the data displayed in the electropherogram and virtual blot.

•	 Maximum - The molecular weight value (in kDa) above which peaks will not be identified. This value will also be used 
as the default upper MW range for the data displayed in the electropherogram and virtual blot.

•	 View - Changes the molecular weight range used for the x-axis.

•	 Analysis matches the range of the run data that was selected in the Range Analysis Settings in both the 
electropherogram and virtual blot view. This is the default setting.

•	 Full will display the range of the run data for the entire capillary in both the electropherogram and virtual blot view.

Baseline Settings
•	 Type - Changes the type of baseline fit used for the run data. 

NOTE: Baseline Type selection is only available when Dropped Lines and Dropped Lines (manual) is used for the 
Area Calculation

•	 Threshold - The variance, or roughness, in a baseline data segment below which a point will be called part of the 
baseline.

•	 Window - How long baseline data segments are expected to be in pixels. Shorter segments will allow the baseline to 
follow plateau sections of the signal.

•	 Stiffness - The amount the baseline is allowed to vary from a straight line. Settings between 0.1 and 1.0 make the 
baseline fit closer to a straight line. Settings from 1.0 to 10.0 will make the baseline fit follow the data more closely.

Peak Find Settings
•	 Threshold - The minimum signal to noise ratio required for a peak to be identified. A setting of 1.0 will detect many 

peaks, a setting of 10.0 will detect fewer peaks.

•	 Width - The approximate peak width (at full width half max) in pixels used to detect peaks. The minimum value for this 
setting is 3.0. Larger widths help to eliminate the detection of shoulder peaks and noise peaks.
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•	 Area Calculation - Three fits are provided: Gaussian Fit, Dropped Lines, or Dropped Lines (manual). These settings can 
be changed before or after the run is finished.

•	 For Immunoassays, peak area is calculated using Gaussian distribution by default. Dropped Lines (manual) allows 
for manually adjusting the start and stop positions of peak boundaries. This type of area calculation is also often 
called the perpendicular drop method. This is the preferred method when peaks overlap or are close to each other. 
It draws two vertical lines from the left and right bounds of the peak down to the x-axis and then measures the total 
area bounded by the signal curve, the x-axis (y=0 line), and the two vertical lines. Adjustments can then be made to 
manually set the start and stop positions of the peak boundaries.

This next view is of the same data using Dropped Lines (manual) instead:

Peak Fit Analysis Settings Groups
Peak fit settings are saved as a group, and multiple settings groups can be created. Specific group settings can then be 
applied to individual capillaries, sample names, attributes, probes (RePlex assays only), and cartridges (Leo only) in the 
run data.
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Peak fit groups are displayed in the analysis settings box:

The Peak Fit group shown contains the Compass for Simple Western default analysis settings. You can make changes to 
this group and create new groups.

To view settings for a group, click on the group name in the analysis settings box.

Creating a New Peak Fit Group
1.	 Select Edit in the main menu and click Analysis, then click Peak Fit in the options list.

2.	 Click Add under the Analysis Groups box. A new group will be created:

3.	 Click on the new group and enter a new name.

4.	 Modify range, baseline or peak find parameters as needed.
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5.	 To use the new group as the default peak fit settings for the run file data, click the arrow in the drop-down list below 
Apply Default, then click the new group from the list. Peak fit settings in the new group will then be applied to the run 
data.

6.	 Click Apply and then click OK to save changes.

Changing the Default Peak Fit Group
1.	 Select Edit in the main menu and click Analysis, then click Peak Fit in the options list.

2.	 Click the arrow in the drop-down list below Apply Default, then click a new default group from the list.

3.	 Click Apply and then click OK to save changes. Peak fit settings in the group selected will be applied to the run data.

Modifying a Peak Fit Group
1.	 Select Edit in the main menu and click Analysis, then click Peak Fit in the options list.

2.	 Click on the group in the Analysis Groups box you want to modify. 
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3.	 Modify range, baseline or peak find parameters as needed.

4.	 Click Apply and then click OK to save changes. The new peak fit settings will be applied to the run data.

Deleting a Peak Fit Group
1.	 Select Edit in the main menu and click Analysis, then click Peak Fit in the options list.

2.	 Click on the group in the Analysis Groups box you want to delete and click Remove.

3.	 Click OK to save changes.

Applying Peak Fit Groups to Specific Run Data
1.	 Select Edit in the main menu and click Analysis, then click Peak Fit in the options list.

2.	 Click on the group in the Analysis Groups box you want to apply to specific run data.

3.	 Application of peak fit groups to specific run data is done in the Apply Override box. Click Add under the override box. 
A default override data set will be created from sample information found in the run file.
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4.	 Click the cell in the Apply To column, then click the down arrow.

5.	 Select an option from the drop-down list. This will apply the settings group selected to specific run data as follows:

•	 Sample names - All sample names entered in the assay template (Assay screen) will display in the drop-down list, 
otherwise the default name of Sample will be shown. Select a sample name to apply group settings to all capillaries 
that use this sample name in the run file.

•	 Attributes - All sample attributes entered in the assay template (Assay screen) will display in the drop-down list. 
Select an attribute to apply group settings to all capillaries that use this attribute in the run file.

•	 Probe 1 and 2 (RePlex Assays only) - Select a probe to apply Peak Fit group settings to all capillaries within that 
probe.

•	 Cartridge (Leo only) - Applies group settings to a specific cartridge. 

•	 Custom settings - Lets you choose specific capillaries to apply the group settings to. When this option is selected, 
the following pop-up box appears to let you enter a specific capillary number or range of capillaries for a specific 
Probe and/or cartridge:

6.	 If you need to change the peak fit group used for a data set, click the cell in the Group column and click the down 
arrow. Select a group from the drop-down list.
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7.	 Repeat the previous steps to apply other groups to specific run data.

8.	 To remove a data set, click on its cell in the Apply To column, then click Remove.

9.	 Click Apply and then click OK to save changes.

Manual Peak Integration
Compass for Simple Western lets you manually integrate peaks in individual electropherograms.

1.	 Select Edit in the main menu, click Analysis, and select Peak Fit in the options list.

2.	 Select Dropped Lines (manual) as the area calculation if it isn’t already selected.

3.	 Click OK to save changes. 

4.	 In the Analysis screen, select Fitted Peaks in the Graph Options.

5.	 Select a capillary in the Experiment pane.
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6.	 Hover the mouse over the peak you want to adjust. Two magenta bars will display that indicate the start and stop points 
of its integration.

7.	 To change the integration, hover the mouse over either of the magenta bars. Then click the mouse and drag the bar to 
move it.

•	 If the cursor changes to  this is the peak start for the peak on the right.

•	 If the cursor changes to  this is the peak end for the peak on the left.
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•	 If the cursor changes to  this is a joint boundary for the peaks on the left and right.

In the example below, we moved the start and end points of the peak to include more area under the peak:

You can also combine peaks by dragging the magenta lines left or right:

You can also separate areas between peaks. Whenever you have a  cursor between two peaks that aren’t baseline 
resolved, move the mouse slightly to the right or left until you get the  or  cursor.

Click and hold the mouse. A black drop line will display indicating where the current peak start or end point is. While 
holding the mouse, drag the cursor to the right or left to move the start or end point to where you want it, then release 
the mouse.
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8.	 To remove the manual integration settings, right-click on the graph or on the sample in the Experiment pane and select 
Clear.

Signal to Noise Settings
The signal to noise settings page lets you view and change the method used for the signal to noise calculation in the 
sample data. To access these settings, select Edit in the main menu and click Analysis, then click Signal to Noise in the 
options list.

NOTE: Settings can be modified in an assay prior to starting a run, or in a run file once the run has finished 
executing. Analysis changes made to an executing run will not be saved to the final run file.
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•	 Click Import to import an analysis settings file. This is explained in more detail in “Importing Analysis Settings” on 
page 337.

•	 Click Export to export the current analysis settings file. This is explained in more detail in “Exporting Analysis Settings” 
on page 337.

•	 Click Apply to see effect of changes before saving. 

•	 Click OK to save changes and exit.

•	 Click Cancel to exit without saving changes.

S/N Compass v5.0
S/N Compass v5.0 is a method that calculates peak score based on a peak finding algorithm to provide a relative ratio 
comparing all peaks within the electropherogram in Compass. S/N Compass v5.0 was referred to as ‘Peak Score (v1-v5)’ in 
Compass for Simple Western versions 6.0. With some run data, Peak Score can result in negative signal to noise values. If 
this happens, using the Signal-to-Noise Ratio instead will correct this.

Signal-to-Noise Ratio
The calculation used for the Signal-to-Noise Ratio follows USP/NF (United States Pharmacopeia/National Formulary) 
regulations with the difference on how noise is determined. This is the default selection for run data generated using Jess 
and Abby assays in Compass for Simple Western version 6.0 and higher and Leo assays in Compass for Simple Western 
version 7.0 and higher.

When this option is selected, you can set the following parameters to select the region of data used to identify the best 
noise sampling:

•	 Full - Selects the entire data range of the run data within the capillary along the x axis (in kDa) for the noise region. The 
default range used will be the size range for the run data: 2-40, 12-230, or 66-440 kDa. This is the default setting for 
the Noise Region and is recommended for most use cases.

•	 Custom - Lets you set the data range along the x axis (in kDa) to narrow the search region used for the signal to noise 
calculation. To use this option, enter a Start and End value in kDa.
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NOTE: There are no custom range recommendations from ProteinSimple. The start and end value entry depends on 
the user application and noise variation in the run data.

When Signal-to-Noise Ratio is selected, the software can overlay the noise region on the electropherogram in the Graph 
pane. To display the overlay, select Noise Region from the Graph Options menu:
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The noise region is indicated by the two red dots on the electropherogram. To zoom in on the noise region: select that area 
with your mouse:

Next, select Auto Scale. This makes it easier to see the noise fit region, as well as the points used in the overall noise 
calculations:

The red line represents the quietest noise fit region within the bounded area. The two points are the greatest difference in 
noise between the real and fit data within the quietest region.
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To find the noise fit region, Compass for Simple Western utilizes a rolling window over the bounded area based on the 
Start and End values. Beginning at the Start value, the software fits a curve using polynomial regression to a window of 
real data and calculates the maximum difference between the real data and the fit data above and below the curve. It then 
searches for the quietest region via multiple searches within the bounded area and chooses the region with the minimum 
noise.

Noise is found by taking the distance between the actual data points and the fit curve and adding those values. In the 
following data, those values have been marked (1, 2), and the distance between the real point and the fit curve is shown as 
the straight blue line:

The noise for this noise fit window is the Length of Blue line 1 + Length of Blue Line 2. This process continues until the 
window reaches the End value.

h = Length of Blue line 1 + Length of Blue line 2

This is the highest noise within the determined region of minimum noise. The signal to noise ratio given the peak height is 
then calculated using:

2.0 * Peak Height/h

This calculation is done for each peak, and is represented as the S/N value in the Peaks table:

NOTE: Per USP standards, ‘h’ is derived from the noise region around the peak of interest and is used in the S/N 
ratio calculation for that individual peak. Compass for Simple Western calculates ‘h’ in the quietest noise fit region 
in the boundary area (not around the individual peak of interest). This value is used to calculate the S/N ratio across 
the capillary for all peaks, where the only value that changes for individual peaks is the Peak Height.
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Advanced Analysis Settings
The advanced analysis settings page lets you view and change analysis settings for samples, standards and image data. 
To access these settings, select Edit in the main menu and click Analysis, then click Advanced in the options list.

NOTE: Settings can be modified in an assay prior to starting a run, or in a run file once the run has finished 
executing. Analysis changes made to an executing run will not be saved to the final run file.

•	 Click Import to import an analysis settings file. This is explained in more detail in “Importing Analysis Settings” on 
page 337.

•	 Click Export to export the current analysis settings file. This is explained in more detail in “Exporting Analysis Settings” 
on page 337.

•	 Click Apply to see effect of changes before saving. 

•	 Click OK to save changes and exit.

•	 Click Cancel to exit without saving changes.
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Standards Settings
•	 Peak Width - The approximate width (at full width half max) used to filter out fluorescence artifacts which improves 

recognition of standards. The default value is 15.

•	 Allowable Drift - The distance in pixels that standards are expected to move compared to their entered positions in the 
standards analysis page. This setting assists in recognition of standards. The default value is 100.

Sample Settings
•	 Peak Fit Starting Width Ratio - Focuses the peak fit towards the peak center and aids the overall peak fitting. The 

default value is 0.5.

Image Settings
•	 Median Filter Threshold Ratio - Pixel ratio used to filter out camera artifacts. The default value is 0.5.

•	 Median Filter Threshold Limit - Pixel threshold value used to filter out camera artifacts. The default value is 1000.

Advanced Analysis Settings Groups
Advanced analysis settings are saved as a group, and multiple settings groups can be created. Specific group settings can 
then be applied to individual capillaries, sample names or attributes in the run data.

NOTES: 
We recommend using the Compass for Simple Western default values for advanced analysis settings. These 
settings are included in the default Advanced group. 
 
Analysis settings are run-file specific. However, settings can be imported or exported for use with other run files. 
For more information see “Importing and Exporting Analysis Settings” on page 337.

Analysis groups are displayed in the analysis settings box:
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The Advanced group shown contains the Compass for Simple Western default analysis settings. You can make changes to 
this group and create new groups.

To view settings for a group, click on the group name in the analysis settings box.

Creating a New Analysis Group
1.	 Select Edit in the main menu and click Analysis, then click Advanced in the options list.

2.	 Click Add under the Analysis Groups box. A new group will be created:

3.	 Click on the new group and enter a new name.

4.	 Modify standards, sample or image parameters as needed.

5.	 To use the new group as the default analysis settings for the run file data, click the arrow in the drop-down list below 
Apply Default, then click the new group from the list. Analysis settings in the new group will then be applied to the run 
data.

6.	 Click OK to save changes.
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Changing the Default Analysis Group
1.	 Select Edit in the main menu and click Analysis, then click Advanced in the options list.

2.	 Click the arrow in the drop-down list below Apply Default, then click a new default group from the list.

3.	 Click OK to save changes. Analysis settings in the group selected will be applied to the run data.

Modifying an Analysis Group
1.	 Select Edit in the main menu and click Analysis, then click Advanced in the options list.

2.	 Click on the group in the Analysis Groups box you want to modify.

3.	 Modify standards, sample or image parameters as needed.

4.	 Click OK to save changes. The new analysis settings will be applied to the run data.

Deleting an Analysis Group
1.	 Select Edit in the main menu and click Analysis, then click Advanced in the options list.

2.	 Click on the group in the Analysis Groups box you want to delete and click Remove.

3.	 Click OK to save changes.
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Applying Analysis Groups to Specific Run Data
1.	 Select Edit in the main menu and click Analysis, then click Advanced in the options list.

2.	 Click on the group in the Analysis Groups box you want to apply to specific run data.

3.	 Application of analysis groups to specific run data is done in the Apply Override box. Click Add under the override box. 
A default override data set will be created from sample information found in the run file.

4.	 Click the cell in the Apply To column, then click the down arrow.

5.	 Select an option from the drop-down list. This will apply the settings group selected to specific run data as follows:

•	 Sample names - All sample names entered in the assay template (Assay screen) will display in the drop-down list, 
otherwise the default name of Sample will be shown. Select a sample name to apply group settings to all capillaries 
that use this sample name in the run file.

•	 Attributes - All sample attributes entered in the assay template (Assay screen) will display in the drop-down list. 
Select an attribute to apply group settings to all capillaries that use this attribute in the run file.

•	 Probe 1 and 2 (RePlex Assays only) - Applies group settings to all capillaries within that probe.
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•	 Cartridge (Leo only) - Applies group settings to a specific cartridge. 

•	 Custom settings - Lets you choose specific cartridges and capillaries to apply the group settings to. When this 
option is selected, the following pop-up box appears to let you enter a specific capillary number or range of 
capillaries for a specific Probe and/or cartridge:

6.	 If you need to change the analysis group used for a data set, click the cell in the Group column and click the down 
arrow. Select a group from the drop-down list.

7.	 Repeat the previous steps to apply other groups to specific run data.

8.	 To remove a data set, click on its cell in the Apply To column, then click Remove.

9.	 Click OK to save changes.

10.	Click Apply and then click OK to save changes.
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Importing and Exporting Analysis Settings
The analysis settings in a run file can be exported as a separate file. This allows the same analysis settings to be imported 
into other assays or run files at a later time, rather than having to re-enter settings manually.

Importing Analysis Settings

NOTE: Importing an analysis settings file populates the settings in all Analysis pages.

1.	 Open the run file or assay you want to import analysis settings to.

2.	 Select Edit in the main menu and click Default Analysis (Assay screen) or Analysis (Analysis screen).

3.	 Click Import on any page.

4.	 Select a settings file (*.settings) and click OK. The imported settings will display in all analysis pages.

Exporting Analysis Settings

NOTE: Exporting an analysis settings file exports the settings in all Analysis pages.

1.	 Open the run file or assay you want to export analysis settings from.

2.	 Select Edit in the main menu and click Default Analysis (Assay screen) or screen).
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3.	 Click Export on any page. The following window displays:

4.	 The default directory is Compass/Assays. Change the directory if needed.

5.	 Enter a file name and click Save. The settings will be saved as a *.settings file.
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Chapter Overview
•	 Custom Preference Options

•	 Setting Data Export Options

•	 Selecting Custom Plot Colors for Graph Overlay
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Custom Preference Options
You can set and save custom preferences for access control, data export, and plot colors in the Graph pane. To access 
these settings, select Edit in the main menu and click Preferences.

NOTE: In Compass for Simple Western version 5.0 and higher, you can no longer change or save Custom 
Preferences outside of the first instance of the software that’s been opened. When running multiple instances of the 
software on the same computer, an error message displays if you try to change Custom Preferences in any instance 
except the first instance opened.

To move between preferences pages in this window, click on any option in the list on the left. The following items can be 
user-customized in Compass for Simple Western:

•	 Access Control - This feature can be used to help satisfy the 21CFR Part 11 data security requirements. See “Enabling 
Access Control” on page 356 for more information.

•	 Analysis Export - Lets you customize data export options.

•	 Graph - Lets you customize electropherogram color displays in the Graph pane.
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Setting Data Export Options
Select Edit in the main menu and click Preferences, then choose Analysis Export in the options list.

•	 Export Standards - Selecting this option includes data for the standards in each sample when run data is exported. 
When this option is deselected, only sample data will be exported. This option is selected by default.

•	 Export using a comma as the column delimiter - Selecting this option exports run data in .csv format. When this 
option is deselected, the data is exported in .txt format.

•	 Empower - This option exports uncalibrated run data in a format that is compatible for further analysis in Empower™ 
Software (Waters™) and other analysis programs that use standard formats.

•	 Chromeleon™ - This option exports uncalibrated run data in a format that is compatible for further analysis in 
Chromeleon Chromatography Data System (CDS) Software (Thermo Scientific™) and other analysis programs that 
use standard formats.

•	 Click Apply to apply changes to any open run files in Compass for Simple Western.

•	 Click Restore Defaults to restore Compass for Simple Western default settings.

•	 Click OK to save changes and exit.

•	 Click Cancel to exit without saving changes.
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Selecting Custom Plot Colors for Graph Overlay
Select Edit in the main menu and click Preferences, then choose Graph in the options list.

•	 Apply colors to stacked plots - Selecting this option applies the color scheme to individual electropherograms when 
the Stack the Plots option is selected in the Analysis screen Graph pane.

•	 When this option is deselected, plots will use Compass for Simple Western default colors.

NOTE: If Apply colors to stack plots is not checked, the colors shown in the preferences screen will be applied only 
to overlaid electropherograms when the Overlay the Plot option is selected in the Graph pane.

•	 Click Apply to apply changes to any open run files in Compass for Simple Western.

•	 Click Restore Defaults to restore Compass for Simple Western default settings.

•	 Click OK to save changes and exit.

•	 Click Cancel to exit without saving changes.

Changing Plot Colors
1.	 Select Edit in the main menu and click Preferences, then choose Graph in the preferences list.
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2.	 Click the color button next to a plot number. The color selection box displays:

3.	 Select a color or define a custom color and click OK. The color button will update to the new color selected.

4.	 Repeat the steps above for any other plot colors.

5.	 Check Apply Colors to Stacked Plots if you want the new color scheme to also be used for the Stack the Plots option 
in the Graph pane.

6.	 Click Apply to apply changes to plots currently displayed in the Graph pane.

7.	 Click OK to save changes and exit. When the Overlay the Plots option is selected in the graph pane, the new color 
scheme will be used.
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Overview
The Compass Access Control feature can be used to help support the 21CFR Part 11 data security requirements when 
using Simple Western instruments. When Access Control is enabled and the Compass Authorization Server for Simple 
Western has been installed:

•	 Users are required to log in to Compass for Simple Western when the software is launched

•	 A history of all actions is maintained

•	 Data files are signed and encrypted to prevent unauthorized changes (e.g., all files are controlled)

•	 Each instrument maintains a history of user commands

•	 Each assay and data file includes a history of signed changes to the file

Compass for Simple Western can be run with or without Access Control enabled. When Access Control is disabled, no 
user log in is required and files are not encrypted or signed. The instrument history and file history are still maintained but 
the entries are not signed.

Compass Authorization Server for Simple Western
The Compass Authorization Server (CAS) for Simple Western controls the log in access to Compass for Simple Western. 
In the simplest configuration, the server is run on the same computer as Compass for Simple Western and only that copy 
of Compass for Simple Western is controlled. A single server can also be used to control access to multiple copies of 
Compass for Simple Western running on different computers, so long as they have network access to the server. Multiple 
copies of the server may be run on the same network, and each server will have its own user database.

To enable Compass for Simple Western to use a particular Authorization Server for Simple Western, click Edit, then 
Preferences and Access Control and enter the server IP address using format X.X.X.X.

Server Administration

NOTES: 
Always use the default port setting of 8443, this should not be changed. 
 
If the server is installed on the same computer as Compass for Simple Western (e.g., the local machine), enter 
localhost:8443 instead of the IP address. Contact your local IT Administrator to assist with installing the Compass 
Authorization Server for Simple Western in your preferred format. 

The Authorization Server for Simple Western is configured through a web interface at the IP address of the server on port 
8443. To access the Server home page, open any browser and type the IP address on port 8443 in a X.X.X.X:8443 or 
https://X.X.X.X:8443 format. Use localhost:8443 instead of the IP address if the Server is installed on the local machine.
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NOTE: If you have upgraded your system from a previous version of Compass Authorization Service, the localhost 
login page will have changed from http://localhost:8000/admin/login/?next=/ to https://localhost:8443/admin/
login/?next=/

The default server administrator is:

•	 User: admin

•	 Password: admin

NOTE: The user account “admin” is not an active Compass for Simple Western login account. In order to log into 
Compass for Simple Western in the 21 CFR Part 11 compliant mode, at least one user account must be created in the 
Authorization Server for Simple Western application.

After installing the Compass Authorization Server for Simple Western, the administrator user name and password can be 
changed.

NOTE: Sites are responsible for maintaining their own admin and user account credentials. Record these and keep 
them safe. ProteinSimple can’t provide access once the admin account has been edited.

Adding Non-admin Users 
Add a user to the server to allow that user to log in to Compass for Simple Western. To do this: 
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1.	 Select Users from the Site Administration home page:

2.	 From the Users page, select Add User:

3.	 Fill in the fields to create a new user:



348

Chapter 9: Compass Access Control and 21 CFR Part 11 Compliance  //  Compass Authorization Server for Simple Western

Compass for Simple Western User Guide

After adding a new user more information can be added:

NOTES:  
Users are blocked after the number of login failures defined in the Password policy setting. See “Password Policy 
Settings” on page 355 for more information.  
 
Non-admin users will not be able to disable Access Control when the CAS connection is lost. 

Permissions

All users can log in to Compass for Simple Western, but the commands available within Compass for Simple Western 
are controlled by Permission settings. Commands a user does not have permission to use will be disabled. After user 
permissions have been changed on the server the user must close and re-open Compass for Simple Western to use the 
new permissions. 
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Users can belong to groups that have multiple permissions such as Operator or Scientist:

Use the Groups page to change the permissions in a group or create new groups:

To change permissions for a group click Change, then select a group:
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Move individual group permissions in or out of the Available Permissions and Chosen Permissions boxes by selecting a 
permission in either box. Click the left or right arrow button to move the permission into the other box.

Here are the current user and group permissions: 

•	 Allow analysis editing - lets users change analysis settings 

•	 Allow copy, export of data - lets users copy and export data 

•	 Allow instrument control - gives users permission to connect to an instrument 

•	 Allow plate editing - lets users update the plate layout and edit sample info 

•	 Allow protocol/method editing - gives users permission to edit protocol parameters/methods. Assay setup is allowed 
for users with this permission 

•	 Allow report printing - lets users print the run report

•	 Allow sign off of data - gives users permission to sign off on changes using e-signatures 

•	 Allow instrument administration - lets users update the instrument embedded software, delete run data from 
instruments, update the Compass for Simple Western software and turn Access Control on or off

Adding Admin Users
To create a user with administrator permissions:

1.	 Follow the steps described in “Adding Non-admin Users” on page 346 to create the admin user.
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2.	 Under permissions, select Staff status and Superuser status: 

3.	 Assign the admin user to a group. 

NOTES:  
Selecting Superuser status enables server permissions only. Admin users must also be assigned to a group in order 
to have Compass for Simple Western permissions. 
 
Only Admins will be able to disable Access Control when the CAS connection is lost. 

Resetting User Passwords

NOTE: Users are blocked after the number of login failures defined in the Password policy setting. 

To reset a user password:

1.	 Select Users from the Site Administration home page, then select the user to change. The following screen displays:
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2.	 Click the text link to access the password change form:

3.	 Enter the new password, then click Change password. 

Audit Trail
Admin users with Staff Status can view, print and download the Audit Trail. Select View Audit Trail from the Site 
Administration home page to access it. 
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Here are the actions currently logged in the Audit Trail:

•	 Login. User logged into CAS or Compass. 

•	 Logout. User logged out of CAS or Compass. 

•	 Start run. User started a run in Compass. Barcodes for cartridges and all plates will be logged when the run starts. 

•	 Stop run. User stopped a run in Compass. 

•	 Delete run. Run file was deleted. 

•	 Self test. User initiated a self-test on an instrument. 

•	 Open runfile. User opened a run file (*.cbz) in Compass. 

•	 Save runfile. User saved a run file (*.cbz) in Compass to the file location shown. 

•	 Save assayfile. User saved an assay file (*.assay) in Compass to the file location shown. 

•	 Instrument upgrade. User initiated an update of instrument software from Compass. 

•	 Change Control Settings. User disabled Access Control from Compass. 

•	 Generate Run Report. User generated Run Report from run in Compass. 

•	 Export spectra ANDI format. User exported the raw and analyzed data traces and background for each capillary in the 
run in .cdf format from Compass. 

•	 Export spectra text format. User exported the raw and analyzed data traces and background for each capillary in the 
run in .txt format from Compass. 

•	 Export tables. User exported the results for all capillaries in the run in .txt format from Compass. 

•	 User created. A new user was created on CAS. 

•	 User modified. A user was modified on CAS. 

•	 User deleted. A user was deleted on CAS. 

•	 Group created. A group was created on CAS. 

•	 Group modified. A group was modified on CAS. 

•	 Group deleted. A group was deleted on CAS. 

•	 Change password. A user's password was changed. 

•	 Sign off. A user signed off on changes to the file location shown utilizing e-signatures in Compass. 

•	 Edit LDAP settings. LDAP settings in CAS were modified. 

•	 Edit password policy. Password policy settings were modified in CAS. 

•	 Install. CAS software was installed. 
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•	 Upgrade. CAS software was upgraded to new version. 

•	 Blocked. A user has been blocked from logging in. 

•	 Unblock. A user has been unblocked, allowed to log in.

•	 Stop events. User initiated a stop to the instrument from Compass.

Audit Trail Settings

The Secure Audit Trail PDF setting (selected by default), allows users to download audit trail PDFs securely. Secure audit 
trail PDFs can be viewed and printed, but content cannot be copied or modified. 
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Password Policy Settings
These settings let administrators set password policies. Select Password policy settings from the Site Administration 
home page to make changes. 

LDAP Setting
The LDAP setting allow you to connect the Compass Authorization Server for Simple Western to your own network’s 
domain controller, so users can log on with their existing network password. With LDAP, passwords are not maintained by 
the Compass Authorization Server for Simple Western they are administered by the network admin. 

First select LDAP settings from the Site Administration page and set your LDAP settings. 

Next, add users as described in ”Adding Non-admin Users” on page 346 and select the LDAP User checkbox. Passwords 
aren’t required for LDAP users. 

NOTE: When enabling the LDAP setting, ensure the SSL port number reflects a secure LDAP port (636 
recommended). Compass Authorization Server for Simple Western doesn’t support non-secure connections.
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Encryption Details 
Compass for Simple Western uses the SHA1 hash algorithm to generate a 160-bit hash code that is unique for all files. 
All files saved by Compass for Simple Western are encrypted with a digital key. This key along with the hash codes 
guarantees the file history is correct and no other edits were made. All changes saved to a file have the electronic 
signature of the user who saved the file. The e-Signature command allows a user to sign off on a state such as approved 
or verified.

There is no individual ownership of files, all users who log into Compass for Simple Western can open any file. 

Enabling Access Control
Access Control is enabled in Preferences. Select Edit in the main menu, click Preferences, then select Access Control.

To enable Access Control: .

1.	 Check the Enable Access Control box. 

2.	 Enter the IP address of the Authorization Server for Simple Western. Use format X.X.X.X or localhost if installing the 
server on the local machine. 

3.	 Close Compass for Simple Western. The next time the software is launched, a user log in will be required. 
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NOTES:  
Access Control can only be disabled by logging into Compass for Simple Western and deselecting the Enable 
Access Control box in the Access Control page of Preferences.  
 
If your Jess, Abby, or Leo system is running a controlled assay, you cannot connect to the instrument with Compass 
unless Access Control is enabled. If your Jess, Abby, or Leo system is running an uncontrolled assay, you will not be 
able to connect to the instrument if Access Control is enabled on Compass Software. 
 
Leo systems will remain in controlled mode once they are connected to Compass Software with Access Control 
enabled. You will need to turn the instrument off and then back on again before the instrument will go back to being 
in non-controlled mode.  
 
Jess and Abby instruments will go back to being in non-controlled mode once Access Control is disabled. 

Changing the Software Inactivity Auto Lock
Compass for Simple Western software automatically locks to prevent user access after a period of inactivity. Once the 
software is locked, users must log in again. Only users with instrument administrator permission can set the auto lock 
inactivity time. 

1.	 Select Edit > Preferences > Access Control. 

2.	 Enter an Auto Lock Inactivity time in minutes. The default setting is 20 minutes. 

Logging In to Compass for Simple Western
With Access Control enabled, all users must log in to Compass for Simple Western whenever the software is launched.
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Enter your username and password previously setup by your Compass for Simple Western Administrator.

NOTE: Your account will be blocked after a certain number of login failures. If this happens, contact your 
administrator to unblock the account. 

A window will appear if Compass for Simple Western is connecting to a previous version of the Compass Authorization 
Server that does not support a secure connection. 

A successful log in will display the Compass for Simple Western main window with the user information in the lower status 
bar. The full username is displayed with the unique user ID in parenthesis: 

Connecting Compass to Systems with Access Control Enabled
Access Control checks are in place that could impact your ability to connect to Compass for Simple Western software. 
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Jess/Abby

•	 When Compass has access control enabled, you will not be able to connect to an instrument running an assay in non-
CFR mode.

•	 When Compass does not have access control enabled, you will not be able to connect to an instrument running an 
assay in CFR mode. 

Leo

•	 When Compass has access control enabled:

•	 The Leo instrument will lock into CFR mode the first time Compass for Simple Western connects to the instrument. 
The instrument switching into CFR will be recorded in the instrument command log. 

•	 Compass must have access control enabled to connect to an instrument that is in CFR mode, even if it is not running 
an assay.

•	 The Leo instrument will reset to a non-CFR mode when the system is turned off and then back on. 

•	 When Compass does not have access control enabled, it will not be able to connect to an instrument locked in CFR 
mode. 

A warning will appear if it is unable to connect to the instrument. The warning will not impact any assay or test that the 
instrument is in the middle of performing. 
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Locking and Unlocking the Application
You can click the Lock button to lock Compass for Simple Western and prevent access by other users. To unlock the 
application, users must re-enter their password. 

If there is no activity in Compass for Simple Western for 20 minutes, the application automatically locks. Users must 
re-enter their passwords to perform any controlled actions: 

NOTE: The default software inactivity lock-out time is 20 minutes. See “Changing the Software Inactivity Auto Lock” 
on page 357 for information on how to modify the lock-out timing. 
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Resolving Log In Issues
Log in failures may occur when: 

•	 The server is temporarily unavailable 

•	 Compass for Simple Western is using the wrong IP address 

When this happens, the following message displays:

U S E R:

A D M I N U S E R:

Click Disable to restart Compass for Simple Western with Access Control disabled. Verify or correct the server IP address 
then close and restart the software to log in with Access Control enabled. 
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Saving Changes
When Save is selected from the File menu, a dialog box will display to allow you to enter a comment before saving the 
signed file:

The comment is added to the signature entry in the file History:

Signing Files
Select e-Signature from the File menu to add an electronic signature to a file. 
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The signed entry will be added to the file History with the meaning of the signature entered in the comment, such as 
Approved or Verified.

Exporting Uncontrolled Files
You can export an uncontrolled file when in the Analysis screen by selecting File > Export Uncontrolled…. The export will 
also be logged in the Audit Trail and the History log for the exported file.

Instrument Command Log
The Instrument Command Log can be viewed at any time by selecting the Instrument menu and clicking Properties. Click 
the Logs button and then in the Instrument Logs box click Command Log: 
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The Command Log lists all the commands sent to the instrument that were signed by the user who sent the command. If 
you want to copy the Command Log at any time, right-click in the table and select Copy, then paste into another document. 

Run File History
Select the Run Summary screen tab and then the History tab to see the file History. 
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Troubleshooting Problems and Suggested Solutions
If any of the following error messages are encountered, follow the recommended steps below to resolve the issue. 

•	 Unknown username or password. 

•	 Check if the Caps Lock is on, username and password are case sensitive. 

•	 Ask a Compass for Simple Western administrator to confirm your username. If your password is unknown then the 
administrator can reset your password (see “Resetting User Passwords” on page 351 for more information).

•	 Server not available. 

•	 From the Edit menu, click Preferences and then Access Control to confirm the server address is set to the correct 
Authorization Server for Simple Western address. Compass for Simple Western must be able to reach the server on 
the network. 

•	 Controlled file cannot be opened without log in. To open a controlled Run file, enable Access Control by clicking Edit, 
then Preferences and Access Control. Select Enable Access Control, close Compass for Simple Western, then re-
launch the software with a valid log in. 

•	 Uncontrolled file cannot be opened when logged in. To open an uncontrolled Run file, disable Access Control by 
clicking Edit, then Preferences and Access Control. Deselect Enable Access Control, close Compass for Simple 
Western then re-launch the software. 

NOTES:  
Only users with Instrument Administrator permission can turn Access Control on or off. This event will also be 
logged in the Audit Trail.  
 
Uncontrolled files cannot be opened when Compass Access Control is enabled (controlled mode). 

•	 Command disabled. Certain commands are only available when a user with the correct permissions is logged in. To 
change user permissions, use a web browser to log in to the Authorization Server for Simple Western web interface at 
the address shown on the Access Control page in Preferences, such as: 127.0.0.1:8443/. 

•	 Compass for Simple Western does not prompt for log in. Compass for Simple Western will only prompt for a log in on 
launch when Access Control is enabled in Preferences. Enable Access Control by clicking Edit, then Preferences and 
Access Control. Select Enable Access Control, close Compass for Simple Western, then re-launch the software. You 
should now be prompted for a log in.
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